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Thatcher — 510(k) Application 6.

G - 32004  FDAS510(k) Summary

Section 807.92

(a)(1). Submitter’s Name: Applicd Neuroscience, Inc., 228 176™ Terrace Drive, St.
Petersburg, FL. 33708. Phone: (727) 392-7851; Fax: (727) 319-1027; email:
rwthatcher@yahoo.com.

Coutact Person: Robert W, Thatcher. Ph.D. Applied Neuroscience, Inc.., 228 176"
Terrace Drive, St. Petersburg, FL 33708. Phone: (727) 392-7851; Fax: (727) 319-1027;
email: rwthatcher@yahoo.com.

Date of preparation: 5/9/2004

(2)(2). Name of the Device: NeuroGuide Analysis System (NAS). Classification name:
EEG Frequency Spectrum Analyzer.

(2)(3). Predicate/legally marketed devices upon which substantial equivalence is
based: Cordis Brain State Analyzer (no FDA information available); TECA Corporation
Neurolab 1, 1T (K844481), Brain Mapper (K890-881), Neuromapper 386 (K894889);
Nicolet BEAM I, 1I (no FDA 510(k) information available); Pathfinder IT (K801604);
Brain Functional Map (K843598); Cadwell Laboratories, Inc. 8400 (K860801) and
Spectrum 32 (K860801 reference); Lexicor Medical Technology Neurosearch-24
(K904269), Neurosearch-4 (K920038); Neuroscience, Inc. Map-10 EEG (K840430),
Neuromapper 1620 (K870263); Biologics Systems Corporation. Inc., Modified Brain
Atlas 111 (K854362), Bio-Logic Automatic Event Analysis (K951594); Quantified Signal
Imaging, Inc. QSI-9500 (K904294), QS1-9200 (FDA 510(k) information not availabie);
Stellate Systems, Inc. Rhythm Software (K912938); NxLink, Inc. (K974748).

(a)(4). Device Description: The NeuroGuide Analysis System (NAS) is a software
program for the post-hoc statistical analysis of the human electroencephalogram (EEG).
EEG recorded on a separate device (i.e., the host system) is transferred to the NAS for
display and user-review. The system requires that the user select reliable samples of
artifact-free, eyes-closed or eyes open, resting digital EEG for purposes of analysis.
Analysis consists of the Fast-Fourier Transformation (FFT) of the data to extract the
spectral power for each of the four primary frequency bands (delta, theta, alpha, and beta),
and frequency information from the EEG. The results of this analysis are then subjected
to univariate, bivariate, and multivariate statistical analyses and displayed in statistical
tables and topographical brain maps of absolute and relative power, power asymmetry,
and coherence for 19 monopolar and 171 selected bipolar derivations of the EEG. In ail
over 1,200 measures are derived for comparison against a carefully constructed and
statistically controlled age-regressed, normative database in which the variables have
been transformed and confirmed for their Gaussian distribution. Each variable extracted
by the analysis is compared to the database using parametric statistical procedures that
express the differences between the patient and an appropriate age-matched reference
group in the form of Z-scores. Multivariate features are compared to the normative
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database using Gaussian Univariate and Multivariate Distance Statistics. The Gaussian
multivariate Distance statistic controls for the interrelationship of the measures of brain
cortical function in the feature set, and provides an accurate estimate of their difference
from normal. The multivariate measures permit an evaluation of regional indices of brain
function that reflect the perfusion fields of the brain. Extracted feature sets are further
analyzed to determine if the pattern of ‘hits’ (statistically significant feature score values
identified for the patient) are consistent with patterns of ‘hits” identified in prior
neuroguide evaluations of clinical patients with known disorders. A step-wise
discriminate analysis program classifies the patient in terms of their similarity to known
neuroguide-defined patterns of abnormality, providing a probability estimate of the
patient’s profile with the average profile of groups of individuals constituting the
normative and clinical database. The discriminant classification program is restricted by
confining potential outcomes to specific patient symptoms derived from the patient
history profile. Established discriminant functions were evaluated through the use of
Receiver Operating Characteristic (ROC) curves for their sensitivity and specificity. The
outcome of the statistical analysis is presented in report form that includes (a) patient
demographic and history information, (b) selected EEG epochs, (c) statistical tables of
monopolar, bipolar, and multivariate extracted feature values, and topographical brain
maps. This information is to be read and interpreted within the context of the current
clinical assessment of the patient by the attending physician/clinician. The decision to
accept or reject the results of the neuroguide analysis, and incorporate these results into
their clinical appraisal of the patient, is dependent upon the judgment of the attending
physician or clinician.

The NeuroGuide Analysis System is complete on a single CD, which contains a
demonstration program with sample NeuroGuide studies, the NAS program, and the print
program. The NAS was designed for implementation under Windows, and programmed
using C. The user interface was carefully designed and implemented to permit the
program to be easy to use, highly reliable in its performance. A variety of control
procedures are used to record stops used in program usage, and the conduct of the
analysis to insure appropriate function end operation of the software. The NAS can be
installed in any appropriately configured IBM-compatible computer system, including
systems designed specifically for the recording of digital EEG. The system functions with
a wide-range of standard computer platforms and input-output devices, and printers.

(a)(5). Statement of Indications of Use: Indications for the use of the NeuroGuide
Analysis System (NAS) are as follows:

Indications of Use
The NeuroGuide Analysis system is to be used by qualified medical and qualified clinical
professionals for the post-hoc statistical evaluation of the human electroencephalogram

(EEG).

(a)(6). Comparison to Predicate Devices: The NeuroGuide Analysis System uses
essentially the same accepted methods of data selection and analysis of predicate devices
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to extract the feature measures upon which statistical determination of normal/abnormal
are made, and from which derivations of probability estimates of clinical classification
are derived. The neuroguide method of EEG selection, analysis, and interpretation have
been previously implemented, in whole or in part, in a variety of digital EEG and analysis
systems marketed in prior years for the quantitative analysis of the EEG in Man. The
NAS database, the same as for predicate devices, was carefully constructed to control for
potential sources of Type I and Type II errors in the use of database comparisons in
clinical electrophysiological assessment of the human EEG. The purposeful, easy to use,
and reliable design of the NAS has been enhanced relative to these eatlier systems
through the careful consideration of user interactions by optimizing on the speed of
modern computer technology to facilitate user feedback and hypothesis testing with
mouse clicks.

(b). Non-clinical and Clinical Tests: The NeuroGuide Analysis System’s design and
implementation was based upon the results of an extensive, 25-year effort to construct a
viable normative and clinical database at the Applied Neuroscience Laboratory (ANL}) at
the University of Maryland. The NAS incorporates the basic methods of data collection,
data selection, analysis, and interpretation developed at the ANL during the conduct of
numerous government and privately funded normative and clinical database projects

(b)(1). Non-clinical Testing: Non-clinical testing of the NAS included the evaluation of
the algorithms and statistical methods used for data analysis. Specifically, control signals,
in the form of signal generated waveforms, were analyzed for frequency and power- EEG
signals were analyzed for conformity between the host digital EEG system and the NAS.
The NAS includes a feature that reproduces sampling frequency in the host digital EEG
system, and permits the visualization and evaluation of the EEG waveform for accuracy
between the host system and the NAS translation. In addition, data obtained in previous
implementations of the NeuroGuide analysis method were evaluated for consistency and
accuracy -- the results of the NAS’s analysis of stored subject data had to conform to that
of the prior analysis (which was conducted using the sarne methed and procedures,
algorithms and method of analysis as that implemented on the NAS).

(b)(2). Clinical Testing: The ability of the NAS to accurately translate and present EEGs
from clinical patients was confirmed by the non-clinical testing. In order for the NAS to
be an effective implementation of the neuroguide method for clinical use, the results of
the analysis (both statistical tables and topographical brain maps) had to be in agreement
with the results of the analysis conducted on the host system used in the processing of
patient information at the Applied Neuroscience Laboratory. In addition, the outcome of
the discriminant analysis had to be consistent, not resulting in errors of misclassification
(that is, the classification on the NAS had to be consistent with that of the host system
used to perform the NeuroGuide analysis at the ANL). These tests confirmed that when
eyes-closed resting, and artifact-free EEG was selected for analysis, the results were
reproducible within an acceptable degree of variation consistent with reliability estimates
identified in the normative studies.

Subjects upon which this device has been tested included individuals which ranged in age

2.8 € 2%

FOI - Page 5 of 290



Jeoq 12 €3
Thatcher — 510(k) Application 29

from 2 months to 82 years, and who were either volunteers or clinical patients referred
for neuroguide evaluation to the Applied Neuroscience Laboratory by the Department of
Psychiatry University of Maryland School of Medicine, and/or Shock Trauma and the
Applied Neuroscience Institute at the University of Maryland Eastern Shore. The results
of the analysis were conveyed to the referring physician or Ph.D. clinician who was asked
to use the information as an adjunct to their clinical interpretation of the patient’s
traditional EEG. The information was provided in report form (including EEG epochs
selected for analysis, statistical tables and topographic brain maps, and the result of the
discriminant analysis) to permit the physician or Ph.D. clinician to determine its
televance to their clinical evaluation and diagnosis or treatment of the patient. When the
results are used in this manner, the likelihood of introducing error into diagnosis and
treatment is substantially reduced. That is, the test is viewed as an adjunct to the
evaluation of the patient, and does not serve as a primary basis for the diagnosis.

Potential adverse effects of the use of the device are known if the NeuroGuide Analysis
System is used as a stand-alone diagnostic system (a use that is specifically
contraindicated by Applied Neuroscience, Inc. and the system’s developers) in the
absence of other clinical data from more traditional means of patient evaluation. Relying
only upon the use of a single index (such as relative power, or the topographical maps
alone) without reviewing the traditional EEG, the epochs selected for analysis, or the
complete set of statistical summary tables is also contraindicated and a source of potential
error. Additional sources of error could arise from the inappropriate selection of EEG
(selecting artifacted EEG epochs, or selecting EEG representative of other states, such as
drowsiness or eyes-open EEG when comparing to an eyes closed database, or by
purposely selecting conditions for testing other than those specified. Additionally, it is
possible that errors will occur through the purposeful falsification of symptoms in the
patient history, and patient age.

(b)(3) Conclusions Drawn From Non-Clinical and Clinical Testing: The appropriate
use of the NeuroGuide Analysis System as an adjunct to the traditional visually-appraised
EEG provides the user with the ability to quantify EEG variables and use them to answer
questions drawn from their clinical experience with the patient. When used by an
experienced, qualified practitioner, or under the proper supervision of a qualified medical
professional, the NAS is concluded to be a useful and beneficial addition to the amay of
clinically accepted medical tests and devices used to evaluate brain structure and function.

The results of non-clinical and clinical resting conducted over the past 25 years
demonstrates that the NAS is both safe and effective for the quantitative analysis of the
eyes-closed resting EEG in the alert humnan subject and to be used to help determine if the
EEG is normal or abnormal, and if abnormal, to statistically characterize the distribution
of selected derived features by their probability of being similarly distributed in specified
groups of clinical patients, the NAS provides information that both complements and
supplements the outcome of the analysis of a traditional EEG. This information, when
properly used in conjunction with other clinical tests as a safe and effective adjunctive aid
to diagnosis, treatment planning, and treatment follow-up of the neurologic and
psychiatric patient.
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Compared to its predicate devices, the NeuroGuide Analysis System’s inclusion of
specific, appropriate, reliable and effective statistical controls over the method of data
selection and analysis, the scientific rigor involved in the construction, refinement, and
application of the normative and clinical databases, and the potential for providing
practitioner with sensitive and specific quantitative indices of brain structure and function
that is both safe and effective and suggests that the NAS is a significant advancement in
the use of quantitative technology in neurology, psychiatry, and clinical neuropsychology
and is an advancement over predicate EEG analysis systems in terms of speed and ease of
use.

30
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L

Food and Drug Administration
9200 Corporate Boulevard
Rockville MD 20850

AUG - 3 2004

Robert W. Thatcher, Ph.D.
President

Applied Neuroscience, Inc.

228 176" Terrace Drive
Redington Shores, Florida 33708

Re: K041263

Trade/Device Name: NeuroGuide Analysis System (NAS)

Regulation Number: 21 CFR 882.1400, 21 CFR 882.1420

Regulation Name: Electroencephalograph; Electroencephalogram (EEQG) signal spectrum
analyzer

Regulatory Class: II

Product Code: GWQ, GWS

Dated: July 20, 2004

Received: July 22,2004

Dear Dr. Thatcher:

We have reviewed your Section 510(k) premarket notification of intent to market the device
referenced above and have determined the device is substantially equivalent (for the indications
for use stated in the enclosure) to legally marketed predicate devices marketed in interstate
commerce prior to May 28, 1976, the enactment date of the Medical Device Amendments, or to
devices that have been reclassified in accordance with the provisions of the Federal Food, Drug,
and Cosmetic Act (Act) that do not require approval of a premarket approval application (PMA).
You may, therefure, market the device, subject to the general controls provisions of the Act. The
general controls provisions of the Act include requirements for annual registration, listing of
devices, good manufacturing practice, labeling, and prohibitions against misbranding and
adulteration.

If your device is classified (see above) into either class 11 (Special Controls) or class III (PMA), it
may be subject to such additional controls. Existing major regulations affecting your device can
be found in the Code of Federal Regulations, Title 21, Parts 800 to 898. I[n addition, FDA may
publish further announcements concerning your device in the Federal Register.

Please be advised that FDA’s issuance of a substantial equivalence determination does not mean
that FDA has made a determination that your device complies with other requirements of the Act
or any Federal statutes and regulations administered by other Federal agencies. You must
comply with all the Act’s requirements, including, but not limited to: registration and listing (21
CFR Part 807); labeling (21 CFR Part 801); good manufacturing practice requirements as set
forth in the quality systems (QS) regulation (21 CFR Part 820); and if applicable, the electronic
product radiation control provisions (Sections 531-542 of the Act); 21 CFR 1000-1050.

FOI - Page 8 of 290



Page 2 - Robert W. Thatcher, Ph.D.

This letter will allow you to begin marketing your device as described in your Section 510(k)
premarket notification. The FDA finding of substantial equivalence of your device to a legalh
marketed predicate device results in a classification for your device and thus, permits your device
to proceed to the market.

If you desire specific advice for your device on our Jabeling regulation (21 CFR Part 801), please
contact the Office of Compliance at (301) 594-4659. Also, please note the regulation entitled,
"Misbranding by reference to premarket notification” (21CFR Part 807.97). You may obtain
other general information on your responsibilities under the Act from the Division of Small
Manufacturers, International and Consumer Assistance at its toll-free number (800) 638-2041 or
(301) 443-6597 or at its Internet address http://www.fda.gov/cdrh/dsma/dsmamain. html

Sincerely yours,

Celia M. Witten, Ph.D., M.D.
Dhrector
Division of General, Restorative
and Neurological Devices
Office of Device Evaluation
Center for Devices and Radiological Health

Enclosure
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Indications for Use

510(k) Number (if known): K041263

Device Name: NeuroGuide Analysis System

indications For Use: For clinical use the NeuroGuide Analysis system is to be used by
qualified medical or clinical professionals for the statistica! evaluation of the human

electroencephalogram (EEG).

Prescription Use AND/OR Over-The-Counter Use X
(Part 21 CFR 801 Subpart D) (21 CFR 801 Subpart C)

(PLEASE DO NOT WRITE BELOW THIS LINE-CONTINUE ON ANOTHER PAGE IF
NEEDED)

Concurrence of CDRH, Office of Device Evaluation (ODE)

(Division Sign-Off) Page 1 of
Division of General, Restorative,
and Neurological Devices

510(k) Number__A6% /263
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Date:
From:

Subject:

To:

e i

)
cip
. Apn-TD FAE
oF .oy
N PARTMENT OF HEALTH & HUMAN SERVICES Public Health Service

Food and Drug Admnistration

Memorandum

Sy

DMC (HEZ-40T)

i

cod(26 5

premarket Notification Number(s): ™
Division Director:, 7{\_(€Z D (Tg (\{D o

The atiached information has been received by the 5 L0(k) DMC on the above referenced S10(k})
submission{s}. Since a final decision has been rendered, this record is offictally closed.

Please review the attached document and return it to the DMC, with one of the statements checked
below.

~_ Information does not change the status of the 510(k); no other action required by the
DMC; please add to image file. (Prepare K-25) THIS DOES NOT APPLY TO TRANSFER OF
OWNERSHIP. PLEASE BRING ANY TRANSFER OF OWNERSHIP TO POS.

~_ Additional information requires a new 510(k); however, the information submitted is
wﬂmycie: (Noitify company 1o submit a new 3 H0(k);[ Prepare the K30 Letter on the [LAN]

~ Noresponse necessary (e.g., hard copy of fax for the truthful and accuracy statement,

510(k) statement, change of address, phone number, or fax number}. hawi CdP\f _ ?r\({‘;‘(‘oco‘fm,%

CLIA CATEGORIZATION refers to laboratory test system devices reviewed by the ; ; V’IbLg — E_

Division of Clinical Laboratory Devices (HF7Z-440

Information requires a CLIA CATEGORIZATION: the complexity may remain the same
as the original 510(k) or may change as a result of the additional information (Prepare a CAT
fetter)

_ Additional information requires a CLIA CATEGORIZATION; however, the information
submitted is incomplete; {(call or fax firm)

~_ Noresponse NEcessary

This information should be returned to the DMC within 10 working days from the date of this
memorandunt.

Reviewed by: %4@&@—*’—

i __@[/447\/«__ — - B

Draft #2 : 9/8/99 / :‘
Draft #3: 1/3/00 W
Draft #4: 3/7/03 Vo
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Applied Neuroscience, Inc.

228 176" Terrace Drive
Redington Shores, Fi 33708
727-392-7851, rwthatcher@yahoo.com

July 29, 2004

Document Mail Center (HFZ-401)

Center for Devices and Radiological Health
Food and Drug Administration

9200 Corporate Boulevard

Rockville, Maryland 20850 USA

Re: 510(k) Number: K041263

Dear Sirs;

Enclosed is an original and two copies of an ”Indications for Use
Form”. Please include this form as part of the Applied Neuroscience,
Inc. 510(k) application (K041263).

Sincerely,
'\_’w(r\,?L i 71 m}f .,fC/'\ .

Robert W. Thatcher, Ph.D.
President

FOI - Page 12 of 290



Indications for Use

510(k) Number (if known): K041263

Device Name:_NeuroGuide Analysis System

Indications For Use: For clinical use the NeuroGuide Analysis system is to be used by
qualified medical or clinical professionals for the statistical evaluation of the human
electroencephalogram (EEG).

Prescription Use AND/OR Over-The-Counter Use __ X
(Part 21 CFR 801 Subpart D) (21 CFR 801 Subpart C)

(PLEASE DO NOT WRITE BELOW THIS LINE-CONTINUE ON ANOTHER PAGE IF
NEEDED)

Concurrence of CDRH, Office of Device Evaluation (ODE)

Page 1 of
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5‘ {é DEPARTMENT OF HEALTH & HUMAN SERVICES public Health Service
k]

Food and Drug Administration
9200 Corporate Boulevard
Rockville MD 20850

AUG - 3 2008

Robert W. Thatcher, Ph.D.
President

Applied Neuroscience, Inc.

228 176™ Terrace Drive
Redington Shores, Florida 33708

Re: K041263

Trade/Device Name: NeuroGuide Analysis System (NAS)

Regulation Number: 21 CFR 882.1400, 21 CFR 882.1420

Regulation Name: Electroencephalograph; Electroencephalogram (EEG) signal spectrum
analyzer

Regulatory Class: 1I

Product Code: GWQ, GWS

Dated: Tuly 20, 2004

Received: July 22,2004

Dear Dr. Thatcher:

We have reviewed your Section 510(k) premarket notification of intent to market the device
referenced above and have determined the device is substantially equivalent (for the indications
for use stated in the enclosure) to legally marketed predicate devices marketed in interstate
commerce prior to May 28, 1976, the enactment date of the Medical Device Amendments, or to
devices that have been reclassified in accordance with the provisions of the Federal Food, Drug,
and Cosmetic Act (Act) that do not require approval of a premarket approval application (PMA).
You may, therefore, market the device, subject to the general controls provisions of the Act. The
general controls provisions of the Act include requirements for annual registration, listing of
devices, good manufacturing practice, labeling, and prohibitions against misbranding and
adulteration.

If your device is classified (see above) into either class II (Special Controls) or class III (PMA), it
may be subject to such additional controls. Existing major regulations affecting your device can
be found in the Code of Federal Regulations, Title 21, Parts 800 to 898. In addition, FDA may
publish further announcements concerning your device in the Federal Register.

Please be advised that FDA’s issuance of a substantial equivalence determination does not mean
that FDA has made a determination that your device complies with other requirements of the Act
or any Federal statutes and regulations administered by other Federal agencies. You must
comply with all the Act’s requirements, including, but not limited to: registration and listing (21
CFR Part 807): labeling (21 CFR Part 801); good manufacturing practice requirements as sct
forth in the quality systems (Q5) regulation (21 CFR Part 820): and if applicable, the electronic
product radiation control provisions (Sections 531-542 of the Act). 21 CFR 1000-1050.

FOI - Page 14 of 290



Page 2 - Robert W. Thatcher, Ph.D.

This letter will allow you to begin marketing your device as described in your Section 510(k)
premarket notification. The FDA finding of substantia! equivalence of your device to a legally
marketed predicate device results ina classification for your device and thus, permits your device
to proceed to the market.

If you desire specific advice for your device on our labeling regulation (21 CFR Part 801), please
contact the Office of Compliance at (301) 594-4659. Also, please note the regulation entitled,
"Misbranding by reference to premarket notification” (21CFR Part 807.97). You may obtain
other general information on your responsibilities under the Act from the Division of Small
Manufacturers, International and Consumer Assistance at its toll-free number (800) 638-2041 or
(301) 443-6597 or at its Internet address http://www.fda.gov/cdrh/dsma/dsmamain.htm]

Sincerely yours,

M O [t

/Celia M. Witten, Ph.D., M.D.

Director
Division of General, Restorative
and Neurological Devices
Office of Device Evaluation
Center for Devices and Radiological Health

Enclosure
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Indications for Use

510(k) Number (if known): K041263

Device Name: NeuroGuide Analysis System

Indications For Use: For clinical use the NeuroGuide Analysis system is to be used by
qualified medical or clinical professionals for the statistical evaluation of the human

electroencephalogram (EEG).

Prescription Use AND/OR Over-The-Counter Use X
{Part 21 CFR 801 Subpart D) (21 CFR 801 Subpart C)

(PLEASE DO NOT WRITE BELOW THIS LINE-CONTINUE ON ANOTHER PAGE IF
NEEDED)

Concurrence of CORH, Office of Device Evaluation (ODE)

Prtiand & Prved”
(Division Sign-Off) Page 1 of
Division of General, Restorative,
and Neurological Devices

510(k) Number__A¢% /243
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DEPARTMENT OF HEALTH AND HUMAN SERVICES Public Health Service

Food and Drug Administration
Center for Devices and
Radiological Health

QOffice of Device Evaluation
Document Mail Center (HFZ—501)
9200 Corporate Blwvd,

July 14, 2004 Rockville, Maryland 20850
APPLIED NEUROSCIENCE INC. 510(k) Number: K041263

228 176TH TERRACE DRIVE Product: NEUROGUIDE

ST. PETERSBURG, FL 33708 ANALYSIS SYSTEM

ATTN: ROBERT W. THATCHER

We are holding your above-referenced Premarket Notification (510(k))
for 30 days pending receipt of the additional information that was
requested by the Office of Device Evaluation. Please remember that
all correspondence concerning your submission MUST cite your 510(k)
number and be sent in duplicate to the Document Mail Center (HFZ-401)
at the above letterhead address. Correspondence sent to any address
other than the one above will not be considered as part of your
official premarket notification submission. Also, please note the new
Blue Book Memorandum regarding Fax and E-mail Policy entitled,

"Fax and E-Mail Communication with Industry about Premarket Files Under
Review. Please refer to this guidance for information on current fax
and e-mail practices at www.fda.gov/cdrh/ode/a02-01 . html.

The deficiencies identified represent the issues that we believe need to be
resolved before our review of your 510(k) submission can be successfully
completed. In developing the deficiencies, we carefully considered the
statutory criteria as defined in Section 513(i) of the Federal Food, Drug,

and Cosmetic Act for determining substantial equivalence of your device.

We also considered the burden that may be incurred in your attempt to respond
to the deficiencies. We believe that we have considered the least burdensome
approach te resolving these issues. If, however, you believe that information
is being requested that is not relevant to the regulatory decision or that
there is a less burdensome way to resolve the issues, you should follow the
procedureséoutlined in the "A Suggested Approach to Resolving Least Burdensome
Issues” document. It is available on our Center web page at:
http://www.fda.gov/cdrh/modact/leastburdensome . html

If after 30 days the requested information, or a request for an extension
of time, is not received, we will discontinue review of your submission
and proceed to delete your file from our review system. Pursuant to

21 CFR 20.29, a copy of your 510(k) submission will remain in the Office
of Device Evaluation. If you then wish to resubmit this 510(k)
notification, a new number will be assigned and your submission will be
considered a new premarket notification submission.

Please remember that the Safe Medical Devices Act of 1990 states that
you may not place this device into commercial distribution until you
receive a decision letter from FDA allowing you to do so.

FOI - Page 17 of 290



If you have procedural or policy questions, please contact the

Division of Small Manufacturers International and Consumer Assistance (DSMICA)
at (301) 443-6597 or at their toll-free number (800) 638-2041, or contact me
at (301) 594-1190.

Sincerely yours,

Marjorie Shulman

Supervisor Consumer Safety Officer

Premarket Notification Section

Office of Device Evaluation

Center for Devices and
Radieclogical Health

FOI - Page 18 of 290



DEPARTMENT OF HEALTH AND HUMAN SERVIGES Public Health Service

Food and Drug Administration
Center for Devices and
Radiological Health

Office of Device Evaluation
Document Mail Center (HFZ—-401)
9200 Corporate Blvd.

May 12, 2004 Rockville, Maryland 20850
APPLTED NEUROSCIENCE INC. 510(k) Number: K041263

228 176TH TERRACE DRIVE Received: 11-MAY-2004

ST. PETERSRBURG, FL 33708 Product: NEUROGUIDE ANALYSIS

ATTN: ROBERT W. THATCHER SYSTEM

The Food and Drug Administration (FDA), Center for Devices and Radiological
Health (CDRH), has received the Premarket Notification you submitted in
accordance with Section 510(k) of the Federal Food, Drug, and Cosmetic Act
(Act) for the above referenced product. We have assigned your submisgsion a
unique 510(k) number that is cited above. Please refer prominently to this
510(k) number in any future correspondence that relates to this submission.

We will notify you when the processing of your premarket notification has been
completed or if any additional information is required. YOU MAY NOT PLACE
THIS DEVICE INTO COMMERGIAL DISTRIRUTION UNTIL YOU RECEIVE A LETTER FROM FDA
ALLOWING YOU TO DO SO,

The Act, as amended by the Medical Device User Fee and Modernization Act of 2002
(MDUFMA) (Public Law 107-250), authorizes FDA to collect user fees for premarket
notification submissions. (For more information on MDUFMA, you may refer to our
website at http://www.fda.gov/oc/mdufma).

Please remember that all correspondence concerning your submission MUST be

sent to the Document Mail Center (DMC)(HFZ-401) at the above letterhead address.
Correspondence sent to any address other than the one above will not be considered
as part of your official premarket notification submission. Also, please note

the new Blue Book Memorandum regarding Fax and E-mail Pelicy entitled,

"Fax and E-Mail Communication with Industry about Premarket Files Under Review".
Please refer to this guidance for information on current fax and e-mail

practices at www.fda.gov/cdrh/ode/a02-01 . html.

You should be familiar with the manual entitled, "Premarket Notification 510(k)
Regulatory Requirements for Medical Devices" available from DSMICA. If you
have other procedural or policy questions, or want information on how to check
on the status of your submission, please contact DSMICA at (301l) 4436597 or
its toll-free number (800) 638-2041, or at their Internet address
http://www.fda.gov/cdrh/dsmamain.html or me at (301)594-1190.

Sincerely vyours,

Marjorie Shulman

Supervisory Consumer Safety Officer

Office of Device Evaluation

Center for Devices and Radiological Health

(%)
U'\
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Applied Neuroscience, Inc.

228 176" Terrace Drive
Redington Shores, FI 33708
727-392-7851, rwthatcher@yahoo.com

—rt
ot
-

May 10, 2004,

=t

e

AL

Document Mail Center (HFZ401)

i

Center for Devices and Radiological Health

Food and Drug Administration
9200 Corporate Boulevard

oWd73ad /u8ad/ yad

R
\ M

Rockville, Maryland 20850 USA

Dear Sirs;

Enclosed are two copies of a 510k application for substantial
equivalence of software for the spectral analysis of EEG. Applied

Neuroscience, Inc. has been designated to qualify as a small business,

MDUFMA small business decision number; SBD047091 and a fee has
been submitted along with Form FDA 3601.

identification number is: 013811-956733.
Sincerely,

&E
Kot w . YA

Robert W. Thatcher, Ph.D.
President

The payment

\ >
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Robert W. Thatcher Food and Drug Administration
Rockville MD 20857

d/b/a ApEIied Neuroscience, Inc.
228 176" Terrace Drive
St. Petersburg, FL. 33708

April 22, 2004

To: Robert W. Thatcher, President
Subject: Request for Qualification as a Small Business

Small Business Decision Number- SBD047091
Expires: September 30, 2004

This responds to your request for elj gibility for Small Business Qualification on Form FDA

3602,

After review of your submission, I am pleased to inform you that your firm does qualify
under MDUFMA as a small business for reduced or waived fees for medical device
submissions made during the fiscal year 2004,

Please include your Small Business Decision Number (see above) whenever you submit a
Medical Device User Fee Coversheet (form FDA 3601). This will allow FDA to quickly
confirm that you are entitled to a reduced or waived fee,

Your Small Business status expires at the close of business September 30, 2004. FDA will
provide information on how to qualify as a Small Business for FY 2005 in a Federal Register
Notice to be published around August 1, 2004. We will also provide this information on our

MDUFMA website, at: www.fda.gov/oc/mdufma.

Also, note that reduced fees for 510(k) submissions by small businesses are for fiscal vear

2004, ettective October 1, 2003,

,’/”/// ' _]/)C, ’f’,--.’d»:.:L
LA k", E b i

Cindy Garris

Small Business Decision Reviewer

Division of Small Manufacturers,
International and Consumer Assistance

Office of Health and Industry Programs

Center for Devices and Radiological Health

M) 24¢- 03¢0 (efys
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Form Approved OMB No. 0910-0511  Expiration Date August 31, 2006. Ses instuchons lor OMS Statement
DEPARTMENT OF HEALTH AND HUMAN SERVICES

FOOD AND DRUG ADMINISTRATION . -
MEDICAL DEVICE USER FEE COVER SHEET A?&”;?f:;’ﬁg:;g’;’bﬁmﬁa 09132’1: 956733

A completed Cover Sheet must accompany each orniginal application or supplement subject to feas. The following actions must be taken to
property submit your appfication and fee payment:

1. Electronically submit the completed Cover Sheet to the Food and Drug Administration (FDA) before payment is sent.

2 Include a printed copy of this completed Cover Sheet with a check made payable to the Food and Drug Administration. Remember
that the Payment ldentification Number must be written on the checic,

3. Mail Check and Cover Sheet to the US Bank Lock Box, FDA Account, P.O. Box 856733, St. Louis, MO 631956733 (Note In po
case should payment be submitted with the application.)

4. iyou prefer to send a check by a coutier, the courier may deliver the check and Cover Sheet lo: US Bank, Alttn: Govermnment

Lockbox 956733, 1005 Convention Plaza, St {ouis, MO 63101, (Note: This address is for courier delivery only. Contact the US

Bank at 314-418-4821 if you have any questions concerning courier delivery.)

For Wire Transfer Payment Procedures, please refer to the MDUFMA Fee Payment Instructions at the following URL:

http//www.fda.goviedrhmdulma/fags himi#3a. You are responsible for paying all fees associated with wire transfers.

6. Include a copy of the completed Cover Sheet in volume one of the application when submitting to the FDA at etther the CBER or
CDRH Dacument Mail Center.

@

1. COMPANY NAME AND ADDRESS (indude name, sireet 2 CONTACT NAME

address, city, state, country, and post office code) ROBERT THATCHER
APPLIED NEUROQSCIENCE, INC. 21 E-MAIL ADDRESS
228 176 TH TERRACE DRIVE rwthatcher@yshoo.com

ST. PETERSBURG, FL 33708
22 TELEPHONE NUMBER (Include Area Code)

7271-392-7851
1.1 EMPLOYER IDENTIFICATION NUMBER (EIN)
S593260424 2.3 FACSIMILE (FAX) NUMEER (Include Area Code)
727-315-1027

3. TYPE OF PREMARKET APPLICATION (Seled one of the following in each column; if you are unsure, please refer to the application
descriptions at the foliowing web site: hitp:/fwww fda .govioe/mdufma

Select an application type: 3.1 Select one of the types below:
M premarket nofification (510(k)); except for third party reviews EOri.tﬁmi' Application
D Biologics License Application (BLA) Supplement Types:

Premarket Approval Application (PMA) ] Efficacy (BLA)

Modular PMA

Panel Track (PMA, PMR, PDP)
Real-Time (PMA, PMR, PDP)
D3 180-day (PMA. PMR, POP)

4. ARE YOU A SMALL BUSINESS? (See the instructions for more informabort on determining this status )

Product Development Protocol (PDP)
D Premarket Report (PMR)

EYES. | meet the small business criteria and have submitted the D NO, | am not a small business
required qualitying docurments to FDA

4.1 I Yes, please enter your Small Business Decision Number:
SBDO047091

5.18 THIS PREMARKET APPLICATION COVERED BY ANY OF THE FOLLOWING USER FEE EXCEPTIONS? IF SO, CHECK THE
APPLICABLE EXCEPTION,

E] This application is the first PMA submilted by a qualified small D The sole purpose of the application is 1o support
business, including any affiliates, parents, and partner firms corditions of use for a pediatric population

D This biclogics apphication is submitted under section 351 of the [:] The application is submitted by a state of federa!
Public Health Service Act for a product licensed for further government entity for a device that is not to be distributed
manufacturing use only commercially

6. IS THIS A SUPPLEMENT TO A PREMARKET APPLICATION FOR WHICH FEES WERE WAIVED DUE TO SOLE USE IN A
PEDIATRIC POPULATION THAT NOW PROPOSES CONDITION OF USE FOR ANY ADULT POPULATION? (If s0, the apphication is
subject to the fee that appiies for an original premarket approval application (PMA) )

DOves Mno ,
7. USER FEE PAYMENT AMOUNT SUBMITTED FOR THIS PREMARKET APPLICATION (FOR FISCAL YEAR 2004)
$2.784.00

https://f‘dasﬁnapp4.fda.gov/CFAPPS/mdufma/coversheet/lndex.cﬁn?ﬁlseacﬁon=ﬁzse_Rpt... 4/23/2004
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DEPARTMENT OF HEALTH AND HUMAN SERVICES Farm Approval
FOOD AND DRUG ADMINISTRATION oMB Tigh 93;:)—91:.0 0. 2004
CDRH PREMARKET REVIEW SUBMISSION COVER SHEET pieton St om0
Dato of Submission User Foa Payment 1D Number FOA Submission Document Number (7 kriowr))
05/03/2004 SBDO47091

SECTION A TYPE OF SUBMISSION

PMA PMA & HDE Supplement PDP
Original Submission Regular (120 day) Original PDP
Premarket Repont Special Notice of Completion Pre-IDE Mesting
Modular Submission Panet Track (PMA Only} Ameandment to PDP Pre-PMA Mesting
Amendment 30-day Supplement Pre-PDP Mesting
Repon 30-day Natice Day 100 Mesting
Report Amendrment 135-day Supplement Agreament Meeting
Ucensing Agreement Reat-time Review Determination Meeting
D %ﬁf\d&mm I:uMA & Other (specify):
D Other
IDE Humanitarian Device Class  Examption Patition Evaluation of Automatic Other Submission
Exemption (HDE) Ciass I Designation
) ) (De Novo)
[Joriginat Submission [ odginat Subrmission B Original Submission Original Subrmission B §13(g)
Amendment Amendment Additional irformation Adcitional | " Gther
Supplement Supplement rlommation {dascribe submission):
Rsport
Aepon Amendment

Have you used or cited Standards in yout submission? Clyss [Ono {if Yes, pioase compiete Section I, Page 5)
SECTION B SUBMITTER. APPLICANT OR SPONSOR

Gompany / Instiution Name Establishment Registration Number (¥ known)
Applied Neuroscience, Inc.
Division Name (¥ applicabis) Phone Number (including area code)
( 727 ) 392-7851
Street Address FAX Number (inciuding area code)
| 228 176th Terrace Drive { 727 ) 3181027
City Stiate / Province ZIF/Postal Code Country
St. Petersburg FL 33708 USA
Comact Name

Robert W. Thatcher

Gortact Title Contact E-mail Address
President rwthatcher@yahoo.com

SECTIONC APPLICATION CORRESPONDENT {e.g., consult
Company / Instibution Name

ant, if different trom above)

Division Name (¥ applicable) Phone Number (including arse code)
( )
Street Address FAX Number finchucing area code)
( )
City Siate / Province ZiP/Postal Code Country
Gontact Name
Comact Title Contact E-mait Address
FORM FDA 3514 (12/03) PAGE 1 OF 5 PAGES

PST Macha Ares (301, 440 1000 EF
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SECTION D1

Withdrawal

Additional or Expanded Indications

Request for Extension

Post-approval Study Protocol

Requast for Applicart Hold

Request for Removal of Appicant Hold
Raquest to Remove or Add Manufacturing Site

D Process change:
Marnufacturing
Sterilization
Packaging

Other (speoily balow)

REASON FOR APPLICATION - PMA. PDP. QR HDE

D Responsa to FDA comespondence:

D Change in design, component, or Danatm change:
Heation: Mart
Software /Hardware Sterilizer
GColor Additive Packager
Material
Specificat
Other (specify below) [CJrepon Submission:
Annuat or Periodic
Post-approval Study
[Jiebeting change: Adverse Reaction
Indications Device Defsct
Instructions Amendmant
Parformance .
Shel Lile
Trade Name Change in Ownership
Cther (specify bolow)} Change in Correspondant
Change of Applican Address

m Other Rsason (specify):

SECTION D2

New Device
New Indication

[[] Aadition of institution

Expansion / Extension of Study

| |1AB Cenification

|| Termination of Study

] Withdrawal of Application

] Unanticipated Adverse Ettect

[ | Notification of Emergency Usa

|_] Compassionate Use Request

| ] Treatment IDE

] Continued Access

REASON FOR APPLICATION - IDE

[ crange in: ] Renose 1o FDA Letier Gonceming:
Corraspondent / Applicant Conditional Approval
Design /Device Deemad Approved
Informed Consent Deficient Final Report
Manwfacturer Deficient Progress Report
Manufacturing Procerss Defcient investigator Report
Protocol - Feasibiity Disapproval
Protocol - Other Request Extension of
Sponsor Time to Respond 10 FDA

Request Mesting

[ Repon submission: Request Hearing
Curren Investigator
Annual Progress Report
Site Waiver Repor
Final

E Other Reason (spedify):

SECTION D3

E/JNawDevica

REASON FOR SUBRISSION - 510k}

3 Adciional or Expanded Indications [CJcnange in Technoingy

[[] other Reason (specify):

FORM FDA 3514 (12/03)

FOI - Page 25 of 290
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SECTION E ADDITIONAL INFORIMATION ON 510(K) SUBMISSIONS

Product codes of devicas to which substantial aquivalence is claimed Summary of. or statement conceming,
K974748 2| K912938 3{ KB854362 4| k951594 Safoy and effectiveness informatio
! [#1510 () summary attached
5| K904269 6| K860801 7| KB40430 8| K870263 1510 60 statement
Information on devices to which substantial equivalence is claimed (f known)
: 510(k) Number m Trade or Proprietary or Modsl Name Manutachwer
; K974748 ; NeuroMetric Analysis System ] NxLink, Inc.
» K912938 » Stellate ” Parsyst Development Comp.
3 K854362 3 Maodified Brain Atlas Il s Biologic Systems Corporation, Inc,
o K351594 4 Bio-Logic Automalic Event Analysis . Biologic Systems Corporation, Inc.
s K904269 5 Neurosearch-24 s Lexicor Medical Technotogy, Inc.
o KB60801 6 Spectrum-32 o Cadwsll Laberatories, inc.

SECTION F PRODUCT I
Common or usual name or dassification

EEG Frequency Spectrum Analyzer

24 Trade or Proprietary or Model Name for This Device

t | NeuroGuide Analysis Systemn 1

2 2

3 3

4 4

5 5

FDA document numbers of ail prior related submissions (regardiess of outcome)
1 2 3 4 5 6
7 8 9 10 " 12

[] Laboratory Testing R avimat Trisss [CJruman trsks

SECTION G

Product Code CF.R. Section (i appicabie)

aws [Flcasst  [Coassn
Classification Panel

EEG Frequency Spectrum Analyzer Olcessw  [Junclassified
indications {from labeking)

The NeuroGuide Analysis system is to be used by qualified heaith practitioners for the post-hoc statistical evaluation of the human
etectroencephalogram (EEG).

FORM FDA 3514 {12/03) PAGE 3 OF 5 PAGES
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or 2891a Device Establishment Registration form.
SECTION M
[Joriginai

Qace  [Jooers

FDA Establishment Registration Number

Nofe: Submission of this information does not affect the need o submit a 2691

MANUFACTURING / PACKAGING / ST

FOA Document Number (¥ known)

ERILIZATION SITES RELATING TO A SUBRISSION

[manutacturer ] Gontract Sterizer
[Jcontract Manutactuwrer  [T] Repackager / Relabeter

Company / instiution Name Establishrment Registration Number
Division Name (7 applicable) Phane Number (including aree code)
( )
Street Address FAX Number {including aroe cods)
( )
Cay State / Province ZiP Cade Country

FDA Estabishment Regisiration Number

E]Add D Dalote

DManMum

[ contract sterikzer
[Jcontract Manutacturer ] Repackager / Relabeler

Company / Institution Name

Establishment Registration Number

Division Name [ appficaia]

Phone Number (including area codea)

( )

Street Address FAX Number finciuding area code)

( )
City Siate / Province 2P Code Country
Contact Name Contact Titke Gortact E-maR Address

FDA Establishment Aegistration Number
¢ an D Manufacturer D Coniract Seriizer

DMd DDele!e Dcormnluanufaciw Dﬁopackagorinahboler
Company / InstRution Name Establishmant Registration Number
Division Name (i applicable) Phone Number (inciluding area cods)

( )
Strest Address FAX Number finchuding area code)

( )
Gity State / Province ZIP Code Country

Comact Name

FORM FDA 3514 (12/03)
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SECTION | UTILIZATION OF STANDARDS '

Note: Complete this section if your application or submission cites standards or includes a "Declaralion of Conformity to & Recognized Standard”
statemeant.
Standards No. tandards Standards Title Version Date
ganization
1
Standards No. Standards Standards Title Version Date
Organization
2
Standards No. Standards Standards Title Vérsion Date
Qrganization
3
Standards No. Standards Standards Title Version Date
Organization
4
Standards No. Stendards Standards Titie Varsion Date
Organization
5
Standards No. Standards Standards Title Version Date
Organization
6
Standards No. Standards Standards Thle Version Date
Organization
7
Please include any additional standards to be cited on a separate page.
Public reporting burden for this collection of ioformation is estimated to average 0.5 hour per FESpOfIse, ihcinding the tme for reviewing instructions, searching
existing data sources, gathering and maintaining the data aeeded, and completing reviewing the collection of nformation. Send comments reparding this burden
cstimate or any other aspect of this collection of information, including suggestions for reducing this burden to:
Food and Drug Administration
CDRH (HFZ-342)
9200 Cotporate Blvd.
Rockville. MD 20850
An agency may not conduct or sponser, and a person Is not required 1o respond to, a collection of informarion unless it displays a currently valid OME control

FORM FDA 3514 (12/03) PAGE 5 OF 5 PAGES
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Thatcher — 510(k) Application

Cover Letter

Submitter’s Name:
Submitter’s Address:
Submitter’s Tel. No.:
Submitter’s Fax No.:
Contact Name & Title:
Contact email:

Date of Preparation:

Reason for Submission:

Name of the Device:
Classification Name:
Product Code:
Regulation Number:
Device Class:

Registration Number:

Sincerely,

510(k) Application

Applied Neuroscience, Inc.

228 176" Terrace Drive, St. Petersburg, Fl1 33708
727-392-7851

727-319-1027

Robert W. Thatcher, Ph.D.; President

rwthatcher@yahoo.com

May 10, 2004

New Device with Substantial Equivalence (SE)
NeuroGuide Analysis System (NAS)

EEG Frequency Spectrum Analyzer

GWS

882.1420

Class I (general controls)

None

KAt W Tl

Robert W. Thatcher, Ph.D.
President Applied Neuroscience, Inc.
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Thatcher — 510(k) Application 8

Device Description - Over the Shelf Software (OTS)

1- Minor level of Concern Medical Device: The NeuroGuide Analysis System (N AS)
is over the shelf software (OTS) that analyzes EEG waveforms and represents no threat
of direct harm to the patient because there is no direct connection to a patient. The risk of
indirect harm from a misdiagnosis relating to medical device malfunction is small since
the worst case is an incorrect image or incorrect statistical computation which is
considered correct. The NeuroGuide Analysis System software (NAS) is intended to be
used to spectrally analyze digital EEG off-line. NAS is not an integral part of EEG
systems that acquire and digitize EEG. NAS only accepts digital EEG that has been
previously achieved or stored on another device (host system). The OTS Software in this
medical device thus represents a Minor Level of Concern and should satisfy BASIC
DOCUMENTATION.

2- Device Description: The NeuroGuide Analysis System (NAS) is a software program
for the post-hoc statistical analysis of the human electroencephalogram (EEG). EEG
recorded on a separate device (i.e., the host system) is transferred to the NAS for display
and user-review. The system requires that the user select reliable samples of artifact-free,
eyes-closed or eyes open resting EEG from the recording for analysis. Analysis consists
of the Fast-Fourier Transformation (FFT) of the data to extract the spectral power for
each of the four primary frequency bands (delta, theta, alpha, and beta), and frequency
information from the EEG. The results of this analysis are then subjected to univariate,
bivariate, and multivariate statistical analyses and displayed in statistical tables and
topographical brain maps of absolute and relative power, power asymmetry, and
coherence for 19 monopolar and 171 selected bipolar derivations of the EEG. In all over
1,200 measures are derived for comparison against a carefully constructed and
statistically controlled age-regressed, normative database in which the variables have
been transformed and confirmed for their Gaussian distribution. Each variable extracted
by the analysis is compared to the database using parametric statistical procedures that
express the differences between the patient and an appropriate age-matched reference
group in the form of Z-scores. Multivariate features are compared to the normative
database using Gaussian Multivariate Distance Statistics. The Gaussian multivariate
Distance statistic controls for the interrelationship of the measures of brain cortical
function in the feature set, and provides an accurate estimate of their difference from
normal. The multivariate measures permit an evaluation of regional indices of brain
function that reflect the perfusion fields of the brain. Extracted feature sets are further
analyzed to determine if the pattern of ‘hits’ (statistically significant feature score values
identified for the patient) are consistent with patterns of *hits’ identified in prior
neuroguide evaluations of clinical patients with known disorders. A step-wise
discriminate analysis program classifies the patient in terms of their similarity to known
neuroguide-defined patterns of abnormality, providing a probability estimate of the
patient’s profile with the average profile of groups of individuals constituting the
normative and clinical database. The discriminant classification program is restricted by
confining potential outcomes to specific patient symptoms derived from the patient
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Thatcher — 510(k) Application 9

history profile. Established discriminant functions were evaluated through the use of
Receiver Operating Characteristic (ROC) curves for their sensitivity and specificity. The
outcome of the statistical analysis is presented in report form that includes (a) patient
demographic and history information, (b) selected EEG epochs, (c) statistical tables of
monopolar, bipolar, and multivariate extracted feature values, and topographical brain
maps. This information is to be read and interpreted within the context of the current
clinical assessment of the patient by the attending physician/clinician. The decision to
accept or reject the results of the neuroguide analysis, and incorporate these results into
their clinical appraisal of the patient, is dependent upon the judgment of the attending
physician or clinician. The Windows operating system (Windows 97, 98, ME, 2000, XP
and NT) is used to interface the user, the microcomputer hardware platform, the stored or
archived digital EEG data, statistical processing programs, data storage, and output
devices.

FOI - Page 31 of 290
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Thatcher — 510(k) Application 10

Intended use of the Device

The NeuroGuide Analysis system is to be used by qualified medical and/or qualified
clinical professionals (e.g., licensed clinical Ph. D.) for the post-hoc statistical evaluation
of the human electroencephalogram (EEG).

10
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e-

4-
a-
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Basic Documentation for NeuroGuide OTS Software
What is it?

NeuroGuide Analysis Software (NAS) is manufactured by Applied Neuroscience,
Inc.

Version Level 2.0, expected release in fall 2004. Documentation for software
changes are in the NeuroGuide manual which a user can activate by clicking Help
at the menu bar.

OTS Software documentation is a manual and a draft copy is in Appendix A
NAS OTS Software is appropriate for EEG amplifier and EEG acquisition
devices and such devices serve as host media by which the EEG is acquired and
then off-line copied to a file where the NAS can import the digital EEG wave
forms.

The design limitations are proper computation of the spectral analysis which can
be evaluated by calibration sign waves using built in programs and the
approximation to Gaussian or normal distributions.

What are the Computer System Specifications for the OTS Software?

IBM compatible hardware platform (PC), any processor speed, 128 mbyte RAM
is recommended, minimum of 100 mbytes of hard disk space, standard display.
Operating system is Windows 97, 98, ME, 2000, XP or NT.

How will you assure appropriate actions are taken by the End User?

An installation wizard automatically installs all components of the software,
Once installed the configuration does not change.

Users should be trained in visual or conventional analysis of the EEG, in digital
signal processing and in qEEG analysis,

NeuroGuide Analysis Software is a stand-alone software program and non-
specified OTS software is prevented from being used or incorporated into the
NAS by design.

False positive and false negative errors (i.c., Type | & Type 1I) are minimized by
the use of a range of probabilities from 2 standard deviations P<0l)toé6
standard deviations (i.e., P < .0000001). See verification and validation tests of
Gaussian distributions in Appendix B.

What does the OTS Software do?
The NAS software is intended to compute off-line spectral analyses of EEG
waves. The details of the various features and analyses of NeuroGuide are

11
29



Thatcher - 510(k) Application 12

provided in the NeuroGuide Manual (see Appendix A). Built in error messages
are presented if a user performs an illegal operation, e.g., wrong montage,
mismatch of host amplifier format (i.e., unable to read file), notification that no
age of the subject was specified and thus no Z scores are provided and duplication
of electrodes in montage creation. The program will automatically not continue
with the user’s request for information processing if any error condition occurs.
The user has the option to follow the instructions of the error message and then
repeat an analysis or to begin a different analysis. The occurrence of an error
message indicates an improper procedure and the user can simply repeat the steps
using the proper conditions.

b- Links to other software are by saving artifact free selections of digital EEG in
ASCII or text format on a disk or in computer memory. ASCI is a universal
format in which stand alone software such as Microsoft Word or Excel or EEG
inverse solution software such as low resolution electromagnetic tomo graphy
(LORETA) or EEG biofeedback or general statistical software which can be used
to analyze the digital EEG. Linkage by exporting Z scores and the results of
statistical analyses occurs by ASCII export and/or in formats that are valid and
accepted by other stand alone software programs for the purposes of verification
and validation.

5. How do you know it works? — Based on a Minor Level of Concern

a- The NAS OTS software is not connected to a patient and it is an off-line analysis
that is validated by microvolt calibration sine waves varying in frequency from
0.5 Hz to 30 Hz and in amplitude from 1 microvolt to 100 microvolts. All of the
NeuroGuide Analysis system’s fast Fourier transform (FFT) algorhythms are
tested at the same time for all channels using sine waves.

b- Results of the testing, including verification and validation of testing results is

provided in Appendix B and is described as the Signal Generator that the user is

recommended to use in order to verify and validate the NAS for themselves.

In the event users find a bug then they can notify Applied Neuroscience, Inc. by

email and/or telephone. Updates of the NAS will be posted on the Applied

Neuroscience, Inc. website and updates of the software can be downloaded by

NAS users. :

C

1

6. How will you keep track of (control) the OTS Software?

a

t

The NAS can be downloaded as a free demo. The NAS is installed as compiled
object code which can not be modified.

b On start-up a copyright license agreement is displayed and the user is required to
accept the terms of the copyright agreement which forbids tampering, adulteration,
modification, reverse engineering and other unlawful conduct and provides legal

12
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safeguards. If user’s choose not to accept the terms of the copyright license
agreement then NAS automatically terminates.

On start-up NAS software records the serial numbers of the user’s computer hard
drive and encrypts these values in a 24 element code called Key A. A security
Key window displays the Key A and if no Key B is entered then the software
automatically launches a demo. The free demo protects NeuroGuide as a product
because the Demo does not allow for importation of EEG by the user.

After purchase the customer’s Key A is sent to Applied Neuroscience, Inc. and a
24 element Key B is sent to the user. The Key B is an encrypted version of Key
A. On start-up and after accepting the terms of the copyright agreement the NAS
software checks the serial numbers of the user’s computer and if there is a
mismatch to the serial numbers in the user’s copyright license Key B then the
NAS will only operate in Demo mode. In Demo mode the user is limited to the
use of the signal generator and to a sample file of EEG and the user will not be
able to import EEG from a host device.

The NAS software is stored on the user’s hard disk. The default location is:
c:/program files/NeuroGuide.

Installation is by a Microsoft installation wizard that automatically installs the
software and does allow users an option to modify or change the NAS.
Maintenance and life cycle support for the NAS OTS Software is provided by
Applied Neuroscience, Inc. and updates are posted on the Applied Neuroscience,
Inc. website and users are notified of all updates.

13
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Thatcher — 510(k) Application 14

Proposed labeling and advertising for the device

1- Labeling on CD Jacket — Appendix A:

“NeuroGuide — EEG Editing and Analysis Software ~ Featuring a Normative
Database, Discriminants and Statistics”

2- Labeling in the NeuroGuide Manual (Page 65 of manual - see Appendix A)

Warning: NeuroGuide does not diagnose and only provides displays of the
digital EEG and statistical analyses of selected EEG segments. NeuroGuide requires
competent human intervention for it's many mathematical tools and NeuroGuide is only
considered as an adjunct and/or as a supplement to other measures that may aid in
evaluating the status of the EEG by a competent person. Clinical use of NeuroGuide
requires a competent medical or clinical professional. NeuroGuide is a standalone .
software package that uses "look up” table functions to create Z scores which are a
reference based on published scientific selection criteria of samples of EEG (Thatcher et
al 1987; 1986; 1989; 2003) and the use of these tables is at the discretion of the
competent professional. It is advised that reliability measurers and validity tests using
different montages and different selections of EEG be conducted as a routine procedure
when using NeuroGuide. NeuroGuide was designed to allow for mouse click selections
and testings of hypotheses and reliability and validity using digital analyses of the EEG. .
qEEG is not a substitute for EEG, but an addition to EEG. Some forms of clinically
important information are better recognized by eye than by quantification, and the visual
inspection of the waveform EEG data is a good way to monitor and control the level of
consciousness as well as eye movement and muscle artifacts. A qEEG device will not
substitute for lack of EEG training, qEEG is more demanding than classic EEG on both
the clinician and technologist. Those performing and reading of qEEG studies must not
only have basic EEG skills, but must also have a functional understanding of the
numerical and statistical techniques used in qEEG, be specifically trained in qEEG
analysis and be aware of the necessity for better control of artifact and subject state.
qEEG should always be interpreted by a knowledgeable clinician in the light of all
relevant information

Contra indications: EEG artifact can invalidate analyses and improper positioning of
electrodes or significant deviations from accepted standards of electroencephalographic
recording methodology can invatidate EEG recordings or erroneous storage of data and
falsification of data, improper manipulation of data or unlawful uses of NAS including
violations of copyright law and other improper uses of NAS are all contra indicated.

3- Labeling in NeuroGuide Introduction Brochure (Page 1 of Manual)

NeuroGuide provides tools as analytical resources and as an EEG reference based
on peer reviewed scientific publications. Any clinical use must be by qualified medical

14
g2
FOI - Page 36 of 290



Thatcher - 510(k) Application 15

or clinical professionals restricted to the post-hoc statistical evaluation of the human
electroencephalogram (EEG).  NeuroGuide is to be used only by competent and trained
individuals. EEG artifact can invalidate analyses and improper positioning of electrodes
or significant deviations from accepted standards of electroencephalographic recording
methodology can invalidate EEG recordings or erroneous storage of data and falsification
of data, improper manipulation of data or unfawful uses of NeuroGuide including
violations of copyright law and other improper uses of NeuroGuide are all contra
indicated.

I5
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Predicate/legally marketed devices upon which substantial equivalence
is based:

Cordis Brain State Analyzer (no FDA information available); TECA Corporation
Neurolab I, II (K844481), Brain Mapper (K890-881), Neuromapper 386 (K894889);
Nicolet BEAM [, II (no FDA 510(k) information available); Pathfinder 11 (K801604);
Brain Functional Map (K843598); Cadwell Laboratories, Inc. 8400 (K860801) and
Spectrum 32 (K860801 reference); Lexicor Medical Technology Neurosearch-24
(K904269), Neurosearch-4 (K920038); Neuroscience, Inc. Map-10 EEG (K840430),
Neuromapper 1620 (K870263); Biologics Systems Corporation. Inc., Modified Brain
Atlas HI (K854362), Bio-Logic Automatic Event Analysis (K951594); Quantified Signal
Imaging, Inc. QSI-9500 (K904294), QSI-9200 (FDA 510(k) information not available);
Stellate Systems, Inc. Rhythm Software (K912938); NxLink, Inc. (K974748).

16
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Substantially equivalent statement
Comparison to Predicate Devices:

The NeuroGuide Analysis System uses substantially the same principles and
methods as predicate devices such as NxLink K974748 for data selection and analysis to
extract measures upon which statistical determination of normal/abnormal are made, and
from which derivations of probability estimates of clinical classification are derived. The
NeuroGuide Analysis System uses essentially identical power spectral analysis methods
the Fast Fourier Transform (FFT) spectral analysis of the electroencephalogram (EEG) as
do all predicate devices: EEG Frequency Spectrum Analyzer Regulation Number
882.1420. NAS uses the standard FFT technology which is as safe and effective as the
predicate devices and does not raise different issues of safety or efficacy. The
Neuroguide (NAS) method of EEG selection, analysis, and interpretation are
substantially the same as predicate devices and these methods have been previously
implemented, in whole or in part, in a variety of digital EEG and analysis systems
marketed in prior years for the quantitative analysis of the EEG in Man. The NAS
database was carefully constructed to control for potential sources of Type I and Type II
errors in the use of database comparisons in clinical electrophysiological assessment of
the human EEG. The NAS database and discriminant functions involve the same
statistical methods of Gaussian distributions and multivariate statistics as in predicate
devices. The development and cross-validations of the discriminant function and
database have been published in peer reviewed scientific journals (see Appendix C).
NAS uses the same principles and methods of predicate devices, but adds to these devices,
increased efficiency and computer speed thereby improving the user’s ability to

statistically analyze the EEG.

Table 1. Comparison with Predicate NxLink (K974748)

ELEMENT NEW DEVICE PREDICATE - K974748
Intended use Same as predicate Same as new device
Inputs host digital EEG Same as predicate Same as new device
Frequency range 0.5--30Hz 0.5-27Hz
Spectral Analyses FFT FFT
Coherence analysis Same as predicate Same as new device
Phase delay analysis Same as predicate Same as new device
Amplitude asymmetry Same as predicate Same as new device

Ratios of power

Same as predicate

Same as new device

Multivariate statistics

Same as predicate

Same as new device

‘Topographic color maps

Same as predicate

Same as new device

Normative database

Sample size = 625, age 2
months to 82 years

Sample size = 470, age 6
years to 92 years

(raussian Distributions

Same as predicate

Same as new device

Z scores

Same as predicate

Same as new device

Discriminant functions

Traumatic brain injury &
learning disabilities

Traumatic brain injury,
ADD, learning disabilities,

FOI - Page 39 of 290

17



Thatcher — 510(k) Application

18

depression
Reliability statistics Split/half & test re-test Test re-test only
Calibration Sine waves, phase delays, Sine waves
noise simulation
Artifact free editing Manual & template match Manual
Save EEG data ASCII, NeuroGuide & NxLink format only
Lexicor format

Print EEG selections

Same as predicate

Same as new device

Visual Display of EEG Same as predicate Same as new device

Neuropsychological Based on 466 subjects None provided to user

correlations

Peak Frequency Analysis By visual mouse navigation By software analysis

Re-montage Linked ears, Average Linked ears only
Reference & Laplacian

Operating System Windows DOS

Demo Software Available Same as predicate Same as new device

Safe and effective Same as predicate Same as new device

Peer reviewed publications Yes Yes

Speed of Computation Faster than predicate Slower than new device

I- Intended use — Clinical applications of the NeuroGuide Analysis system is to be used
by qualified medical or clinical professionals for the post-hoc statistical evaluation of the
human electroencephalogram (EEG). Same as predicate device K974748

2- Inputs host digital EEG - The NeuroGuide Analysis System is off-line stand alone
software that can be loaded into a IBM PC and used without any physical connection to a
patient or to a human subject the same as other predicate devices. EEG digital samples
from a host system are used off-line to digitally analyze the EEG samples. The predicate
device K974748 is also OTS and stand alone software and users access stored EEG

digital analyses in the same manner as the new device (NAS).

3 — Frequency Range — NAS analyses digital EEG over the frequency range from 0.5 Hz
to 30 hz. The predicate device K974748 analyzes over a similar frequency range but is
limited in the high frequency range to 27 hz.

4 - Spectral Analysis Algorhythm- Both the NeuroGuide analysis system and the
predicate device K974748 use the Fast Fourier Transform (FFT) algorhythm to compute

power spectra.

5- Spectral Analysis Measures- Both the NeuroGuide analysis system and the
predicate device K974748 use the same equations to compute absolute power, relative
power, ratios of power, coherence, phase delays and amplitude asymmetry.

6- Multivariate Statistics- Both the NeuroGuide analysis system and the predicate
device K974748 use the same multivariate statistical equations (e.g., discriminant
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ﬁmctio.ns, Mahalombis distance, multiple regression).

7. Normative Database - Both the NeuroGuide analysis system and the predicate device
K974748 have compiled a reference normative sample of EEG data using accepted and
published selection criteria of no history of neurological disorders, performing at grade
fevel and normal range of intelligence and neuropsychological test performance. The
NAS normative database (N = 625) spans the age range from 2 months to 82 years while
the normative reference database of the predicate device K974748 spans the age range
from 6 years to 92 years of age (N = 470).

8- Gaussian Distributions and Z scores- Both the NeuroGuide analysis system and
the predicate device K974748 use transforms to approximate a normal or Gaussian
distribution before computing any statistics. Both the NAS and the predicate device use
accepted tests of Gaussian distributions and both have published the results of these tests.
Z scores are computed by NAS and the predicate device K974748 using the same
equation.

9- Discriminant Functions- Both the NeuroGuide analysis system and the predicate
device K974748 use the same equations to compute discriminant functions. The NAS
has only computed discriminant functions for comparative analyses of age matched
normal subjects and traumatic brain injured patients as well as leamning disabled children.
The predicate device K974748 in addition to the above two discriminant functions, uses
additional discriminant functions based on other clinical populations. The scientific
principles and methods of discriminant analyses are the same independent of the number
of sub-groups.

10- Reliability Statistics- Both the NeuroGuide analysis system and the predicate device
K974748 use test re-test reliability statistics (i.e., the ratio of variance of the 1*' half vs.
the second half of the edited selections of EEG). The NAS also uses split-half reliability
measures (i.e., the ratio of variance of even vs. odd seconds of edited EEG). NAS
provides users with immediate feedback of the split/half and test re-test reliability in a
window at the left side margin of the display screen so that the user is immediately
provided with the reliability of the EEG selections.

11- Calibration- Both the NeuroGuide analysis system and the predicate device

K 974748 use sine waves of different amplitudes and different frequencies to calibrate the
software. The NAS provides more extensive calibration routines including a general user
interface {GUI) in which different phase delays and different ratios of signal to noise can
be computed and EEG simulated using mouse clicks. The GUI in NAS facilities tests of
the accuracy of the NAS and thus enhances the NAS level of safety and effectiveness in
comparison to the predicate device K974748. The principles and mathematical methods
are the same, but in comparison NAS takes advantage of the speed of computer
processing to make these measures available immediately during the editing process itself.

12- Artifact Free editing- Both the NeuroGuide analysis system and the predicate device
K974748 provide an easy to use display window by which users can manually delete

19
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artifact and/or select artifact free segments of EEG. The NAS facilitates the selection of
artifact free EEG by allowing users to select a template of artifact free EEG which is then
used to match or mismatch the peak-to-peak amplitude of other segments of EEG and
thus to select artifact free samples based on the best match to the artifact free template.
The artifact selection features of NAS, especially when used with the immediate
feedback by reliability statistics further enhances the safety and effectiveness of the NAS
over the predicate device. In NAS tutorials the user is encouraged to compare different
selections as well as comparing a selection of all of the EEG samples so that the extent of
distortion due to artifact can be quickly known.

13- Save EEG data- The predicate device K974748 only exports EEG data in NxLink
native format which can only be read by the predicate device and not by other software
systems and other predicate devices. The NAS, in addition to exporting in native
NeuroGuide format also saves EEG in the universal ASCII or text format which can be
read by other software programs and a wide range of stand alone software such as
Microsoft windows and Excel.

14- Print EEG selections- Both the NeuroGuide analysis system and the predicate
device K974748 allow users to print EEG data for visual analysis.

15- Visual Display of EEG- Both the NeuroGuide analysis system and the predicate
device K974748 provide users with a visual display of the digital EEG tracings so that
users can scan the EEG data and identify artifact free segments of the EEG. The
NeuroGuide analysis system facilitates the visual examination of EEG samples by taking
advantage of the windows operating system by which users can use mouse clicks to scan
through the EEG display while at the same time viewing the results of the FFT spectral
analysis of the edited selections.

16 - Neuropsychological correlations- Both the NeuroGuide analysis system and the
predicate device K974748 measured neuropsychological test performance when they
acquired their respective normative databases. The predicate device does not provide
users with predictive feedback based on the neuropsychological test scores, whereas the
NAS does provide users with feedback. This feature is a further enhancement of the
effectiveness of the NAS software in comparison to the predicate device.

17- Peak Frequency analysis- Both the NeuroGuide analysis system and the predicate
device K974748 provide users with the ability to compute peak frequency for each of the
channels of EEG. The users of NAS measure peak frequency by sliding the mouse over
the FFT and then reading the values in uv’/Hz in 0.5 Hz resolution whereas the predicate
device computes peak frequency in a given frequency band and displays these values in a
table.

18- Re-Montage- The predicate device K974748 only provides for a single montage of
a linked ears. The NAS extends the capability of scrutiny and analysis of the EEG by
allowing users to create different montages by a mouse click to Average reference and
Laplacian current source density. The average reference and the Laplacian are accepted
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measures that enhance the effectiveness of NAS by helping users to eliminate artifact and
to identify and select artifact free EEG samples.

19- Operating Systems - The predicate device K974748 uses the older Microsoft DOS
operating system whereas the NAS uses the Microsoft Windows operating system. The
use of the Windows operating system makes NAS more effective and enhances ease of
use by implementing mouse clicks to navigate thru NAS menus and analysis features.

20- Demo Software Available- Both the predicate device K974748 and NAS provide
demo software so that users can use stand alone software to learn how to use the
respective analysis systems, to educate and to allow users to calibrate the software. The
NeuroGuide Analysis System (NAS) includes demo software on a CD that were
compiled using a Windows 98, 2000, ME and XP compatible operating systems. The
NAS software program can also be downloaded from the internet as a demo software
program that is without the ability to open any EEG data file, except the demo file. All
of the calibration tests and analytical tests of NAS can be freely evaluated in the Demo.
NAS has been thoroughly tested and does not crash or abruptly halt and allows users to
save digital data and make back ups using the Window operating system, the same as
other predicate devices.

Compared to its predicate devices, the NeuroGuide Analysis System’s inclusion of
specific, appropriate, reliable and effective statistical controls over the method of data
selection and analysis, the scientific rigor involved in the construction, refinement, and
application of the normative and clinical databases, and the potential for providing a
practitioner with sensitive and specific quantitative indices of brain structure and function
that is both safe and effective and suggests that the NAS is a significant advancement in
the use of quantitative technology in neurology, psychiatry, and clinical neuropsychology
and is an advancement over predicate EEG analysis systems. High speed testing of
reliability and statistical measures of EEG is an advancement that NAS offers in
comparison to predicate devices.

21- Safe and effective - The software is calibrated and standardized and is safe and
effective. There is no direct connection between the software and any device that may be
connected to a patient. The NAS OTS and/or stand alone software does not provide
diagnoses and is used as an adjunct to other measures and the stand alone software is
intended for use by qualified and competent medical or clinical professionals the same as
other predicate devices. There is extensive calibration software and reliability measures
to enhance effectiveness and to minimize errors.

22- Peer reviewed publications — The NeuroGuide Analysis System utilizes data and
procedures that have been published numerous times over the last 25 years in peer
reviewed scientific and clinical journals. The software technology of NAS is derived
from accepted spectral analysis standards such as the FFT and CD analyses and has been
supported by grants from the National Institutes of Health, National Science Foundation,
USDA, Department of Defense, Veterans Administration and other government granting
agencies. The content and number of peer reviewed publications in support of the
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spectral analyses in NAS is substantially similar to the peer reviewed literature in support
of other predicate devices. A bibliographic listing of publications and example
publications are provided in the appendix.

23- Speed of computation speeds - The NeuroGuide Analysis System optimizes on
modern computer hardware and software library calls that substantially improve the
speed of computation in comparison to the predicate device.

22
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Non-clinical Testing:

Non-clinical testing of the NAS is essentially equivalent to predicate devices such as
NxLink (K974748) which included the evaluation of the algorithms and statistical
methods used for data analysis. Specifically, control signals, in the form of signal
generated waveforms, were analyzed for frequency and power- EEG signals were
analyzed for conformity between the host digital EEG system and the NAS. The NAS
includes a feature that reproduces sampling frequency in the host digital EEG system, and
permits the visualization and evaluation of the EEG waveform for accuracy between the
host system and the NAS translation. In addition, data obtained in previous
implementations of the NeuroGuide analysis method were evaluated for consistency and
accuracy - the resuits of the NAS’s analysis of stored subject data had to conform to that
of the prior analysis (which was conducted using the same method and procedures,
algorithms and method of analysis as that implemented on the NAS). The user of the
NAS can verify the accuracy of the EEG spectral analyses by using built in calibration
signals. Appendix-B is the manual and documentation for calibration of the NAS.

23
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Clinical Testing:

The ability of the NAS to accurately translate and present EEGs from clinical
patients was confirmed by the non-clinical testing. In order for the NAS to be an effective
implementation of the neuroguide method for clinical use, the results of the analysis (both
statistical tables and topographical brain maps) had to be in agreement with the results of
the analysis conducted on the host system used in the processing of patient information at
the Applied Neuroscience Laboratory. In addition, the outcome of the discriminant
analysis had to be consistent, not resulting in errors of misclassification (that is, the
classification on the NAS had to be consistent with that of the host system used to
perform the NeuroGuide analysis at the ANL). These tests confirmed that when eyes-
closed resting, and artifact-free EEG was selected for analysis, the results were
reproducible within an acceptable degree of variation consistent with reliability estimates
identified in the normative studies (see Appendix-C).

Subjects upon which this device has been tested included individuals which ranged in age
from 2 months to 82 years, and who were either volunteers or clinical patients referred
for neuroguide evaluation to the Applied Neuroscience Laboratory by the Department of
Psychiatry University of Maryland School of Medicine, and/or Shock Trauma and the
Applied Neuroscience Institute at the University of Maryland Eastern Shore. The resuits
of the analysis were conveyed to the referring physician and/or Ph.D. clinician who was
asked to use the information as an adjunct to their clinical interpretation of the patient’s
traditional EEG. The information was provided in report form (including EEG epochs
selected for analysis, statistical tables and topographic brain maps, and the result of the
discriminant analysis) to permit the physician or Ph.D. clinician to determine its
relevance to their clinical evaluation and diagnosis or treatment of the patient. When the
results are used in this manner, the likelihood of introducing error into diagnosis and
treatment is substantially reduced. That is, the test is viewed as an adjunct to the
evaluation of the patient, and does not serve as a primary basis for the diagnosis.

Potential adverse effects of the use of the device are known if the NeuroGuide Analysis
System is used as the sole diagnostic system, a use that is specifically contraindicated by
NAS in the absence of other clinical data from more traditional means of patient
evaluation. Relying only upon the use of a single index (such as relative power, or the
topographical maps alone) without reviewing the traditional EEG, the epochs selected for
analysis, or the complete set of statistical summary tables is also contraindicated and a
source of potential error. Additional sources of error could arise from the inappropriate
selection of EEG (selecting artifacted EEG epochs, or selecting EEG representative of
other states, such as drowsiness or eves-open EEG when comparing to an eyes closed
database, or by purposely selecting conditions for testing other than those specified.
Additionally, it is possible that errors will occur through the purposeful falsification of
symptoms in the patient history, and patient age.

24
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Conclusions Drawn From Non-Clinical and Clinical Testing:

The NeuroGuide Analysis System’s design and implementation was based upon
the results of an extensive, 25-year effort to construct a viable normative and clinical
database at the Applied Neuroscience Laboratory (ANL) at the University of Maryland.
The NAS incorporates the basic methods of data collection, data selection, analysis, and
interpretation developed at the ANL during the conduct of numerous government and
privately funded normative and clinical database projects. The results of the use of the
NAS to evaluate neurological and psychiatric disorders of the brain is published in
numerous peer reviewed papers over this 25 year period.

The appropriate use of the NeuroGuide Analysis System as an adjunct to the
traditional visually-appraised EEG provides the user with the ability to quantify EEG
variables and use them to answer questions drawn from their clinical experience with the
patient. When used by an experienced, qualified practitioner, or under the proper
supervision of a quatified medical professional, the NAS is concluded to be a useful and
beneficial addition to the array of clinically accepted medical tests and devices used to
evaluate brain structure and function.

The results of non-clinical and clinical resting conducted over the past 20 years
demonstrates that the NAS is both safe and effective for the quantitative analysis of the
eyes-closed resting EEG in the alert human subject, Used to determine if the EEG is
normal or abnormal, and if abnormal, to statistically characterize the distribution of
selected derived features by their probability of being similarly distributed in specified
groups of clinical patients, the NAS provides information that both complements and
supplements the outcome of the analysis of a traditional EEG. This information, when
properly used in conjunction with other clinical tests as a safe and effective adjunctive aid
to diagnosis, treatment planning, and treatment follow-up of the neurologic and
psychiatric patient.
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FDA 510(k) Summary

Section 807.92

(a)(1). Submitter’s Name: Applied Neuroscience, Inc., 228 176" Terrace Drive, St.
Petersburg, FL 33708. Phone: (727) 392-7851; Fax: (727) 319-1027; email:
rwthatcher@yahoo.com.

Coutact Person: Robert W, Thatcher. Ph.D. Applied Neuroscience, Inc.., 228 176™
Terrace Drive, St. Petersburg, FL 33708. Phone: (727) 392-7851; Fax: (727) 319-1027;
email: rwthatcher@yahoo.com.

Date of preparation: 5/9/2004

(a}(2). Name of the Device: NeuroGuide Analysis System (NAS). Classification name:
EEG Frequency Spectrum Analyzer.

(2)(3). Predicate/legally marketed devices upon which substantial equivalence is
based: Cordis Brain State Analyzer (no FDA information available); TECA Corporation
Neurolab I, IT (K844481), Brain Mapper (K890-881), Neuromapper 386 (K894889);
Nicolet BEAM I, II (no FDA 510(k) information available); Pathfinder II (K801604);
Brain Functional Map (K843598); Cadwell Laboratories, Inc. 8400 (K860801) and
Spectrum 32 (K860801 reference); Lexicor Medical Technology Neurosearch-24
(K904269), Neurosearch-4 (K920038); Neuroscience, Inc. Map-10 EEG (K840430),
Neuromapper 1620 (K870263); Biologics Systems Corporation. Inc., Modified Brain
Atlas ITf (K854362), Bio-Logic Automatic Event Analysis (K951594); Quantified Signal
Imaging, Inc. QSI-9500 (K904294), QS1-9200 (FDA 510(k) information not available);
Stellate Systems, Inc. Rhythm Software (K912938); NxLink, Inc. (K974748).

(a)(4). Device Description: The NeuroGuide Analysis System (NAS) is a software
program for the post-hoc statistical analysis of the human electroencephalogram (EEG).
EEG recorded on a separate device (i.., the host system) is transferred to the NAS for
display and user-review. The system requires that the user select reliable samples of
artifact-free, eyes-closed or eyes open, resting digital EEG for purposes of analysis.
Analysis consists of the Fast-Fourier Transformation (FFT) of the data to extract the
spectral power for each of the four primary frequency bands (delta, theta, alpha, and beta),
and frequency information from the EEG. The results of this analysis are then subjected
to univariate, bivariate, and multivariate statistical analyses and displayed in statistical
tables and topographical brain maps of absolute and relative power, power asymmetry,
and coherence for 19 monopolar and 171 selected bipolar derivations of the EEG. In all
over 1,200 measures are derived for comparison against a carefully constructed and
statistically controlled age-regressed, normative database in which the variables have
been transformed and confirmed for their Gaussian distribution. Each variable extracted
by the analysis is compared to the database using parametric statistical procedures that
express the differences between the patient and an appropriate age-matched reference
group in the form of Z-scores. Multivariate features are compared to the normative
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database using Gaussian Univariate and Multivariate Distance Statistics. The Gaussian
multivariate Distance statistic controls for the interrelationship of the measures of brain
cortical function in the feature set, and provides an accurate estimate of their difference
from normal. The muitivariate measures permit an evaluation of regional indices of brain
function that reflect the perfusion fields of the brain. Extracted feature sets are further
analyzed to determine if the pattern of “hits’ (statistically significant feature score values
identified for the patient) are consistent with patterns of ‘hits’ identified in prior
neuroguide evaluations of clinical patients with known disorders. A step-wise
discriminate analysis program classifies the patient in terms of their similarity to known
neuroguide-defined patterns of abnormality, providing a probability estimate of the
patient’s profile with the average profile of groups of individuals constituting the
normative and clinical database. The discriminant classification program is restricted by
confining potential outcomes to specific patient symptoms derived from the patient
history profile. Established discriminant functions were evaluated through the use of
Receiver Operating Characteristic (ROC) curves for their sensitivity and specificity. The
outcome of the statistical analysis is presented in report form that includes (a) patient
demographic and history information, (b) selected EEG epochs, (c) statistical tables of
monopolar, bipolar, and muitivariate extracted feature values, and topographical brain
maps. This information is to be read and interpreted within the context of the current
clinical assessment of the patient by the attending physician/clinician. The decision to
accept or reject the results of the neuroguide analysis, and incorporate these results into
their clinical appraisal of the patient, is dependent upon the judgment of the attending
physician or clinician.

The NeuroGuide Analysis System is complete on a single CD, which contains a
demonstration program with sample NeuroGuide studies, the NAS program, and the print
program. The NAS was designed for implementation under Windows, and programmed
using C. The user interface was carefully designed and implemented to permit the
program to be easy to use, highly reliable in its performance. A variety of control
procedures are used to record stops used in program usage, and the conduct of the
analysis to insure appropriate function end operation of the software. The NAS can be
installed in any appropriately configured IBM-compatible computer system, including
systems designed specifically for the recording of digital EEG. The system functions with
a wide-range of standard computer platforms and input-output devices, and printers.

(a)(5). Statement of Indications of Use: Indications for the use of the NeuroGuide
Analysis System (NAS) are as follows:

Indications of Use

The NeuroGuide Analysis system is to be used by qualified medical and qualified clinical
professionals for the post-hoc statistical evaluation of the human electroencephalogram
(EEG).

(a)(6). Comparison to Predicate Devices: The NeuroGuide Analysis System uses
essentially the same accepted methods of data selection and analysis of predicate devices
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to extract the feature measures upon which statistical determination of normal/abnormal
are made, and from which derivations of probability estimates of clinical classification
are derived. The neuroguide method of EEG selection, analysis, and interpretation have
been previously implemented, in whole or in part, in a variety of digital EEG and analysis
systems marketed in prior years for the quantitative analysis of the EEG in Man. The
NAS database, the same as for predicate devices, was carefully constructed to control for
potential sources of Type [ and Type H errors in the use of database comparisons in
clinical electrophysiological assessment of the human EEG. The purposeful, easy to use,
and reliable design of the NAS has been enhanced relative to these earlier systems
through the careful consideration of user interactions by optimizing on the speed of
modern computer technology to facilitate user feedback and hypothesis testing with
mouse clicks.

(b). Non-clinical and Clinical Tests: The NeuroGuide Analysis System’s design and
implementation was based upon the results of an extensive, 25-year effort to construct a
viable normative and clinical database at the Applied Neuroscience Laboratory (ANL) at
the University of Maryland. The NAS incorporates the basic methods of data collection,
data selection, analysis, and interpretation developed at the ANL during the conduct of
numerous government and privately funded normative and clinical database projects

(b)(1). Non-clinical Testing: Non-clinical testing of the NAS included the evaluation of
the algorithms and statistical methods used for data analysis. Specifically, control signals,
in the form of signal generated waveforms, were analyzed for frequency and power- EEG
signals were analyzed for conformity between the host digital EEG system and the NAS.
The NAS includes a feature that reproduces sampling frequency in the host digital EEG
system, and permits the visualization and evaluation of the EEG waveform for accuracy
between the host system and the NAS translation. In addition, data obtained in previous
implementations of the NeuroGuide analysis method were evaluated for consistency and
accuracy - the results of the NAS’s analysis of stored subject data had to conform to that
of the prior analysis (which was conducted using the same method and procedures,
algorithms and method of analysis as that implemented on the NAS).

(b)(2). Clinical Testing: The ability of the NAS to accurately translate and present EEGs
from clinical patients was confirmed by the non-clinical testing. In order for the NAS to
be an effective implementation of the neuroguide method for clinical use, the resuits of
the analysis (both statistical tables and topographical brain maps) had to be in agreement
with the results of the analysis conducted on the host system used in the processing of
patient information at the Applied Neuroscience Laboratory. In addition, the outcome of
the discriminant analysis had to be consistent, not resulting in errors of misclassification
(that is, the classification on the NAS had to be consistent with that of the host system
used to perform the NeuroGuide analysis at the ANL). These tests confirmed that when
eyes-closed resting, and artifact-free EEG was selected for analysis, the results were
reproducible within an acceptable degree of variation consistent with reliability estimates
identified in the normative studies.

Subjects upon which this device has been tested included individuals which ranged in age

28
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from 2 months to 82 years, and who were either volunteers or clinical patients referred
for neuroguide evaluation to the Applied Neuroscience Laboratory by the Department of
Psychiatry University of Maryland School of Medicine, and/or Shock Trauma and the
Applied Neuroscience Institute at the University of Maryland Eastern Shore. The results
of the analysis were conveyed to the referring physician or Ph.D. clinician who was asked
to use the information as an adjunct to their clinical interpretation of the patient’s
traditional EEG. The information was provided in report form (including EEG epochs
selected for analysis, statistical tables and topographic brain maps, and the result of the
discriminant analysis) to permit the physician or Ph.D. clinician to determine its
relevance to their clinical evaluation and diagnosis or treatment of the patient. When the
results are used in this manner, the likelihood of introducing error into diagnosis and
treatment is substantially reduced. That is, the test is viewed as an adjunct to the
evaluation of the patient, and does not serve as a primary basis for the diagnosis.

Potential adverse effects of the use of the device are known if the NeuroGuide Analysis
System is used as a stand-alone diagnostic system (a use that is specifically
contraindicated by Applied Neuroscience, Inc. and the system’s developers) in the
absence of other clinical data from more traditional means of patient evaluation. Relying
only upon the use of a single index (such as relative power, or the topographical maps
alone) without reviewing the traditional EEG, the epochs selected for analysis, or the
complete set of statistical summary tables is also contraindicated and a source of potential
error. Additional sources of error could arise from the inappropriate selection of EEG
(selecting artifacted EEG epochs, or selecting EEG representative of other states, such as
drowsiness or eyes-open EEG when comparing to an eyes closed database, or by
purposely selecting conditions for testing other than those specified. Additionally, it 1s
possible that errors will occur through the purposeful falsification of symptoms in the
patient history, and patient age.

(b)(3) Conclusions Drawn From Non-Clinical and Clinical Testing: The appropriate
use of the NeuroGuide Analysis System as an adjunct to the traditional visually-appraised
EEG provides the user with the ability to quantify EEG variables and use them to answer
questions drawn from their clinical experience with the patient. When used by an
experienced, qualified practitioner, or under the proper supervision of a qualified medical
professional, the NAS is concluded to be a useful and beneficial addition to the array of
clinically accepted medical tests and devices used to evaluate brain structure and function.

The results of non-clinical and clinical resting conducted over the past 25 years
demonstrates that the NAS is both safe and effective for the quantitative analysis of the
eyes-closed resting EEG in the alert human subject and to be used to help determine if the
EEG is normal or abnormal, and if abnormal, to statistically characterize the distribution
of selected derived features by their probability of being similarly distributed in specified
groups of clinical patients, the NAS provides information that both complements and
supplements the outcome of the analysis of a traditional EEG. This information, when
properly used in conjunction with other clinical tests as a safe and effective adjunctive aid
to diagnosis, treatment planning, and treatment follow-up of the neurologic and
psychiatric patient.

29
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Compared to its predicate devices, the NeuroGuide Analysis System’s inclusion of
specific, appropriate, reliable and effective statistical controls over the method of data
selection and analysis, the scientific rigor involved in the construction, refinement, and
application of the normative and clinical databases, and the potential for providing
practitioner with sensitive and specific quantitative indices of brain structure and function
that is both safe and effective and suggests that the NAS is a significant advancement in
the use of quantitative technology in neurology, psychiatry, and clinical neuropsychology
and is an advancement over predicate EEG analysis systems in terms of speed and ease of
use.
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PREMARKET NOTIFICATION
TRUTHFUL AND ACCURATE STATEMENT
[As required by 21 CFR 807.87(k)]
I certify that, in my capacity as president of Applied Neuroscience, Inc., I believe to

the best of my knowledge, that all data and information submitted in the premarket
notification are truthful and accurate and that no material fact has been omitted.

[—(MW ﬂmuit/évp/

(Signature)
Robert W. Thatcher

(Typed Name)
May 10, 2004

(Dated)

(Premarket Notificatien [510(k)] Number)
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SCREENING CHECKLIST FOR ALL PREMARKET NOTIFICATION [510(k)] SUBM...

@ﬁs l"\ lood md I)zuw \dmmlstr*--

FDA Home Page l CDRH Home Page | Search| CDRH A-Z index | Contact CDRH

Page 1 of 4

SCREENING CHECKLIST FOR ALL
PREMARKET NOTIFICATION [510(k)]
SUBMISSIONS

510(k) Number:

: Seg Reofated

B intormation |

The cover letter clearly identifies the type of 510(k) submission as (Check the appropriate box):

[J Special 510(k) - Do Sections 1 and 2
[0 Abbreviated 510(k) - Do Sections 1, 3 and 4
[ Traditional 510(k) or no identification provided - Do Sections 1 and 4

Section 1: Required Elements for All Types of 510(k) submissions:

Presentor | Missing or
Adequate | Inadequate

over letter, containing the elements listed on page 3-2 of the
arket Notification [510)] Manual.

[Table of Contents.

Truthful and Accurate Statement.

ice’s Trade Name, Device’s Classification Name and
tablishment Registration Number.

evice Classification Regulation Number and Regulatory Status
Class 1, Class II, Class 1II or Unclassified).

Eroposed Labeling including the material listed on page 3-4 of
e Premarket Notification [510)] Manual.

tatement of Indications for Use that is on a separate page in the
remarket submission.

Substantial Equivalence Comparison, including comparisons of
e new device with the predicate in areas that are listed on page
3-4 of the Premarket Notification [510)] Manual.

510(k) Summary or 510(k) Statement.

scription of the device (or modification of the devxce) including
ia s, engineering drawings, photographs or service manuals.
| dentification of legally marketed predicate device. *

file://C:\My%20Documents\NEUROGUIDE\FDA\CHECK%20LIST htm
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SCREENING CHECKLIST FOR ALL PREMARKET NOTIFICATION [510(k)] SUBM. . Page 2 of 4

ILChompliance with performance standards. * [See Section 514 of

e Act and 21 CFR 807.87 (d).]

[Class Il Certification and Summary. **

Einancial Certification or Disclosure Statement for 510(k)
otifications with a clinical study. * [See 21 CFR 807.87 (i)]

510(k) Kit Certification ***

* - May not be applicable for Special 510(k)s.
*x - Required for Class III devices, only.

*** - Seepages 3-12 and 3-13 in the Premarket Notification [510)] Manual and the Convenience Kits
Interim Regulatory Guidance.

Section 2: Required Elements for a SPECIAL 510(k) submission:

Present |Inadequate or
Missing

Name and 510(k) number of the submitter’s own, unmodified
redicate device.
A description of the modified device and a comparison to the
sponsor’s predicate device.
A statement that the intended use(s) and indications of the
odified device, as described in its labeling are the same as the
intended uses and indications for the submitter’s unmodified
redicate device.
eviewer’s confirmation that the modification has not altered the
ndamental scientific technology of the submitter’s predicate
evice.
Design Control Activities Summary that includes the
ollowing elements (a-c):
a. Identification of Risk Analysis method(s) used to assess the
fmpact of the modification on the device and its components, and
the results of the analysis.
b. Based on the Risk Analysis, an identification of the required
verification and validation activities, including the methods or
ests used and the acceptance criteria to be applied.
c. A Declaration of Conformity with design controls that includes
{the following statements:
A statement that, as required by the risk analysis, all
verification and validation activities were performed
by the designated individual(s) and the results of the
activities demonstrated that the predetermined
acceptance criteria were met. This statement is
signed by the individual responsible for those
particular activities.
A statement that the manufacturing facility is in
conformance with the design control procedure

file://C \My%20Documents\NEUROGUIDE\FDA\CHECK %20LIST. htm 5/9/2004
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requirements as specified in 21 CFR 820.30 and the
records are available for review. This statement is
signed by the individual responsible for those
particular activities.

Section 3: Required Elements for an ABBREVIATED 510(k)* submission:

Present

Inadequate or
Missing

or a submission, which relies on a guidance document and/or
special control(s), a summary report that describes how the
lguidance and/or special control(s) was used to address the risks
Fssociated with the particular device type. (If a manufacturer

lects to use an alternate approach to address a particular risk,
sufficient detail should be provided to justify that approach.)

or a submission, which relies on a recognized standard, a
eclaration of conformity [For a listing of the required elements of]
declaration of conformity, SEE Required Elements for a
eclaration of Conformity to a Recognized Standard, which is
osted with the 510(k) boilers on the H drive.]

or a submission, which relies on a recognized standard without a
eclaration of conformity, a statement that the manufacturer

intends to conform to a recognized standard and that supporting
ata will be available before marketing the device.

or a submission, which relies on a non-recognized standard that

as been historically accepted by FDA, a statement that the

anufacturer intends to conform to a recognized standard and that
supporting data will be available before marketing the device.

[For a submission, which relies on a non-recognized standard that
has not been historically accepted by FDA, a statement that the
manufacturer intends to conform to a recognized standard and that
supporting data will be available before marketing the device and
any additional information requested by the reviewer in order to
determine substantial equivalence.

Any additional information, which is not covered by the guidance
document, special control, recognized standard and/or non-
ecognized standard, in order to determine substantial
Equivalence.

* - When completing the review of an abbreviated 510(k), please fill out an Abbreviated Standards
Data Form (located on the H drive) and list all the guidance documents, special controls, recognized

standards and/or non-recognized standards, which were noted by the sponsor.

Section 4: Additional Requirements for ABBREVIATED and TRADITIONAL 510(k) submissions

(If Applicable):

Present

Inadequate or
Missing

tile://C:\My%20Documents\NEUROGUIDE\FDA\CHECK %20LIST.htm
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t) Biocompatibility data for all patient-contacting materials, OR
ertification of identical material/formulation:

b) Sterilization and expiration dating information:

i} sterilization process

i1) validation method of sterilization process

iii) SAL

iv) packaging

v) _specify pyrogen free

vi) ETO residues

vii) radiation dose

viii) Traditional Method or Non-Traditional Method
k) Software Documentation:

Items with checks in the “Present or Adequate” column do not require e additional information from
the sponsor. Items with checks in the “ Missing or Inadegquate” column must be submitted before
substantive review of the document.

Passed Screening Yes No
Reviewer:
Concurrence by Review Branch:

Date:

The deficiencies identified above represent the issues that we believe need to be resolved before our
review of your 510(k) submission can be successfully compieted. In developing the deficiencies, we
carefully considered the statutory criteria as defined in Section 513(i) of the Federal Food, Drug, and
Cosmetic Act for determining substantial equivalence of your device. We also considered the burden
that may be incurred in your attempt to respond to the deficiencies. We believe that we have considered
the least burdensome approach to resolving these issues. If, however, you believe that information is
being requested that is not relevant to the regulatory decision or that there is a less burdensome way to
resolve the issues, you should follow the procedures outlined in the “A Suggested Approach to
Resolving Least Burdensome Issues” document. Itis available on our Center web page at:
http./fwww.fda gov/cdrh/modact/ieastburdensome html

Uploaded on March 3, 2004

CDRH Home Page | CDRH A-Z index | Contact CDRH | Accessibility } Disciaimer

FDA Home Page | Search FDA Site | FDA A-Z index | Contact FDA | MHS Home Page

Center for Devices and Radiological Health  CORH
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NEUROGUIDE

MANUAL AND TUTORIAL

Copyright © 2002 - 2004 Applied Neuroscience, Inc.
(EEG segments were selected for illustrative purposes only)

TABLE OF CONTENTS

INTENDED USE

INSTALLATION INSTRUCTIONS
KEY A and KEY B to ACTIVATE NEUROGUIDE

SUPPORT AND UPGRADES

Step #2 - Scale and re-montage the EEG and visually scan the EEG for artifact, epoch
length and the general status of the EEG.

Step #3 - Activate the Dynamic Normative FFT Databases and examine the raw EEG
and power spectrum to identify Z scores = 2.0.

Step #4 - Automatic Artifact procedure to select “Good” , “Reliable”, artifact free and

representative samples of EEG for quantitative analysis.

Step # 5 -~ Re-Montaging and Use of Average Reference and Laplacian Norms

Step #6 - Save and Print EEG Selections

Step #8 - Annotation Tool to Examine Peak-to-Peak EEG Amplitude
Step #9 - Digital Filters

Step # 10 — Selecting Report Content

mk:@MSITStore:C:\Program%20Files\R oboHelp%200ffice\RoboHTML\NEUROGUIDE\...  5/9/2004
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Step # 11 — Screen Capture, Saving, Printing & Bit Map Export

Step # 12 — import EEG in ASCIl Format and/or EDF Format

Step # 13 - Save FFT Power Spectral Analyses in Tab Delimited Format

Step # 14 — Launch LORETA - Frequency Domain

14b - LORETA Raw Values

14e - LORETA Normative Database

Step # 15 - LORETA Export in ASCIl Format for the Key Institute Programs

Step # 16 — Import to LORETA-Cross- Spectrum and LORETA Explorer

Appendix - A: Wamings - General
Appendix - B: Warnings about Lexicor EEG Exports

Appendix - C; Workshop EEG Examples

Appendix — D: ASCII Electrode Order and Spherical Coordinates for Use of the
NeuroGuide Qutput Files with the Key inst. LORETA Explorer

Appendix — E: University of Maryland Amplifier Characteristics
Appendix - F: LORETA Normative Reference Database Z scores

Appendix - G: Spectral Analysis Specifications

Appendix - H: References

Intended Use
For clinical purposes the NeuroGuide Analysis system is to be used by qualified
medical or clinical professionals for the post-hoc statistical evaluation of the
human electroencephalogram (EEG). For research and education NeuroGuide is
intended to be used by competent and ethical students and professionals for the
post-hoc statistical evaluation of the human electroencephalogram (EEG).

Installation Instructions

Copy all of the NeuroGuide program files to the same folder. To install
NeuroGuide double click the setup.exe file. If you have installed an earlier version
then uninstall will run first and one must double click setup.exe a second time
to initiate the installation. Click Start > All Programs > NeuroGuide to launch
NeuroGuide. We advise that one always use the defauit directory of c:/program
files for the installation directory. If you shift installation to a different directory

mk:@MSIT Store:C:\Program%20Files\R cboHelp%200ffice\RoboHTML\NEUROGUIDE\...  5/2/2004
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after receiving a Key B based on the initial directory then your initiai Key B will no
longer work. [f this happens, please contact us by phone or at
qeeg@appliedneuroscience.com.

Key A and Key B to Activate NeuroGuide

The first time that NeuroGuide is launched a copyright agreement appears. Click
yes to accept the terms of the agreement, otherwise the program will terminate.
The next window is a NeuroGuide Security Key window that contains a Key A.
Once you pay for NeuroGuide then a Key B will be issued that will uniock the full

power of NeuroGuide including the ability to import EEG files. The Key B uses the
computer ID numbers that are unique to the single computer and single user
license that you register your software. A second but renewable license will be
issued to individuals who have a laptop at work and/or a desktop computer at
home, etc. [tis important to note that a single user's license is all that is allowed
and separate licenses must be purchased if users other than the single user
intends to use the software (see copyright license agreement which is saved on
your computer when you launch NeuroGuide). Demo mode is activated by
clicking the CANCEL button. In the Demo mode the user is still bound by the
terms of the single user copyright agreement, however, users are limited to using
the exemplar files inside of NeuroGuide and demo users will not be able to import
their own data.

Support and Upgrades
Support is free for one year and you may contact us via phone or email at
qeeg@appliedneuroscience.com. We are constantly updating the program with
new features, bug fixes, and new EEG file formats. One year of free upgrades from
the date of first purchase is included with each purchase of NeuroGuide. In the
future we plan to implement a subscription service which begins at the end of one
year and provides service and upgrades beyond the one year period. Your Key B
will work with all upgrades of NeuroGuide until we implement the subscription
service and maintence . You will be invited to join the NeuroGuide users group at
yahoo.com where open discussion is encouraged and new upgrades are
announced. Once you purchase NeuroGuide please join this group and check for
the release of new updates of NeuroGuide.

Formats Supported
New file formats and features are constantly being added to NeuroGuide. See the
Universal file format hyperlink below and visit our web site at
www.appliedneuroscience.com for the most up-to-date list of supported formats.
To equate the amplifier characteristics of different EEG machines to the amplifier
characteristics of the normative reference database mivorvolt calibration sine
waves are input into the different EEG machines and equilibrated to the amplifier
characteristics of the normative amplifiers. The Universal physics metric of the
EEG is then the Volt defined as joules/icoulomb.

mk:@MSITStore: C:\Program%20Files\RoboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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unidentified 18 year old patient with a history of traumatic
brain injury. This EEG sample is only an example tutorial
selected to help users step through NeuroGuide's basic
software features and there is no diagnosis or clinical
interpretation. NeuroGuide is only an adjunct to other
clinical information (competent clinical experience is
required to use the electrophysiology of the brain for
clinical purposes).

Return to Top

1a- Click File > Open > Lexicor > Lexicor NRS24 from the Menu bar (Demo example)

-y

Universal file format such as ASCll and EDF and EEG Machine formats (Native Formats)
are available in the non-Demo mode

mk:@MSITStore:C:\Documents%20and%20Settings\Owner\Desktop\NeuroGuide_Deluxe.... 5/3/2004
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year old patient with a history of traumatic brain injury.

Return to Top

1a- Click File > Open > Lexicor > Lexicor NRS24 from the Menu bar (Demo example)

Universal file format such as ASCII and EDF and EEG Machine formats (Native Formats)
are available in the non-Demo mode

mk:@MSITStore:C:\Program%20Files\R oboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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Import Different EEG Formats by clicking File > Open

EEG Machine Formats tha
Supported by NeuroGuide

&

1b- Access to NeuroGuide age dependent norms requires specifying an age. This can
be done by simply typing an age in the Age row or by typing in the date of birth and the
date of EEG test. Also, type in full subject information including comments.

mk:@MSITStore:C:\Program%20Files\R oboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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1c- For demonstration purposes one can just type in a given age, e.g., 18 years
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Step #2 is to Scale and Visually Scan and re-montage the
EEG and to further visually scan the EEG for artifact,
epoch length and the general status of the EEG.

Return to Top

2a - Default Screen Contains Linked Ears Reference Digital EEG and 6/sec vertical grid
lines and Polarity = positive up. Click on View and change polarity or eliminate grids.

mk:@MSIT Store:C:\Program%20Files\RoboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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Scale the EEG tracings in uV/cm and view the length of EEG selections
in seconds and view dynamic Reliability measures of the EEG selections

Scale the chango polarity + up or -up
EEG uY/cm

2b - Manual Edit Selection - press left mouse button and drag to select, press right

mouse button and drag to erase. As a tutorial Select 15! four seconds of EEG by
pressing left mouse button and sliding it. To experiment De-select by pressing the right
mouse button and holding over the selected area. Highlight Edit and Select “Clear All”,

then re-select 15t 4 seconds.

mk:@MSIT Store:C:\Program%20Files\RoboHel p%200ffice\RobocHTML\NEUROGUIDE\... 5/2/2004
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Scale the EEG tracings in uV/em and view the length of EEG selections
' in seconds and view dynamic Reliability measures of the EEG selections

Scale the Change polarity + up or -up
EEG u¥/cm

Edit Time B ' ' A B SN

Reliability

Test Re-Te
Reliability

2c- Scan the EEG record by clicking the left mouse button and scanning across the
EEG. Move the wiper at the bottom and/or page & arrow keys and home and End Keys.

Press Home to move to the beginning and End to move to the end of the of the Digital
Record. Experiment using the arrow keys and the page keys and the home and end
keys and by dragging the left and right mouse buttons.

mk:@MSIT Store:C:\Program%?20Files\R oboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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2d- Split-Half reliability is the ratio of variance between the even and odd seconds of the
time series of selected digital EEG (variance = sum of the square of the deviation of
each time point from the mean of the time points). Examine the average reliability and
the reliability of each channel as you increase the length of the sample and manually
select different segments. Selection of artifact free EEG should have a reliability > 0.95
and a sample length of edited EEG > 60 seconds.

mk:@MSITStore:C:\Program%20Files\R oboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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Dynamic Reliability Measures of Edited Selections. Compare Split-Half
(even vs. odd 1 sec segments) to Test Re-Test {15t half vs. 2" half EEG varian

Split-Half
Reliabilities -

" Test Re-Test
Reliabilities

2e- Test re-test reliability is the ratio of variance between the first haif vs. the second
half of the selected EEG segments (variance = sum of the square of the deviation of
each time point from the mean of the time points). Test re-test reliability > 0.90 and a
sample length of edited EEG > 60 seconds is commonly published in the scientific
literature. Test re-test reliability is an excellent statistic to compare Brain state
changes such as drowsiness as well as the consistency of a measure independent of
changes in brain state.

Return to Top

Step # 3 - Activate the Dynamic Normative FFT Databases
and examine the raw EEG and normalized power spectrum
to identify Z scores = 2.0 and to compare the > 2 SD
deviant Z frequencies and EEG channels using the

mk:@MSITStore:C:\Program%20Files\RoboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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Average Reference and Laplacian norms and linked ears
norms.

Return to Top

3a- Click Edit > Dynamic FFT > Reference Database > Eyes Closed. Release the
mouse and repeat the sequence of clicking Edit > Dynamic FFT > Relative Power. This
will display the FFT absolute or relative power values in the upper right quadrant and
the Z scores in the lower right quadrant. First try relative power eyes closed, then eyes
open, then absolute power, etc. Clicks of the mouse allow for quickly repeating muiltiple
mouse clicks for 2 or 3 times for each option and watch the screen change.

Click Edit > Dynamic FFT to Select Eyes Closed or Eyes Open Normative Database
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3b - Click Edit > Dynamic FFT > Relative Power and Release Mouse. Average
Reliability for all channels is in the Reliability Window on the left margin of the edit
screen as well as reliability per channel. Scan through the reliability of different
channels. As defined in 2d Split-half reliability is the ratio of the variance of the even 1

mk:@MSITStore:C:\Program%20Files\RoboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004

120
FOI - Page 74 of 290



NeuroGuide Manual | Page 13 of 77

second samples of EEG digital samples divided by the odd 1 second segments of the
EEG edited selection. The split-half reliability value 0.86 is low because it represents
only 4 seconds of EEG.

Click Edit > Dynamic FFT > Relative Power

FFTOf

i ZScores
T OfEdit
Selections

As explained in Step 2e, Higher moment to moment variability is related to a decrease
in the split-half reliability and state change variability is more related to a decrease in
the test re-test reliability.

3b- Example of how to change normative databases to eyes open

mk:@MSIT Store:C:\Program%20Files\RoboHelp%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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3c- Click & move the left mouse button over the Z Score of Relative Power and read the

frequency and Z scores on the left of the EEG display. Note Frequency of 6.59 Hz & the
Red Z Scores at P3, 01, Pz & T3.

o

Step # 4 - Manual Edit select by left mouse button and de-select
by right mouse button. Use the Automatic Artifact procedure to

mk:@MSITStore:C:\Program%20Files\RoboHel p%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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select “Good” & “Reliable” artifact free and representative
samples of EEG as a template for quantitative analysis.

Return to Top

4a- For automatic template selections Click Edit > Automatic Selection. We will use the

15t 2 seconds of selected EEG as a template of “Good” EEG, this is only for illustration
and to note that the first 2 seconds is generally not a good period to select from. To
test the reliability and validity of your template selections use a different template by
clicking Edit > Clear All Selections and then select a different template using the left
mouse button and repeat Edit > Automatic Selection. De-select using the right mouse
button. A “good” EEG sample is split-half reliability = .95 and Edit Time = 60
seconds.

Click Edit >,Automalic Selection in order to use a Artifact Free Template to
- Select Additional EEG

4b- The Default multiplier is 1.0. Click O.K. and the FFT and Z scores of the edited
selections will be displayed. Cut Off Multiplier = 1.0 is a RMS amplitude match for each

2 seconds of EEG that are equal to or less than the RMS amplitude of the user selected
EEG template.

mk:@MSIT Store:C:\Program%20Files\RoboHel p%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004
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Automatic selections to
250 milliseconds

4c - Edit time is now 1 min. & 59 seconds and Reliability is improved. Visually Re-scan
the EEG to de-select segments that may have artifact and to select Good and
representative EEG segments that may have been omitted.
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O D

4d- To change the template selection of “Good” EEG, highlight “Clear Automatic
Selections” and then repeat the automatic selection process by clicking Edit >
Automatic Selections. To change the Cut-Off highlight “Clear Automatic Selections”
and repeat steps 4a and 4b.
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'P-to-P amplitude will now be
25% > the tempiate amplitude

Set minimum time between
Autoiatie selsits ®
250 milliseconds

The Cut Off Multiplier determines the amplitude of match to the “Good EEG”
template. When the cut off multiplier = 1.25 then the match will be 25% larger peak-to-
peak amplitude than the template amplitude, if it is 1.5 then the match will be 50% larger
amplitude than the template. The Cut Off Window is the delay between automatic
selections. A value of 0.25 = 250 millisecond minimum gap between automatic
selections and a value of 0.5 = 500 millisecond minimum gap between automatic
selections, etc.

4e- Click O.K. using the 1.25 Multiplier Cut-Off and see a larger sample of EEG of 2:22
minutes and Reliability Increased. Note that the EEG Spectrum and Z Scores did not
change much. Scroll through the EEG Selections as an Expert would and look for
Epileptic discharges and other possible abnormal features of the EEG that may have
been excluded. Change to 1.5, 1.75, etc. to test reliability and then click Edit. Save
your selections by clicking Edit > Save Edit File, e.g., Template-nonartifact 30 seconds
or Template-nonartifact 2min or Template-All EEG without any artifact rejection.
Compare these three artifact free files to the compare the Z scores and the Dynamic
FFT to different selections in order to understand the influence of your selections may
or may not have upon the Z scores and FFT . Finally, click Edit > Select All (the worse
case scenario in which artifact is not excluded). Conclusion: High Theta (5 Hz - 7 Hz)
and Low Beta (15 — 25 Hz) are pervasive and representative of the artifact free EEG.

mk:@MSITStore:C:\Program%:20Files\RoboHel p%200ffice\RoboHTML\NEUROGUIDE\... 5/2/2004

2
FOI - Page 80 of 290



NeuroGuide Manual Page 19 of 77

Press left mouse button and Drag
Over Z scores and frequencies

Press the left mouse button and scan the Z scores while observing the Z score values at
the left margin of the EEG tracings for the different frequencies of the spectrum

Step # 5 — Re-Montaging and Use of Linked Ears, Average
Reference and Laplacian Norms

Return to Top
5a- Double click on the Average Reference Montage or use the Tab & Arrow keys. The

corresponding Z scores will be displayed in the lower right Z Score window. Scan the Z
scores and compare to the Linked Ears montage.
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5b - Double click on the Laplacian Reference Montage or use the Tab & Arrow keys.
The corresponding Z scores will be displayed in the lower right Z Score window. Hold
the left mouse button and scan the Theta peak at 5 Hz to 6.5 Hz and make a written note
of the Red Z scores and frequencies in the left margin of the EEG tracings.

Note that the scale is in microamperes because the Laplacian is an estimate of the
current flowing at right angles through the skull (Nunez, 1981; 1994; Pasqual-Marqui et
al, 1988).
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Step # 5¢ — Linked Ears Reference Montage Revisited - Double click on LINKEARS
Montage & Re-Examine Theta and make notes as to which Locations show Red Z
scores (i.e., > 1.96 SD). With linked ears reference the significant Z scores are more
diffuse.

Double Click in the Montage Window to Change the Montage

Step # 6 - Save and Print EEG Selections

Return to Top

6a - Save the final edit selections that will be used in the QEEG analyses by
highlighting “Save. If you want to only print a specific page, save the edits, then clear
all selections and select the single page that you want to print.
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6b — Save in a Directory using the *.edt extension
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06010007 0003 0004
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6c — After importing a digital EEG file to open Edit Selections for that file Click Edit >
Open Edit File > NeuroGuide and navigate to the location where the edits were saved.
This only opens the Edit Selections for a Given EEG data file and an EEG file must be

imported first.
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6d — Print or Export the Edited EEG in ASCIl format by Highlighting “Print” or “Export”
in the File Menu.
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6e — Save the Edited EEG Selections in NeuroGuide Format (*.ng) or in Lexicor Format
(*.dat).
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Step # 7 — Create and Label Montages (1 to 19 channels,
Bipolar or Monopolar)

Return to Top

7a - Click Montage > Select Montage in the Montage Menu
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7b - Click a Montage in the Montage List to view the electrode order and references that
are present in the left column of the EEG View screen

7¢ - Click Montage > Create New Montage” in the Montage Menu
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7d - Click on Electrode Locations and a Reference (e.g., Linked Ears, then Name the
Montage then click Save and then click close.
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Click on a channel
mm:m

7e - If You Make a Mistake or Want to Remove an Electrode Selection, Double Click
on the Electrode and then Click Remove Channel. To Delete a Previously Created and
Saved Montage, Click on the Montage and then Click Delete Montage. Click Close to
Return to the EEG Display or Create and Save A New Montage.

7f — Example of a Two Channel Display with Dynamic FFTs Designed
To Evaluate T5 and T6 Theta Activity. First create a T5-linked ears and a T6 linked ears
Montage then click Close
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Chck T5 then LE, click T6 then LE

7g- Display the T5 and T6 Linked Ears Montage in the NeuroGuide Viewer
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8 — Use Annotate Tool to Examine peak-to-peak features of
the EEG

Return to Top
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8a — Press the left mouse button and drag over the EEG segments of interest and read
the instantaneous microvolt values (uV) or microampers (uA) in the CSD montage. To
Erase the annotations, press the right mouse button and drag over the annotations to
be erased.
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‘Change Scale = 40 uV

‘Change Display Time = 2 seconds

Page 33 of 77

Hold mmmmmm: Screen. To Erase

Step # 9 — Digital Filter Viewer is a lIR ButterWorth Filter
that only changes the appearance of the EEG tracings and

does not have any impact on the FFT or normative

database comparisons. This is a valuable visual tool to

examine the time and frequency details of the EEG
tracings themselves.

etu

9a - Click View > Filters
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mmmm

‘Change the Filter

Step # 10 — Selecting Report Content

Return to Top

10a - Highlight “Report” in the Analysis Menu, then drag the mouse to FFT Color Maps
> Frequency Resolution > 1 Hz Resolution to see the Default Selections. Uncheck and
check those FFT Color Maps that you want in your Report.
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10b - Highlight “Report” in the Analysis Menu. Uncheck and check those Analysis
Results that you want in your Report.

10c - Highlight “Report” in the Analysis Menu, then drag the mouse to Discriminant
Functions> Leaming Disabilities & Head Injury to see the Default Selections. Uncheck
and check the Discriminant Functions that you want in your Report (Not a Diagnostic).
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10d - Click: Report > Preferences to Select the range of Z scores and colors ranges in
the Topographic Z score maps.

T -~ t Color T S— n—
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10e - In the preferences window select the Z score range and color contrasts, then
close the Report Preferences window.

Select Topographic Color Scales and Contrasts
for Different Z Score Ranges

Adjust Z Score * Sid. Deviations

Select Range of Nomnal £ Std.

Select Non-Linear G Contrast

10f - After making your Selections (Final Items Checked and Unchecked) Highlight
Generate Report and Then Release the Mouse. Repeat 8a-8d with Different Montages
and Conditions (Laplacian & Average Reference)
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Step # 11 — Printing & Bit Map Export

Return to Top
11a- First Page of Report is the Subject Information Page (see Step 1b)

Mostags. LNVEARS '  EEGES Demwl
Subject information
Paigar N Sy TR
Do of Bty R85
At Ly
EEGIn Dasmit
D o Tost 1ARGHE
Tagheisian Wt Compsant
Diesctor D Corrpetit

11b - Example Page of Z Score Color Maps of Relative Power Frequency Bands
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11c - Example Page of Z Score Color Maps of Ratios of Relative Power

§ Mtuge SAMTREE ' ) ‘ ' BESG Beat
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11d - Example Page of the 1 Hz Z Relative Power Z Score Maps

EEG I Dwrmot |

11f — Example Page of Cross-Spectral Z Scores
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Page 40 of 77
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11g- Save the Results of the Color Maps in Bit Map Format or the numerical values in
e
ASCII Tab Delimited Format to be Export to Excel or Database Management or Statistics
Programs.

BelaX 150,175 k) Bt 34160 25 Dy

1

11h - Create a Folder, then open the folder and name the bitmap files before saving
them in the folder. Later navigate to the Folder to Import directly into Word, or Power
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Point or Print Shop Pro, etc.

11j — Use Screen Capture Tool to Copy a Bit Map to the ClipBoard. Highlight “View”
menu and check “Copy Bitmap to Clipboard”. When done with the screen capture tool,
then highlight “View” and check “Edit” or “Annotate” to use the mouse for other

functions. Click View > Annotate

11j — Depress the left mouse button and drag the mouse over the EEG tracings and view
the “Blue” vertical line and microvolt values of the digital EEG. To erase the annotation
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values, depress the right mouse button and drag over the annotation selections. Click
View > Edit in order to restore the edit functions.

11k - Select screen region to copy, then depress the left mouse button and drag the
mouse over the screen image that you want to copy to the clipboard.

111 - If a mistake is made click the left mouse button and the dashed rectangle will
. disappear. Start over again and click and drag the mouse over another screen region.
To copy the selection to the clipboard, click the right mouse button and select “copy”.
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A second method is to highlight “Edit” and then select “Copy” at the bottom of the
menu.

Step # 12 — Import EEG in ASCIl Format and EDF

Return to Top
12a - Highlight “File > Open>Text file” in order to select an ASCIl formatted EEG file.
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12b - Navigate to the ASCII file and open the file. The ASCIl import window below
appears. Open the ASCII file in Word or Excel and examine the file and determine the
channel order and delimiters and whether or not there is a header in the file. One must
know the Montage or order of the channels, the sample rate and the delimiters.
NeuroGuide will search the file and help determine the delimiters or headers. If none is
found then the default window below is opened. If a different channel order is used,
then select “Montage” and “Create New Montage”. After creating a Montage to match
the channel order, name the montage, save and close. Re-open the ASCIl import
window and select this new montage. A Default DeyMed Montage is available to import
DeyMed ASCll-real EEG using the (A1+A2)/2 or linked ears reference.
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12c - Import EDF formatted files by Selecting File>Open/EDF. NeuroGuide
assumes that all channels were digitized at the same rate. User’s must
know the Montage or channel order, create a new montage to match the
channel order of the EDF file that you are importing.
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Step # 13 - Save Power Spectral Analyses in Tab Delimited
Format

Return to Top

13a - Click Analysis > FFT Power Spectra and then Absolute Power, Relative Power or
Z Scores
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‘Click Analysis > FFT Power Spectra to Save 0.5 Hz Resolution FFT Results in
Tab Delimited Format

13b - Navigate to a Folder and Name the File

NavigahtoFoldormdNuuﬂnFFTFla. Default extension is *.tdt
TommthﬁDm

‘Yes means that the
Twmofhmﬂﬂ
Be the channel labels
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Step # 14 — Launch LORETA - Frequency Domain Raw
Cross-Spectral Values and/or Normative Database Z
Scores (z scores are not in the Demo they are an add on

product).

Return to Top

14a - Download the free Key Institute LORETA programs at

waw.unizh.chlkevinstINewLORETAISoftwareISoftware.htm)

and then request a copy of the Key Institute password. Once the Key
Institute software is installed on the users computer then the LORETA
viewer program can be launched directly from the NeuroGuide edit window.

14b - Select artifact free EEG samples then Click Analysis > LORETA >
Lauch LORETA Viewer > Raw Values
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Click - Analysis > LORETA > Launch LORETA Viewer > Raw Values to Export
Cross-Spectral Raw Values and Launch the Key Institute LORETA Viewer Program

14c - Simultaneous NeuroGuide and LORETA Viewer
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Example of Simultaneous LORETA Viewer and NeuroGuide. Clic
Back and Forth between NeuroGuide and the LORETA Viewer

Step 14d - Time Frames are Frequencies from 1 to 30 Hz in 1 Hz
increments.
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Click Plz
Automat
Advance
1to30F

W A, B N RLER B SRR RS RO

Time Frame is Frequency from 1 to 30 Hz

The cross-spectral values are computed according to the equations
provided by the Key Institute for frequency domain analysis (i.e., Hermitian
matrix multiplication without the 2pi scaling and any unspecified scaling)
and the spatial localization can be independently verified by exporting the
same EEG selections in the time domain (see step # 15). See Step # 16
for further details and options involved in the use of the Key Institute
LORETA software. The automatic launching of the LORETA viewer
involves the use of the electrode coordinates and T- Matrix described in
Step 16b, thus saving the user of NeuroGuide the trouble of using the time
domain to cross-spectral steps described in steps 15 and 16. See the Key
Institute documentation to learn how the *.crs file and the *.lorb are
computed and then passed to the LORETA viewer by NeuroGuide.

14e - Select artifact free EEG samples then Click Analysis > LORETA >
Lauch LORETA Viewer > Z Scores (z scores are not available in the Demo
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mode). This procedure exports normative database Z scores which is an
add on feature of NeuroGuide. See Appendix F for details.

Click - Analysis > LORETA > Launch LORETA Viewer > Z Scores to Export
Normative Database Z Scores and Launch the Key Institute LORETA Viewer Prograr

14f - Click ScaleWin and then click Time Frame > to advance from 1 to 30
Hz and view the default maximum Z Scores. Note that the Z scores of the
maximum and minimum blue and red pixels in the MRI sequence may or
may not be statistically significant (i.e., Z > 2 standard deviations). That is,
the default ScaleWin only displays the "maximum" and "minimum" Z
scores which may or may not be Z > 2 standard deviations. Click "Play" to
automatically step through the entire spectrum of Z scores and note the Z
score maxima and minima. Click the NeuroGuide edit window and identify
the frequencies at which the maximum deviations from normal occur on
the scalp surface and then type these frequencies into the Explorer Viewer
time frame and examine the LORETA solution.
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Ciick — ScaleWin and Adjust the Color Scale and Viewer Settings

S Emeeetis woRs W
e Famgaral Uyres
o Vopey al Leadve

i [

P e Aot ORI O A EDRIERIRERD E

EEG Z Scoves

Change Senn/ Adjust Color DO Not Check “Fit Maximum™ to
_la-z,' Extremes For the Maximum Z Score Value

14g - Click - ScaleWin in the Viewer and then check "Fit Maximum" and
move "Change Max" wiper to adjust Z score thresholds and move “"Change
Linearity” wiper to adjust color extremes. Z scores are only valid if they
correspond to the surface EEG measures in the NeuroGuide edit window.
Click the NeuroGuide EEG tracing and dynamic FFT window and
determine the frequencies of maximum deviance from normal and then
click the LORETA Viewer and change frequency and Z score settings
accordingly. Details of normative database creation and validation using
the Key Institute software and NeuroGuide computation of the Key Institute
equations are provided in Appendix F.
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Return to Top

14h - In the LORETA Viewer Click "3DSurf" to Open the 3-Dimensional
Rendered Brain. Click "Orthoview" to Produce a Full View of the Rendered

Brain and the Location of Z Scores. Click "Left" or "Right" to View the
Hemispheres.
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Return to Top

Step # 15 — LORETA Export of EEG Time Series in ASCII
Format— Easy Steps

eturn to To

NEUROGUIDE TIME SERIES EXPORT

1- After editing the 19 channels of digital EEG, in the NeuroGuide menu bar select
“Analysis > LORETA Export” and click on “Overlapping Windows” and the “Save
Export Files” window will appear.

2- In the “Save Export Files” window Click on the create folder button and name the
folder “Overlap-LE”
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13- Double click on the new folder (i.e., Overlap-LE}), name the files LE and then click
Save.

LORETA ~ Key CROSS-SPECTRUM

1- Download the FREE Key Institute LORETA software

(www.unizh.ch/keyinst/NewL ORETA/Software/Software.htm) and then launch it and
double click on “EEG cross-spectrum” (users must first obtain a password to use the
FREE Key Inst. Software).

2- From the FREE Key Inst. EEG cross-spectral maker menu select "A1EEGs -> 1Spec
(aut)” and navigate to where you saved the “LORETA Export” files from NeuroGuide
(i.e., step #2). Click “Add this folder” and click “add all sub-folders”.

3- Type: Number of electrodes = 19, Number of time frames = 256, sample rate = 128,
select “normalize each EEG file, select the top frequency option, click “GO™.

LORETA — Key 3-D IMAGES

1- Re-Activate the main LORETA window and double click “LORETA Explorer for cross-
spectra” then in the menu bar select “File > Open EEG-crs” and select the crs file
created in steps # 5 & 6, “Open Electrode Coords” and select “Lex-
TalairachCoord.xyz”, highlight File>Open TransfMatrix and select the file
“LexTMatrix.tm file. These two files were created using the Key Institute “Electrode
Coordinates Maker” and the Lexicor electrode order for the international 10/20 system
of electrodes. Download the coordinate and transfer matrix files as
www.appliedneuroscience and click the demo webpage to download.

2- Now click on the part of the spectrum that you are interested in and create the 3-D
displays that you are interested in. Try “3Dsurf” and “ScaleWin” and please read the
LORETA-Key manual pages 34 and 35.

15a — Details of Export of ASCIl EEG as a Time Series

After making your edit selections in the NeuroGuide edit window, highlight
“Analysis” in the menu bar and select “LORETA Export”. There are two options:
“Overlapping Windows” or “Successive Windows”. For purposes of this demo, select
“Overlapping Windows” by highlighting with the left mouse button. Then click on
“QOverlapping Windows”,
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15b - Save Key Inst. Formatted Files in a Folder

Click on the create folder button and name the folder Overlap-LE (e.g., for Cross-
Spectral Linked Ears montage). Open the folder & type the file name LE.txt and click
save. This will save the successive ASCI! files in the Key Inst. Iinstitute format for the
“A1EEGs -> 1Spec(aut)” option.

[C\EEG_CLNCAL REPORTS BXCELXP 2 0ATADEND =1

YRS T cRoss-SPECAE_35 b
EATESTIS0-C0 {F] pemoascz
TTESTISOLE 7 LOR-AY-DEMO |
L4 TEST-150

e

Swembpe [Teeroal

Selection of the “Overlapping Windows” option minimizes the FFT windowing
effects by overlapping 256 point x 19 channel EEG segments by 75% in ASCII format
(see Kaiser & Sterman, J. of Neurotherapy, 4(3): 85-92, 2001). This is a standard
procedure in NeuroGuide, including the method by which the normative EEG data was
analyzed. The “Successive Windows” method saves successive 256 point data without
overlapping which is not optimal as discussed by Kaiser & Sterman, 2001). The user is
encouraged to compare and contrast the “Successive Windows” vs the “Overlapping”
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methods in order to see the effects of the cosine taper windowing of a 256 point
FFT.

16 — Import of ASCIl EEG Time Series to LORETA - EEG
Cross-Spectra

Return to Top

First download the “Lex-Talairachcoord xyz” and the “Lex-TaIairachTMatrix tm”
convenient location. The user must download the free Key Institute LORETA Internet
software by going to
http://www.unizh.ch/keyinst/NewLORETA/Software/Software.htm). Once the Key Inst.
Software is installed, launch the LORETA program and double click on “EEG Cross-

Spectra”

- B Ebe:t!rmz etwdf@m ﬂ'uiu%i‘ m Tﬁwsc:h «'&‘ﬁ.&.i\
1 Blectrodes viewsr : :
B Transformaton mati ‘L@ET& mw* i
: ;t*ﬁE’M Evziwwm FHSJ’EW '
B EsGEw s IORETA e
EEGRERP - SLORETAeyz.
B LORETA amwer e
1 EEGHGSS‘-‘SDEMU&. e .
B LORETA Explorer for Kﬁf"xwﬁ: “apactra
B EEG orossspedyum - > LORETA :
B & Swmstcd nrrv%s&ma“"r Mamm xmz
B = Lwites
' Averager t’ﬁ!ﬁ-‘ifﬁF"& fm}
- Baselne removd EE?F&&SNWETM i
- Fiverrg andior deletng dlectrodes from s“am fm
'mﬁﬁr&m‘m }mha :
. LW& frmme i ="Te**r Lol E‘ﬂm e

16a - Activate the EEG Cross-spectral maker > AIEEGs ->1Spec(aut)

As described on page 34 of the Key Inst. Documentation the A1EEGs -> 1Spec
(aut) option computes 1 single cross-spectral file for each and every 256 point
NeuroGuide time series file that the user previously saved as described in section 11a.
The window below will appear:
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Navigate to the location where you created the folder “Overlap-LE” described in 11a and
then click “Add this folder ->” and “add all sub-folders ->”. Type 19 as the number of
electrodes, type 256 as the number of time frames/EEG file, type 128 as the sampling
rate (Hz), click Normalize each EEG file (deselect “Force Average Reference” users are
encouraged to repeat these steps using “Force Average” to compare and experiment),
click the Discrete frequency selection and set the lower end = 1 Hz and the Upper end =
30 Hz then click “Go”. A cross-spectral file with a *.crs extension will be saved with the
same folder name of “Overlap-LE” that you created in section 11a.

16b - LORETA Explorer for EEG Cross-Spectrum

Double click “LORETA Explorer for Cross-Spectrum” in the main LORETA Key
Institute window. Highlight File > Open EEG - crs and navigate to the folder where the
*.crs file was saved in section 15b and select the cross-spectral file that you created.
Highlight File > Open Electrode Coords and navigate to select the electrode coordinate
file for Lexicor. NeuroGuide uses the “Lex-Talairachcoord.xyz” file which was
produced by the Key Inst. Talairach Electrode Coordinate Maker and is compatible with
the Lexicor order of electrodes using the LORETA Export menu. Repeat this step and
highlight File>Open TransfMatrix and select the file “and the “Lex-TalairachTMatrix.tm”
which was also produced by the Key Inst. Software using the Lexicor electrode order.
The following window will appear:
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16c - Create 3-D Maps
To create 3-D LORETA maps use your left mouse button to select one of the

eight frequency bands and then click “View1”. 3-D LORETA source localization will
appear at the top of the screen.
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Click “3Dsurf” at the top of the LORETA Explorer menu to activate the cortical surface
images. Click “Orthoview” to produce the 9 different views below:

16d — In LORETA Explorer Place the Color Scale Window Below the 3-

Dimensional Images. Set the “Change Linearity” Wiper to the far right and then move

the “Change Max” Wiper to the right and left. Observe how the absolute power values
spatially extend from the Midline Visual Cortex or the Midline Occipital Cortex (near to
Visual Area 17) and then spreads to Visual Area 18 as the “Change Max” Wiper.
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16e - Save the LORETA Images in jpeg format. Click File and
then Save As.

16f — Examine All of the LORETA Slices. Click “AliSlicesWin” in
the LORETA Explorer Menu.
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16g — Save the All Slices LORETA images in jpeg format by
Clicking “Save”.

16h — Repeat Step 15a to 16g by importing a different NeuroGuide Output file
into the LORETA Explorer by clicking on the “Open EEG/ERP” menu. Repeat Steps 16b
- 16g with a different NeuroGuide ASCII time series output, for example, an Eyes Open
condition from the same subject and explore the fine details of the 3-Dimensional
Sources of the EEG. Enjoy exploring relationships between frequency and 3-D space
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Appendix - A:
Warning about Digital and Statistical Analyses
of the EEG

Return to Top

Warning: NeuroGuide does not diagnose and only provides displays of the digital EEG
and statistical analyses of selected EEG segments. NeuroGuide requires competent
human intervention for it's many mathematical tools and NeuroGuide is only considered
as an adjunct and/or as a supplement to other measures that may aid in evaluating the
status of the EEG by a competent person. Clinical use of NeuroGuide requires a
competent medical or clinical professional. NeuroGuide is a standalone software
package that uses "look up" table functions to create Z scores which are a reference
based on published scientific selection criteria of samples of EEG (Thatcher et al 1987;
1986; 1989; 2003) and the use of these tables is at the discretion of the competent
professional. It is advised that reliability measurers and validity tests using different
montages and different selections of EEG be conducted as a routine procedure when
using NeuroGuide. NeuroGuide was designed to allow for mouse click selections and
testings of hypotheses and reliability and validity using digital analyses of the EEG.

Contra indications: EEG artifact can invalidate analyses and improper positioning of
electrodes or significant deviations from accepted standards of
electroencephalographic recording methodology can invalidate EEG recordings or
erroneous storage of data and falsification of data, improper manipulation of data or
unlawful uses of NeuroGuide including violations of copyright law and other improper
uses of NeuroGuide are all contra indicated.

Appendix - B:
Return to Top

Computation of the auto-spectral and cross-spectral densities, Coherence,
Phase Delays and Amplitude Asymmetry of the edited EEG selections

Use the Signal Generator to Calibrate the Digital Sighal Processing

1- import of digital EEG data involves the following steps: 1- Down-sample or up-
sample to 128 Hz, 2- Baseline the EEG by filtering at < 1 Hz and > 40 Hz (5th order
Butterworth filters and creating values from zero time to negative time to allow the filter
to start at time point = 0); 3- After each edit selection baseline the spliced selections of
EEG by filtering a second time at < 1 Hz and > 40 Hz.

2- Amplifier equilibration is computed as the difference between the normative database
amplifier characteristics in microvolts based on the frequency response of a calibrated
sine wave from 1 to 40 Hz. The equilibration ratio for each EEG machine manufacturer
is a coefficient in all of the subsequent spectral computations in the list of EEG
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machines in the File > Open window. The FFT (Fast Fourier Transform) parameters are:
epoch = 2 seconds at a sample rate of 128 sample/sec = 256 digital time points and a
frequency range from 0.5 to 40 Hz at a resolution of 0.5 Hz using a cosine taper window.
Each 2 second FFT is 81 rows (frequencies 0 to 40 Hz) X 19 columns (electrode
jocations) = 1,539 element cross-spectral matrix for each subject. NeuroGuide uses the
same equations as used by the Key Institute and Bendat and Piersol, 1980; Otnes and
Enochson, 1978 which are standard equations. The N in the Key Institute cross-
spectrum equations 16 and 17 is the number of 2 second windows that are used in the
computation of the average FFT which is the number of 2 second windows/N over all
EEG selections. The last whole integral of 256 points marks the end of window
summation and averaging. The N sub T (Key Inst. equation 17) is the number of time
frames per FFT window = 256 at 128 samples per second.

1. in order to minimize the effects of windowing in the FFT (Kaiser and Sterman, J.
Neurotherapy, 4(3): 85-92, 2001) a EEG sliding average of the 256 point FFT cross-
spectral matrix was computed for each normal subject’s edited EEG by advancing in 64
point steps (75% overlap) and recomputing the FFT and continuing with the 64 point
sliding window of 256 point FFT cross-spectrum for the entire edited EEG record. Each
of the 81 frequencies for each 19 channeis is log10 transformed to better approximate a
normal distribution. The total number of 2 second windows is the number that is
entered into the analysis of variance and t-tests and it is used to compute the degrees
of freedom for a given statistical test.

4- A mean, variance, standard deviation, sum of squares, and squared sum of the real
(cosine) and imaginary (sine) coefficients of the cross-spectral matrix is computed
across the sliding average of edited EEG for all 19 leads for the total number of 81 and
1,539 log transformed elements for each subject. This creates the following seven basic
spectral measurement sets and their derivatives 1- Cross-Spectral Power (square root
of the sums of squares of the real and imaginary coefficients); 2- Auto-Spectral Power
which is the diagonal of the cross-spectral matrix where the imaginary coefficient =0
and power = sine square; 3- Amplitude asymmetry of auto-spectral power = (A-B)/(A+B)
x 200 where A = EEG channel 1 and B = EEG channel 2; 4-Coherence = square of the
cross-spectrum divided by the product of the two auto-spectra; 5- Phase = arctangent of
the ratio of the real/imaginary components for frequencies from 0.5 to 40 Hz,; 6- Real
coefficients; 7 — imaginary coefficients (Bendat and Piersol "Engineering applications of
correlation and spectral analysis”, John Wiley & Sons, NY, 1980; Otnes and Enochson
"Digital time series analysis”, Wiley-interscience, 1978; Press et al, "Numerical recipes

in C".
Appendix - C:
Warning about Exporting Edited Digital EEG in Lexicor
Format

Return to Top
Warning: NeuroGuide uses a splicing method of appending edited selections of EEG

(minimum segment length = 600 msec.) and then baselines using a Butterworth high
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and brain anatomy using NeuroGuide's Exports to LORETA.

LORETA is a special and excellent program and the user needs to read the
LORETA Explorer manual that is provided with the program from the Key Institute
before using it.

A number of different tools are available after you launch the Key institute
LORETA programs. Validation of LORETA is necessary before one can trust the
solutions that are provided. Try validating by comparing Eyes Open vs Eyes Closed
changes in amplitude of the alpha rhythms. It is expected that if the visually observed
alpha is maximal in O1 and O2, then it should also be maximal in LORETA in the
posterior cortical regions and not in the midline Pz lead or in anterior cortical regions,
etc. Users must be cautious to validate LORETA to the extent that LORETA is
consistent with physiological information and the re-montaged digital EEG.

All comments and feedback are welcome.

Contact us at geeg@appliedneuroscience.com and tell us what you think.

Appendix - A:
Warning about Digital and Statistical Analyses
of the EEG

Return to Top

Waming: NeuroGuide does not diagnose and only provides displays of the digital EEG
and statistical analyses of selected EEG segments. NeuroGuide requires competent
human intervention for it's many mathematical tools and NeuroGuide is only considered
as an adjunct and/or as a supplement to other measures that may aid in evaluating the
status of the EEG by a competent person. Clinical use of NeuroGuide requires a
competent medical or clinical professional. NeuroGuide is a standalone software
package that uses "look up” table functions to create Z scores which are a reference
based on published scientific selection criteria of samples of EEG (Thatcher et al 1987;
1986; 1989; 2003) and the use of these tables is at the discretion of the competent
professional. It is advised that reliability measurers and validity tests using different
montages and different selections of EEG be conducted as a routine procedure when
using NeuroGuide. NeuroGuide was designed to allow for mouse click selections and
testings of hypotheses and reliability and validity using digital analyses of the EEG.

Contra indications: EEG artifact can invalidate analyses and improper positioning of
electrodes or significant deviations from accepted standards of
electroencephalographic recording methodology can invalidate EEG recordings or
erroneous storage of data and falsification of data, improper manipulation of data or
unlawful uses of NeuroGuide including violations of copyright law and other improper
uses of NeuroGuide are alt contra indicated.
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Appendix - B:
Return to Top

Computation of the auto-spectral and cross-spectral densities, Coherence,
Phase Delays and Amplitude Asymmetry of the edited EEG selections

Use the Signal Generator to Calibrate the Digital Signal Processing

1- Import of digital EEG data involves the following steps: 1- Down-sample or up-
sample to 128 Hz, 2- Baseline the EEG by filtering at < 1 Hz and > 40 Hz (5th order
Butterworth filters and creating values from zero time to negative time to allow the filter
to start at time point = 0); 3- After each edit selection baseline the spliced selections of
EEG by filtering a second time at < 1 Hz and > 40 Hz.

2- Amplifier equilibration is computed as the difference between the normative database
amplifier characteristics in microvolts based on the frequency response of a calibrated
sine wave from 1 to 40 Hz. The equilibration ratio for each EEG machine manufacturer
is a coefficient in all of the subsequent spectral computations in the list of EEG
machines in the File > Open window. The FFT (Fast Fourier Transform) parameters are:
epoch = 2 seconds at a sample rate of 128 sample/sec = 256 digital time points and a
frequency range from 0.5 to 40 Hz at a resolution of 0.5 Hz using a cosine taper window.

Each 2 second FFT is 81 rows {frequencies 0 to 40 Hz) X 19 columns (electrode
locations) = 1,539 element cross-spectral matrix for each subject. NeuroGuide uses the
same equations as used by the Key Institute and Bendat and Piersol, 1980; Otnes and
Enochson, 1978 which are standard equations. The N in the Key Institute cross-
spectrum equations 16 and 17 is the number of 2 second windows that are used in the
computation of the average FFT which is the number of 2 second windows/N over all
EEG selections. The last whole integral of 256 points marks the end of window
summation and averaging. The N sub T (Key Inst. equation 17) is the number of time
frames per FFT window = 256 at 128 samples per second.

3- In order to minimize the effects of windowing in the FFT (Kaiser and Sterman, J.
Neurotherapy, 4(3): 85-92, 2001) a EEG sliding average of the 256 point FFT cross-
spectral matrix was computed for each normal subject's edited EEG by advancing in 64
point steps (75% overlap) and recomputing the FFT and continuing with the 64 point
sliding window of 256 point FFT cross-spectrum for the entire edited EEG record. Each
of the 81 frequencies for each 19 channels is log10 transformed to better approximate a
normal distribution. The total number of 2 second windows is the number that is
entered into the analysis of variance and t-tests and it is used to compute the degrees
of freedom for a given statistical test.

4- A mean, variance, standard deviation, sum of squares, and squared sum of the real
(cosine) and imaginary (sine) coefficients of the cross-spectral matrix is computed
across the sliding average of edited EEG for all 19 leads for the total number of 81 and
1,539 log transformed elements for each subject. This creates the following seven basic
spectral measurement sets and their derivatives 1- Cross-Spectral Power (square root
of the sums of squares of the real and imaginary coefficients); 2- Auto-Spectral Power
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which is the diagonal of the cross-spectral matrix where the imaginary coefficient =0
and power = sine square; 3- Amplitude asymmetry of auto-spectral power = (A-B)(A+B)
x 200 where A = EEG channel 1 and B = EEG channel 2; 4-Coherence = square of the
cross-spectrum divided by the product of the two auto-spectra; 5- Phase = arctangent of
the ratio of the realfimaginary components for frequencies from 0.5 to 40 Hz,; 6- Real
coefficients; 7 — Imaginary coefficients (Bendat and Piersol "Engineering applications of
correlation and spectral analysis”, John Wiley & Sons, NY, 1980; Otnes and Enochson
"Digital time series analysis”, Wiley-Interscience, 1978; Press et al, "Numerical recipes

inC".
Appendix - C:
Warning about Exporting Edited Digital EEG in Lexicor
Format

Return to Top

Waming: NeuroGuide uses a splicing method of appending edited selections of EEG
(minimum segment length = 600 msec.) and then baselines using a Butterworth high
pass filter at 1 Hz and a low pass filter at 40Hz so as to minimize splicing artifact. When
NeuroGuide exports the edited selections in Lexcior format there is an approximation to
baseline adjustment and possible splice artifact may occur when the edited data are
imported into other software platforms. Another waming about cross-platform
comparisons are possible differences in FFT epoch lengths (NeuroGuide uses 2 second
epoch lengths), windowing methods (NeuroGuide uses cosine taper windowing),
successive vs. overlapping epochs (NeuroGuide uses 75% sliding epoch overlapping
while other platforms do not use overlapping epochs, see Appendix B), etc. Within
platform analyses using calibration sine waves are recommended and cross-platform
comparisons are not recommended uniess the same analytical procedures are used.

Appendix - D:
Default LORETA Electrode Coordinates and T Matrix

Return to Top

ASCII Electrode Order and Spherical Coordinates for Use of the NeuroGuide
Output Files with the Key Inst. LORETA Explorer. [f the “Lex-TalairachCoord.xyz" file is
not available then create this file by copying the values in the Table below and save as
an ASCIi file (tab delimited, free space or comma delimited). You will need this file in
order to use the NeuroGuide output files with the LORETA Explorer. The user of
course can always create their own electrode coordinate files and ‘T’ matrices by using
the Key Institute’s “Talairach Electrode Coordinate Maker 01
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A
15.0000000

-32.8106500

32 8106500

-50 9022100

50.9022100

-51 1154100

61.1154100

-51 4187000

51 4187000

-31 6591500

31.6591500

-70.6373800

70 6373800

-82.4581900

82 4581900

.73 4313200

73.4313200
0.0000000
0.0000000
0.0000000

B C D

810014200 -3.6996630 Fp!
810014200 -3.6996630 Fp2
48.1851900 50.4379300 F3
48 1851900 50.4379300 F4
-13.0630900 69.4728100 C3
-13.0630900 69.4728100 C4
.77 4712400 63.7236800 P3
77 4712400 637236800 P4
-116 3994000 163618900 O1
-116.3994000 16.3618900 02
315961900 1.3213170 F7
31 5961900 1.3213170 F8
.19 4618900 65102720 T7/T3
194618900 65102720 TB/T4
.72 5394700 119044600 P7/T5
725394700 11.9044600 PB/TH
56 9681500 71.0918800 Fz
1103126900 96.5361000 Cz
801928200 83.6937200 Pz

Appendix - E:

University of Maryland Amplifier Characteristics

Return to Top

Normative reference EEG was acquired using 20 identical amplifiers mounted in
a rack at the Baltimore campus and another rack of 20 identical amplifiers at the Eastern
Shore campus. Each of the amplifiers and A/D systems were calibrated before and after
each subject’'s EEG and evoked potential acquisition.

1-  Gain = 10* viv switchable to 10° viv
2- Gain Stability = 0.5%
3- Common Mode Rejection = 100 db

4. Bandwidth: 0.5 Hz to 29 Hz 3db point with notch filter at 60 Hz. Notch Q =10,
Notch rejection = 40 db, flatness less than 0.25 db.
5- Input Impedance = 100 meg (differential or common mode).

6- Noise Level = 0.5 uv p-p at 10% viv & 1.5 uv p-p at 105 viv.
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4- Bandwidth: 0.5 Hz to 29 Hz 3db point with notch filter at 60 Hz. Notch Q =10,
Notch rejection = 40 db, flatness less than 0.25 db.

5- Input Impedance = 100 meg (differential or common mode).

6- Noise Level = 0.5 uv p-p at 104 viv & 1.5 uv p-p at 10° viv.

7-  Nominal Output Level = £ 0.5v at 10* viv & 1 5v at 10% viv.

8- Supply Voltage =t 15vdc.

9- Supply Current = +15vdc: 37Tma t 10% & -15vdc: 37ma £ 10%

10- A to D conversion = 12 bit, sample and hold (Analog Devices).

11-  Sample Rate = 100 Hz.

Appendix - F:

Go to launch LORETA Normative database

Low Resolution Electromagnetic Tomography (LORETA)
Normative Reference Database: Birth to 82 years

1.0- Introduction
There are many potential uses of a normative EEG database among the most
important being a statistical “guess” as to the “error rate” or to the probability of
finding a particular subject’'s EEG measure within a reference normal population. Most
other uses of a reference EEG database also involve statistics and the same statistics
that all of modem clinical medicine relies upon. For example, nuil hypothesis testing,
measures of reliability, sensitivity, power, predictive validity, content validity, etc. all
depend on specific assumptions and statistical procedures.
Low Resolution Electromagnetic Tomography (LORETA) {Pascual-Marqui et al, Int.

J. Psychophysiol., 18: 49-65, 1994; Pascual-Marqui, Internat. Journal of
Bioelectromagnetism 1: 75-86, 1999) is a distributed inverse model of 2,394 gray matter
pixels to estimate the current sources in 3-dimensions that give rise to the surface EEG.

The use of a normative LORETA database depends upon the statistical distribution of
the 3-dimensional sources. The statistical stability of a normative database is directly
related to the extent that the distribution of sources in a large population of normal
individuals approximates a Gaussian distribution. This appendix demonstrates how the
use of the FFT cross-spectrum of 2,394 sources from a large population of normal
subjects provides a reasonable approximation to Gaussian and how leave-one-out
cross-validation statistics demonstrate sensitivities > 95% accurate in the statistical
estimation of values based on the NeuroGuide normative database. Expertise in the
use of the Key Institute LORETA Viewer is necessary and validation of the maximum 2
scores by the surface EEG in frequency and scalp location are important. The user of
the NeuroGuide LORETA normative database is encouraged to read the Key Institute
documentation and always validate the LORETA solutions based on the surface EEG.

1.1 - Key Institute and Applied Neuroscience, Inc. LORETA Normative EEG
Database comparative validation
Four different normative reference databases were computed: eyes open and
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eyes closed for linked ears and for average reference montages. Five sequential age
groupings of 625 normal subjects (Thatcher et al, J. Neurotherapy, 7(3/4): 87-121, 2003)
were selected to cover the age range from 2 months to 82 years. The age groupings
were: 1- Two months to 5.99 years; 2- 6.0 years to 9.99 years; 3- 10 to 13 years); 4- 13 to
16 years and 16 to 82 years. The details of the selection/exclusion criteria, clinical
validation using neuropsychological tests and other aspects of normative reference
database creation are described in Thatcher et al (J. Neurotherapy, 7(3/4): 87-121, 2003).
To make sure that the calculations of the 2,394 LORETA currents were correct,
two different procedures were compared: 1- the Key Institute computation of currents
followed by leave-one-out cross-validation and, 2- NeuroGuide computation of currents
followed by cross-validation. Figure 1 is an illustration of a step by step procedure by
which the ASCII digital time series was exported to the Key Institute and then the Key
Institute software was used to compute *.crs files that were transformed into *.LOR files
from which means and standard deviations of the 2,394 gray matter pixels were
computed. In order to approximate Gaussian distributions, skewness and kurtosis
were calculated and then the individual subject values were transformed by log10 and
skewness and kurtosis were re-calculated. Other transforms such as square root and
loge were used but these transforms were not as affective in reducing skewness and
kurtosis. The left side of the figure is the edited and artifact clean and reliable Digital
EEG Time Series which may be re-referenced or re-Montaged to average reference,

which is then analyzed using the Key institute software.

LORETA Normative Database Cross-Vailldation Tests
Using the Key institute Cross-Spectral Software

Cross.Vildstion
ASCS Time s ZScores |
Series Export
f, Transforms ansd Tests
. . Tavsform Falne Neg.
e e ae O S W "
: ' Gloup Tests
e |
K *lof PR 3 % T T R P
% Fo-Compene

Fig. 1 - llustration of cross-validation procedures using the Key Institute software to

mk:@MSIT Store:C:\Program%20Files\R oboHelp%200ffice\RoboHTMLANEUROGUIDE\... 5/2/2004

FOI - Page 134 of 290

g0



NeuroGuide Manual Page 70 of 77

compute the cross-spectrum and means and standard deviations of the 2,394 LORETA
currents. Leave-one-out cross-validation procedures were followed and parametric and
non-parametric sensitivities were compared.

The second method which yielded essentially the same results as obtained using
the Key Institute software involved computing the cross-spectrum in NeuroGuide and
then multiplying the diagonal of the cross-spectral matrix (19 columns) by the Key
Institute ‘T’ matrix of 2,394 x, y & z rows for each frequency (1 to 30 Hz), then computing
J or the current source density as the square root of the sum of the squares for each
frequency and each of the 2,394 pixels (same procedure as described by the Key
Institute manual for the computation of *.crs files). Figure 2 illustrates the cross-
validation procedures using the NeuroGuide software and the Key Institute ‘T" matrix.

LORETA Normative Database Cross-Validation Tests
Using the NeuroGuide Cross-Spectral Software

Cross-\Valkdation
Cross-spectrum
19 % 2,394 (xy.7)
T matrix mult.
J=Sqrt, sum of
squares 1 —-30 Hz
l Transforms and Tesis

Artifect Free | \ | means & ransform | Faise N
Dighal EEG NeuroGuide SLDEV. ——-E::t., * &P

4

ZScores |

L J

L

L *.Crs

Sansitivity Test fe—

»

L *lor

Re-Compute

L *.lorb

Fig. 2 - llustration of cross-validation procedures using the NeuroGuide software to
compute the cross-spectrum and means and standard deviations of the 2,394 LORETA
currents. Approximations to Gaussian were achieved and statistical sensitivities of the
Z scores were computed.
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2.0 Results
2.1 - Gaussian Distributions and Affects of Log transforms

Figure 3 shows examples of the pre and post log10 distribution of LORETA Z
scores in the adult subjects for different frequency bands.
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Fig. 3 - Distribution of the 2,394 LORETA currents in the deita (0.5 —- 3 Hz), theta (3 -7
Hz) and alpha (8 — 13 Hz) without transforms (left) and with log10 transform (right}. The
log transform adequately approximated a normal Bell Shaped distribution.
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The ideal Gaussian and the average cross-validation values of the database by which
estimates of statistical sensitivity can be derived were published in Thatcher et al, J.
Neurotherapy, 7: 121, 2003. True positives (TP) = the percentage of Z scores that lay
within the tails of the Gaussian distribution, False negatives (FN) = the percentage ofZ
scores that fall outside of the tails of the Gaussian distribution. The error rates or the
statistical sensitivity of a QEEG normative database are directly related to the deviation
from a Gaussian distribution. These facts provide a mathematical method of
estimating the statistical sensitivity of a normative EEG database in terms of the
deviation from Gaussian for the NeuroGuide normative database of surface EEG values
as well as for the 2,394 gray matter pixel LORETA norms.

LORETA zCROSS-VALIDATION_EC(A)_21.0G10{x)
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Fig. 4 - Statistical sensitivities based on the equations in Figure 4 for the eyes closed
condition in a group of adult subjects for linked ears and average reference.
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Fig. § - Statistical sensitivities based on the equations in Figure 4 for the eyes open
condition in a group of adult subjects for linked ears and average reference.

Go to launch LORETA Normative database

Appendix - G:
Return to Top

Computation of the auto-spectral and cross-spectral densities, Coherence,
Phase Delays and Amplitude Asymmetry of the edited EEG selections

1- The FFT parameters are: epoch =2 seconds at a sample rate of 128
sample/sec = 256 digital time points and a frequency range from 0.5 to 40
Hz at a resolution of 0.5 Hz using a cosine taper window to minimize
leakage. Each 2 second FFT is 81 rows (frequencies 0 to 40 Hz) X 19
columns {electrode locations) = 1,539 element cross-spectral matrix for
each subject.

2-  In order to minimize the effects of windowing in the FFT (Kaiser and
Sterman, J. Neurotherapy, 4(3): 85-92, 2001) a EEG sliding average of the
256 point FFT cross-spectral matrix was computed for each normal
subject’s edited EEG by advancing in 64 point steps (75% overiap) and
recomputing the FFT and continuing with the 64 point sliding window of
256 point FFT cross-spectrum for the entire edited EEG record. Each of
the 81 frequencies for each 19 channels is log,, transformed to better

approximate a normal distribution. The total number of 2 second windows
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is the number that is entered into the analysis of variance and t-tests and it
is used to compute the degrees of freedom for a given statistical test.

3- A mean, variance, standard deviation, sum of squares, and squared
sum of the real (cosine) and imaginary (sine) coefficients of the cross-
spectral matrix is computed across the sliding average of edited EEG for all
19 leads for the total number of 81 and 1,539 log transformed elements for
each subject. This creates the following seven basic spectral
measurement means and standard deviations: 1- Cross-Spectral Power
(square root of the sums of squares of the real and imaginary coefficients
using the complex conjugate Hermitan Matrix); 2- Auto-Spectral Power
which is the diagonal of the cross-spectral matrix where the imaginary
coefficient = 0 and power = sine square; 3- Real coefficients; 4 — Imaginary
coefficients; 5- Coherence = square of the cross-spectrum divided by the
product of the two auto-spectra; 6- Phase = arctangent of the ratio of the
real/imaginary components for frequencies from 0.5 to 40 Hz; and 7-
Amplitude Asymmetry defined as the ratio of absolute power (A-B)/A+B) x
200, that is absolute power in channel A minus channel B divided by the
sum of A + B times 200.

Appendix - H:
A Few of the Normative Database Publications,
Replications and Validations (see the National Library of
Medicine database for more citations)

Return to Top

Bell, M.A and Fox, N.A. (1992), The relations between frontal brain electrical activity
and cognitive development during infancy. Child Dev. 63{5): 1142-63.

Boildyreva GN, Zhavoronkova LA. (1991). Interhemispheric asymmetry of EEG
coherence as a reflection of different functional states of the human brain.
Biomed Sci.; 2(3): 266-70.

Cantor DS, Thatcher RW, Hrybyk M, Kaye H. {(1986). Computerized EEG analyses of
autistic children. J. Autism Dev. Disord., 16(2):169-87.

Cantor, D.S., Thatcher, RW. and Kaye, H. (1987). Computerized EEG Analyses of
Autistic Children. Int. J. Autism, 114: 21-36.

Case, R. (1992). The roie of the frontal lobes in the regulation of cognitive development.
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Brain Cogn. 20(1): 51-73.

Dawson G, Panagiotides H, Klinger LG, Hill D. (1992). The role of frontal lobe
functioning in the development of infant self-regulatory behavior. Brain Cogn. 20
(1): 152-75.

Fishbein, D. and Thatcher, R.W. (1986). New Diagnostic Methods in Criminology:
Assessing Organic Sources of Behavioral Disorders. Research on Crime and
Delinquency, 23 (3): 240 - 267.

Fisher, K.W. (1987), Relations between brain and cognitive development. Chiid Dev. 58
(3): 623-32.

Hanlon, H. W. (1996). Topographically different regional networks impose structural
limitations on both sexes in early postnatal development. In: K. Pribram & J. King
(Eds.), Learning as self-organization (pp. 311-376). Mahwah, NJ: Lawrence
Erlbaum Assoc., Inc.

Hanlon, H. W., Thatcher, R. W. & Cline, M. J. (1999). Gender differences in the
development of EEG coherence in normal children. Developmental
Neuropsychology, 16 (3), 479-506.

John, E.R. Karmel, B., Corning, W. Easton, P., Brown, D., Ahn, H., John, M., Harmony, T.,
Prichep, L., Toro, A., Gerson, |., Bartlett, F., Thatcher, R., Kaye, H., Valdes, P.,
Schwartz, E. Neurometrics: Numerical taxonomy identifies different profiles of
brain functions within groups of behaviorally similar people. Science, 196, :1393
1410, 1977.

John, E.R,, Prichep, L.S. and Easton, P. Normative data banks and neurometrics: Basic
concepts, methods and results of norm construction. In: Remond A. (ed.),
Handbook of Electroencephalography and Clinical Neurophysiology, Vol. lii,
Computer Analysis of the EEG and Other Neurophysiological Signals. 1987,
Amsterdam: Elsevier, pp. 449-495.

Iito Y, Teicher MH, Glod CA, Ackerman E. (1998). Preliminary evidence for aberrant
cortical development in abused children: a quantitative EEG study. J
Neuropsychiatry Clin Neurosci. 10(3): 298-307.

Kaiser J, Gruzelier JH. (1996). Timing of puberty and EEG coherence during photic
stimulation. Int J Psychophysiol. 21(2-3): 135-49.

Matsuzawa J, Matsui M, Konishi T, Noguchi K, Gur RC, Bilker W, Miyawaki T. {2001).
Age-related volumetric changes of brain gray and white matter in healthy infants
and children. Cereb Cortex. 11{4): 335-42.

McAlaster, R. (1992). Postnatal cerebral maturation in Down's syndrome children: a
developmental EEG coherence study. Int J. Neurosci. 65(1-4): 221-37.

Thatcher, R. W., McAlaster, R., Lester, M. L., Horst, R. L. & Cantor, D.S. (1983).
Hemispheric EEG asymmetries related to cognitive functioning in children. in A.
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Perecuman (Ed.), Cognitive processing in the right hemisphere (pp. 125-145). New York:
Academic Press.

Thatcher, R. W., Krause, P. and Hrybyk, M. (1988). Corticocortical association fibers
and EEG coherence: A two compartmental model. Electroencephalography and
Clinical Neurophysiology, 64, 123-143.

Thatcher, R. W., Walker, R. A. & Guidice, S. (1987). Human cerebral hemispheres
develop at different rates and ages. Science, 236, 1110-1113.

Thatcher, R. W., Walker, R. A., Gerson, |. & Geisler, F. (1989). EEG discriminant analyses
of mild head trauma. Electroencephalography and Clinical Neurophysiology, 73,
93-106.

Thatcher, R. W. (1991). Maturation of the human frontal lobes: Physiological evidence
for staging. Developmental Neuropsychology, 7 (3), 370-394.

Thatcher, R. W. (1992). Cyclic cortical reorganization during early childhood. Brain and
Cognition, 20, 24-50.

Thatcher, R. W. (1994). Psychopathology of early frontal lobe damage: Dependence on
cycles of postnatal development. Developmental Pathology, 6, 565-596.

Thatcher, R. W. (1998). EEG normative databases and EEG biofeedback. Journal of
Neurotherapy, 2 (4), 8-39.

Thatcher, RW. (1999). EEG database guided neurotherapy. In: J.R. Evans and A.
Abarbanel Editors, Introduction to Quantitative EEG and Neurofeedback,
Academic Press, San Diego.

Thatcher, R. W., Biver, C. & North, D. (2003) Quantitative EEG and the Frye and Daubert
Standards of Admissibility. Clinical Electroencephalography., , 34(2), 1 —15.

Thatcher, R.W., Walker, R.A., Biver, C.J., North, D.M., and Curtin, R. Quantitiative EEG
Normative Databases: Validation and Clinical Correlation. Journal of
Neurotherapy 7, 87-105, 2003.

Trudeau, D.L., Anderson, J., Hansen, L.M., Shagalov, D.N., Schmoller, J., Nugent, S. and
Barton, S. (1998). Findings of mild traumatic brain injury in combat veterans with
PTSD and a history of blast concussion”, J. Neuropsychiatry Clin Neurosci. 10
(3):308-313.

Wolff, T. and Thatcher, R.W., (1990). Cortical reorganization in deaf children. J. of
Clinical and Experimental Neuropsychology, 12: 209-221.

van Baal, G. C. (1997). A genetic perspective on the developing brain: EEG indices of
neural functioning in five to seven year old twins. Organization for scientific
research (NWQO). The Netherlands: Vrije University Press.

mk:@MSIT Store:C:\Program%s20Files\RoboHel p%200ffice\RoboHTML\NEUROGUIDE\...  5/2/2004

€T
FOI - Page 141 of 290



NeuroGuide Manual Page 77 of 77

van Baal, G. C,, de Geus, E. J., & Boomsma, D.l. (1998). Genetic infiuences on EEG
coherence in 5-year-old twins. Behavioral Genefics, 28 (1), 9-19.

van Beijsterveldt, C. E., Molenaar, P. C., de Geus, E. J., & Boomsma, D. I. (1986).
Heritability of human brain functioning as assessed by electroencephalography.
American Journal of Human Genefics, 58 (3), 562-573.

van Beijsterveldt, C. E., Molenaar, P. C., de Geus, E. J., & Boomsma, D. |. (1998). Genetic
and environmental influences on EEG coherence. Behavioral Genetics, 28 (6),
443-453.
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Introducing NeuroGuide

NeuroGuide Deluxe is an informative and compreheasive digital EEG and QEEG post-hoc
analysis system. NeuroGuide provides access to modern and simple to use Microsoft windows for
automatic artifact rejection, Dynamic Lifespan Eyes Open and Eyes Closed Reference Normative
Database, covering the age from Birth to 82 years of age (N = 625). NeuroGuide includes Re-
Montaging to Average Reference or the Laplacian for eyes open and eyes closed conditions.

NeuroGuide is designed for use with the LORETA Key Institute Source Localization software
for registration with the Talarich MRI Atlas from the Montreal Neurological Institute,

NeuroGudie provides tab delimited output files that can be imported into any statistical package
or database management system. NeuroGuide does not diagnose nor render any clinical decisions
and it is designed for use by trained and competent individuals.

NeuroGuide discriminant functions are add on products and include a Mild Head Injury
discriminant function and a Learning Disabilities discriminant function. The discriminant
functions are not intended to provide a clinical diagnosis but are only an adjunct to other
measures.

NeuroGuide brain performance index is an add on product and includes predictive correlations
between EEG and Neuropsychological function such as Block Design, Digit Span and 1.Q. and
other cognitive measures. The brain performance index is a correlative research tool and is not
intended to diagnose or render clinical judgments.

NeuroStat is an add on program that computes pre-test vs. post test EEG comparisons as well
as statistical group comparisons.

NeureBatch is an add on program that automatically processes large batches of edited EEG
and organizes EEG data for purposes of group statistics.

LORETA Normative reference database is an add on program that provides 3-Dimensional Z
scores from birth to 32 years of age launched from the NeuroGuide edit window using the Key
Institute Explorer Viewer.

NeuroGuide Signal Generator is not an add on but is a free educational tool distributed in the
Demo at www.appliedneuroscience.com by which basic digital signal processing of EEG can be
learned and LORETA and NeuroGuide and other programs can be tested.

NeuroGuide provides tools as analytical resources and as an EEG reference based on peer
reviewed scientific publications. Any clinical use must be by qualified medical or clinical
professionals restricted to the post-hoc statistical evaluation of the human electroencephalogram
(EEG). NeuroGuide must be used only by competent and trained individuals. EEG artifact can

invalidate analyses and improper peositioning of electrodes or significant deviations from accepted
standards of electroencephalographic recording methodology can invalidate EEG recordings or
erroneous storage of data and falsification of data, improper manipulation of data or unlawful
uses of NeuroGuide including violations of copyright law and other improper uses of NeuroGuide
are all contra indicated.
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NEUROGUIDE SIGNAL GENERATOR
MANUAL AND TUTORIAL

Copyright © 2003-2004 Applied Neuroscience, Inc.
(Sine Wave segments were selected for illustrative purposes only)

Introduction:

The signal generator is used to calibrate and test the digital signal processing
properties of NeuroGuide as well as to serve as an educational program by which
the principles of digital signal analyses can be learned and explored. Concepts such
as frequency, time, phase delays, noise, amplitude and coherence can be tested and
evaluated. EEG data can be simulated by approximating the selected mixtures of
signals to match the signal parameters and scalp locations of the EEG.

TABLE OF CONTENTS

Step #1 - Launch NeuroGuide and click File>Open>Signal Generation

Step #2 - Use Mouse to Select EEG Channels, Sine Wave Frequencies and
Amplitudes (uV) and Phase Delays (degrees) and “Noise” (% S/N ratio)

Step # 3- Click OK, then Click Edit>Select All to view FFT resuits

Step # 4 — Click File>Save As to save the signals in NeuroGuide or Lexicor format
(*.ng or *.dat).

Step #5 - Example Tutorial of Replicating Peer Reviewed Publication: Gomez and
Thatcher “Frequency domain equivalence between potentials and currents
using LORETA.” Int, J. of Neuroscience, 107: 161-171, 2001.

Appendix — A - LORETA

Appendix — B — Mathematics of Gomez and Thatcher, 2001

Appendix — C — References
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Step #1: Launch NeuroGuide and click File>Open>Signal
Generation

Return to Top

Step #2 - Use Mouse to Select EEG Channels, Sine Wave

Frequencies and Amplitudes (uv) and Phase Delays (degrees) and
“Noise” (% S/N ratio)

Return te Top

Kdﬁn.
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2a - Click a channel to select a location in Lexicor format (e.g., O1), then double
click a Frequency (e.g., 10 Hz), then double click Amplitude (uV) and type in a value

2b — Mix sine waves in by double clicking the amplitude of a different frequency,
e.g., S Hz and type 50 uV.
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2¢ — Shift the Phase of the 5 Hz signal by double clicking “Phase Shift (Deg)” at S Hz
and type 30.

2d — Add “Noise” to the 5 Hz signal by double clicking the window below “Signal
Noise (uV)” and type 100. This adds 100 microvolts of noise to the 5 Hz signal
located at O1.
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2e — Repeat Steps 2a to 2d for each channel with or without adding phase delays
and/or noise or multiple frequencies, etc. Unselect any value by double clicking in
the appropriate box and set the value = 0.

The Channel is the primary selection and then the amplitude, frequency or mixtures
of frequencies and phases and noise are the secondary selections.

2f - Simulate any EEG by comparing the auto and cross-spectral values and then
entering these values into the appropriate channels and appropriate parameter
selection locations. Use the Signal Generator feature of NeuroGuide to learn about
digital signal processing in general as well as various analytical programs including
LORETA and other inverse solutions.

Step # 3- Click OK, then Click Edit>Select All to view FFT
results

Return to Top
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Step #4 - Click File>Save As to save the signals in NeuroGuide
or Lexicor format (*.ng or *.dat).

Return to Top

Step — 4a - Follow the NeuroGuide Manual Instructions (step #6) to save as
NeuroGuide (*.ng) or Lexicor (*.dat) files.

Step — 4b - Follow the NeuroGuide Manual Instructions (step # 6) to save Power
Spectra and Cross-Spectra (Step # 6) and to Export to LORETA (Step # 11 in the
NeuroGuide Manual).

Step #5 - Example Tutorial by replicating the publication:
Gomez and Thatcher “Frequency domain equivalence
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between potentials and currents using LORETA.” Int. J. of
Neuroscience, 107: 161-171, 2001.

Return to Top

5a- Select O1 at 10 Hz at 50 uV and 20 Hz and 25 uV

5b — Select O2 at 8 Hz 50 uV and 16 Hz at 25 uV
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Sc — Select F7 at 10 Hz 25 uV and 20 Hz 50 uV

Sd — Select F8 at 8 Hz 25 uV and 16 Hz at 16 uV
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Se - Click OK and then click File>Save As NeuroGuide (*.ng) or Lexicor (*.dat) for
purposes of further analysis. For example, save the power spectra and/or export the
digital time series to LORETA.
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S T S U
D L Rl R et O

APPENDIX - A
Return to Top

Gomez and Thatcher, 2001 used the Key Institute mathematical equations to validate
LORETA and cross-validated their math by comparing the forward solution and the inverse
solution using MRI 3-D voxel locations and the surface scalp EEG currents and potentials (Based
on the Reciprocity Theorum, Helmholtz, 1853). The results of the Gomez and Thatcher, 2001
study is also consistent with Tesche, C. and Kajola, M. “A comparison of the localization of
spontaneous neuromagnetic activity in the frequency and time domains.” Electroencephalography
and Clin. Neurophysiology, 87(6): 408-416, 1993.

One can test the facts and the science of LORETA for themselves using the NeuroGuide
signal generator and the Gomez and Thatcher, 2001 frequencies and locations which is only one of
several tools available to test LORETA (see Appendix B and C) not to mention the mathematical
concepts of linearity between frequency and time and between electrical potentials and currents
(Helmholtz, 1853 physics of "Reciprocity" and the "Lead Field", Malmivuo and Plonsey, 1995).

It makes no difference whether one exports signals in the time domain or in the frequency
domain (as demonstrated in the Gomez & Thatcher, 2001 and the Tesche et al, 1993 publications
as well as by mathematical simulation in step # 5). Caution must be exercised when using
LORETA to be sure to physiologically validate using the surface linked ears, average reference
and current source density data. This is not to indicate that LORETA is not a valid mathematical
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and scientific methodology, to the contrary, it is an important contribution. We are
emphasizing the fact that LORETA is valid when used by competent professionals who take the
time to validate the source solutions by evaluating the surface EEG distributions in order to guard
against possible ghost images and to take into consideration the inherent low resolution properties
of LORETA (i.c., low resolution electromagnetic tomography).

APPENDIX - B
Mathematics and Results of Gomez & Thatcher, 2001

Return to Top

Note: There are three instances when multiplication of matrices is communtative: 1- by a null
matrix, 2- by an identity matrix and, 3- multiplication by a scalar. The equation below is a valid
equality when using a scalar as we do.

AA={Aa}={a,A}=AA Eq.1

We apply this communtative property in the following manner.
For S = KJ, where K is the lead field matrix, J = current and S = the sensitivity of the sensors
(depending on the mode] used and the conductivity, etc.). S is an N x W matrix for the scalp
potentials (EEG/MEG), where N is the number of sensors and W is the number of time samples. J
is 2 3M x W matrix, where M is the number of sources and W is the same time samples as for S.
Then the inverse solution is a linear combination of the signal S in the sensors
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J=T-8 Eq.2
Where T is some generalized inverse of K, where the minimum noerm solution is
T = (pinv(K’ - K=K)) =K’ Eq.3

K’ is the transpose of K, and - represents matrix multiplication and pinv(X) is the Moore-Penrose
pseudoinverse (Menke, 1984). Pascual-Marqui et al, 1994 use the mathematical method that they
refer to as “Low-Resolution Computed Tomography” (LORETA) to add physiological
foundations and to avoid the minimum norms’s problems in localizing deep sources by using the
Laplacian Operator B and W as a weighting matrix. The LORETA equation is

T = {pinv(WB’BW)}K’ [pinv(K inv(WB’BW)K} Eq. 4

The critical factor in these considerations is that the real number FFT computed by the cross-
spectrum (Hermitian matrix as a scalar real number) as represented in equation 1 is a linear
operator such that for any inverse solution of the form in equation 3 is equivalent to:

FFT(J)=FFT [T - S} =T - FFI[S] Eq.5

Equation S is the formula that Gomez and Thatcher (2001) used. Gomez and Thatcher (2001)
simulated the linear equivalence by a combination of sine waves and confirmed the linearity of
equation 5 as any one can do by using the NeuroGuide signal generator as described in step # 5 for
oneself.

Figure 1 - From Gomez & Thatcher, 2001. This is the three-shell spherical model of the head
used to simulate LORETA. Four electrodes (F7, F8, O1, 02) and the reference electrode (A1) are
indicated by black rectangles. The coordinates of the electrodes are according to the hest-fitting
sphere relative to cortical anatomy (Towel et al., 1993). The peaks of beta (for F7 and F8) and
alpha activity (for O1 and O2) are indicated in parenthesis. Eight sources (1 to 3) indicated by
black circles were located in the interior of the sphere to represent the equivalent current sources
such as in the gray matter.
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Figure 2 — From Gomez & Thatcher, 2001. Power spectrum of the signals used to simulate
LORETA. The spectrum of the signals in the scalp electrodes is shown on the left (amplitude of
beta is higher in the anterior regions, alpha amplitude is higher in the posterior regions and a
frequency shift toward the lower frequencies in the right hemisphere). The center and right
columns are the spectra of the current sources nearest to the electrodes J1, J3, J5 and J7 after
calculating the inverse solution. Each source has three components x, y and z. The y-axis of the

electrodes is uv> Icycle/sec for the electrodes and uA/cm? )2 /cycle/sec for current density at each
source location. The x-axis is frequency in Hz in all cases. This simulation confirms the
mathematical statements and demonstrates a frequency domain equivalence between the spectra
of electrical potentials at the scalp and the spectra of currents in the interior of the head model.
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Normative Database Validation Steps

Transform & Re-Compute
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Clinical Correlations & Predictive Validity i

Parametric & Non-Parametric Statistics

Hiustration of the step by step procedure used in the design and development of the NAS
to Gaussian cross-validate and then validate by correlations with clinical measures in
order to estimate the predictive and content validity of the EEG normative reference
database. The feedback connections between Gaussian cross validation and the means
and standard deviations refers to transforms to approximate Gaussian if the non-
transformed data is less Gaussian. The clinical correlation and validation arrow to the
montage stage represents repetition of clinical validation to a different montage or
reference or condition such as eyes-open and eyes-closed.

FOI - Page 164 of 290



Thatcher — 510 k Application

Sensitivity Based on Deviation from Gaussian
Cross-Validation Accuracy N= 625 Subjects
False. Neg. = 2.3 . 1.98) = 32 False Pos. = 288 .2.3)~ 6

- Expacted * +2. %%
(Obwerond ~ - 1.98%) Dbasrved = + 2.30%)

M

V4 \/ \

True Positive = {100 - (1.9 + 2.68) =95 14%

TP . %4
TP +(FP + FN}  95.14+10
™

Specificity = —~e—wroee——— = Undefined
TN + (FP + FN)

Sensitivity =

A normal or Gaussian curve showing values of Z (+1.96 ), which includes the proportion
which is .95 of the total area. The left and right tails of the distribution show probability
values of .025 (one-tailed). The results of the cross-validation of 625 subjects showed a
classification accuracy that was normally distributed with 2.28% of the Z-scores > + 2
standard deviations (SD) and 0.16% of the Z-scores > + 3 SD. The clinical evaluation of
EEG measures rely upon such a normal distribution by estimating the probability of
finding an observed EEG value in a given range of a normal population and then
empirically testing the sensitivity of the database by cross-validation.
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EYES CLOSED NORMS - IDEAL = 2.3%

Percentage in Tails of

Bar graphs of percentage deviation of Z-scores from the ideal Gaussian cross-validation
in eyes-closed linked ears, average reference and current source density (Laplacian) re-
montaging of the norms. The results of the validation tests show a good approximation

to a Gaussian distribution in which the ideal or perfect Gaussian = 2.3%.
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EYES OPEN NORMS - IDEAL = 2.3%

Bar graphs of the percentage deviation from the ideal Gaussian cross-validation in the
eyes-open condition linked ears, average reference and current source density (Laplacian)
re-montaging of the norms. The results of the validation tests show a good

approximation to a Gaussian distribution in which the ideal or perfect Gaussian = 2.3%.
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DEPARTMENT OF HEALTH & HUMAN SERVICES Public Health Service -
Food and Drug Administration

Memorandum

From: Reviewer(s) - Name(s} \(u( N (a— P d\lL

Subject: 510(k) Number K OYl203 ?)5 ool

To: The Record - It is my recommendation that the subject 5 10(k) Notification:
[JRefused to accept.
quuires additional information (other than refuse to accept).

Is substantially equivalent to marketed devices.

ONOT substantially equivalent to marketed devices.
[JOther (e.g., exempt by regulation, not a device, duplicate, etc.)
Is this device subject to Section 522 Postmarket Surveillance? LIYES 4 No
[s this device subject to the Tracking Regulation? CIvEs <o
Was clinical data necessary to support the review of this 510(k)? LIYES ?O
Is this a prescription device? CIvEes NO
Was this 510(k) reviewed by a Third Party? CIYES o
Special 510(k)? Ovyes FT No
Abbreviated 510(k)? Please fill out form on H Drive 510k/boilers OJvEs %

yful and Accurate Statement DRequested %nclosed
A 510(k) summary OR [JA 510(k) statement
| The required certification and summary for class Il devices Mk

he indication for use form

Combination Product Category (Please see algorithm on H drive 5 IOk/BoilerS;) {\J

Animal Tissue Source [ YES [\Z{O Material of Biological Origin C1 vES [ﬁo

The submitter requests under 21 CFR 807.95 (doesn’t apply for SEs):
[J No Confidentiatity [ Confidentiality for 90 days [ Continued Confidentiality exceeding 90 days

Predicate Product Code with class: ’Additi,onal Product Code(s) with panel {optional):
Feawe , T, §&2. 1400 - t*lechVa@n(e[?halogvo\()k w
a(\'ﬁf—f’lrlvn‘} 5/. ’I,/, Ffa. /420 - Eleg *Voﬁnrﬁiplzm l(}f:‘jL o 45‘.‘3551;:5 [ < ,')(’C*ruwk

- €
Review: (L. (Wi WE2he 0@1{5 zcirr.)ozfc“ naly 2er
ALOME _(Branch Chicf) (Branch Code) (Date)
Final Review: rW’}% dp/wv-ﬁﬂj- K/Q /D‘«I
ﬁf (Division Director) (Dz{te) B
Revised:4/2/03
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DGRND/GSDB
K041263

Reviewer: Yung Pak General Surgical Devices Branch:
Mechanical Engineer (HFZ-410)

Proprietary Trade Name: NeuroGuide Analysis System

Commeon Name: EEG, EEG signal spectrum analyzer

Product to which compared: NxLink (K974748) Cr2e 2t
Applicant: Applied NeuroScience Contact: Robert W. Thatcher, Ph.D. g%

Phone (727)392-7851 i
Intended Use

The NeuroGuide Analysis System is to be used by qualified medical or qualified clinical
professionals for the statistical evaluation of the human electroencephalogram (EEG).
(Flowchart #3)

Device Description

The NeuroGuide Analysis System (NAS) is a software program for the post-hoc analysis of the
human electroencephalogram (EEG). EEG is recorded on a separate device is transferred to the
NAS for display and user-review. Analysis consists of the Fast-Fourier Transformation (FFT) of
the data to extract the spectral power for each of the four primary frequency bands (delta, theta,
alpha, and beta), and frequency information from the EEG. The results of this analysis then
converted to statistical values in the table. The similar software program was cleared for the
similar mathematical function and statistical values.

The table below compares the similarities between proposed device and predicate device:

Device Characteristics Predicate device (K974748) Proposed Device
Input host digital EEG Yes Yes

Frequency 0.5-3.0Hz 0.5-27Hz
Spectral Analysis FFT FFT

Coherence analysis Yes Yes

Phase delay analysis Yes Yes

Amplitude asymmetry Yes Yes

Ratio of power Yes Yes

Multivariate statistics Yes Yes
Topographic color maps Yes Yes

Normative database Sample size = 470 Sample size =625
Gaussian distribution Yes Yes

Z scores Yes Yes

K041263 — NeuroGuide Analysis System
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rOperating system DOS Windows

Visual display of EEG Yes Yes

The new device is very similar to predicate device but with faster operating system and with
larger database population. Therefore, the new device is able to display/calculate functions
efficiently due to faster operating system.

(Flowchart #5)

Clinical Consult

Dr. Mike Schlosser reviewed the submission and stated that he does not see any safety or
effectiveness issues since the new device is doing same functions as the predicate device. See
his review — attached.

Software

The software requirements specification, architectural deign chart, hazard analysis and software
verification. validation and testing are provided and adequate for this type of device.
Biocompatibility

Not applicable since the device is software and does not come in contact with patients.

Sterilization

Not applicable since the device is software program.

Labeling

The users manual contain information labeling contains installation instruction for the software
which is comparable to the predicate labeling. This is adequate.

Administrative

Indications for Use Statement — enclosed
Truthful and Accurate Statement — enclosed
510(k) Summary — enclosed

K041263 — NeuroGuide Analysis System
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Substantial Equivalence (SE) Decision Making Documentation

YES NO

1. ISPRODUCT A DEVICE? X IF NO, STOP
2. DEVICE SUBJECT TOQ 510(k)? p.S [F NO, STOP
3. SAME INDICATION STATEMENT? p.S _ IF YES,GOTOS
4. DO DIFFERENCES ALTER THE EFFECT OR

RAISE NEW ISSUES OF SAFETY

OR EFFECTIVENESS? _ _ IF YES, STOP -> NE
5. SAME TECHNOLOGICAL

CHARACTERISTICS? X _ IF YES, GOTO7Y
6. COULD THE NEW CHARACTERISTICS

AFFECT SAFETY OR EFFECTIVENESS? _ _ IF YES,GOTOS8
7. DESCRIPTIVE CHARACTERISTICS

PRECISE ENOUGH? — X [F YES, STOP -> SE
10. PERFORMANCE DATA AVAILABLE

TO SUPPORT EQUIVALANCE? X IF NO, REQUEST DATA
11. PERFORMANCE DATA DEMONSTRATES

EQUIVALANCE? X IF NO, STOP -> NSE

10.  The software documentation has been provided.
11. The provided software documentation demonstrated equivalence the predicate.

L3

K041263 — NeuroGuide Analysis System
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Reviewer Recommendation:

Substantially equivalent.

ProCode: 84GWQ. 84GWS

Class: [i
CFR #: 21 CFR §882.1400,
/MZ//%A Shblut
) Date

ung Pak
Mechanical Engineer, General Surgery Devices Branch

(e [l 07.29.0

Carlos Pena, Ph.D. Date
Acting Chief, General Surgery Devices Branch

K041263 — NeuroGuide Analysis System
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882.1420

f’//’ Concur
/7 Do Not Concur
Comments:



Indications for Use

510(k) Number (if known): K041263

Device Name: NeuroGuide Analysis System

Indications For Use: For clinical use the NeuroGuide Analysis system is to be used by
qualified medical or clinical professionals for the statistical evaluation of the human
electroencephalogram (EEG).

Prescription Use AND/OR Over-The-Counter Use X

{Part 21 CFR 801 Subpart D) (21 CFR 801 Subpart C)

(PLEASE DO NOT WRITE BELOW THIS LINE-CONTINUE ON ANOTHER PAGE IF
NEEDED)

Concurrence of CDRH, Office of Device Evaluation (ODE)

Page 1 of
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DEPARTMENT OF HEALTH & HUMAN SERVICES Public Health Service

Food and Drug Administration
Memorandum
From: Reviewer(s) - Name(s) \(L LA A ‘RJ\\L/
Subject:  510(k) Number K O Ll[[ 2%
To: The Record - It is my recammendation that the subject 510(k) Notification: -

?ﬁfused 1o accept. _f
Requires additional information (other than refuse to accept). $ te ’7 / 4 ot ﬂ‘
{15 substantially equivalent to marketed devices. ,? i 4 Q( Jf Con ,\L A 'J&c

[INOT substantially equivalent to marketed devices.
[ other (e.g., exempt by regulation, not a device, duplicate, etc.)

s this device subject to Section 5272 Postmarket Surveillance? Clyes O ne
Is this device subject to the Tracking‘Regulation? dves N
Was clinical data necessary to support the review of this 510(k)? LIYES [ n¢
[s this a prescription device? Ovyes e
Was this 510(k) reviewed by a Third Party? [dvEs N
Special 510(k)? tIvEs O
Abbreviated 510(k)? Please fill out form on H Drive 510k/boilers Oves O wN

Truthful and Accurate Statement [Requested L] Enclosed
(1A 510(k) summary OR i A 510(k) statement
{1 The required certification and summary for class IIl devices

1 The indication for use form

" Combination Product Category (Please see algorithm on H drive 510k/Boilers)

Animal Tissue Source [(1ves [JNO Material of Biological Origin O ves O

The submitter requests uader 21 CFR 807.95 (doesn’t apply for SEs):
£ No Confidentiality 1 Confidentiality for 90 days O Contmucd Conﬁdcntlahty exceeding 9

Predicate Product Code with class: Additional Product Code(s) with panel (optional):

Review: | ﬁ?_@i [2’_@— HF &Gt (A 1t /};@c

f}'ﬂ”@([}ranch Chief) (Branch Code) (Date)

Final Review:
(Division Dircctor) (Date)

Reviscd:47/2/03
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510(k) “SUBSTANTIAL EQUIVALENCE™
DECISION-MAKING PROCESS

New Device 18 Compared (o
Macketed Deviee ®

| ®

Deseriptive Information Dues New Deviee Have Same  NO - Do the DilYerences Alter the intended ’ Not Substantialiy
about New or Marketed Indication Statement?y »  Therapeutic/Diagnostic/cic. Effect YES  Equivalent Determination
Device Requested as Needed (in Deciding. May Consider Impact on

l YES Safety and Effectiveness)?**
New Device Has Same Intended NO
Use and May be “Substantially Equivalent” ¢
New Deviee Has O

Does New Device Have Same

@ @ New [ntended Use

Technological Characteristics,  NO Could the New
¢ Desten. Materials. et 77 » Characteristics Do the New Charactenistics
YES Aﬂ:ccl'SaI‘ely or —# Raise New Types of Safety YES _ O
l Effectiveness? or Effectiveness Questions?
A
NO Are the Descriptive NO
Characteristics Precise Enough NO
1o Ensure Equivalence? @
NO
Are Performance Data Do Accepted Scientific
Available to Asses Equivalence? YES Methods Exist for
Assessing Eftects of NO
the New Characteristics?
YiS

@ YES
Y

Performance Are Performance Data Available NO

Data Required : To Assess Effects of New
Characleristics? ***
. ) YES
Co v @
h 4
»  performance Data Demaonstrate Performance [Data Demaonstrate
Equivatence? ———() 9] < Equivalence? — 44—
YES YES NO

NO

“Substantially Equivalent” @
To Determination To

* S 1K) Submissions compare new devices (o marketed devices. FDA requests additional information it the refationshap between
marketed and “predicate” (pre-Amendments or reclassified post-Amendments) devices is unclear.

** This decision is normaliy based on descriptive information alone, but limited Lesting intormation is sometimes required.

*E Data maybe in the 510(k), other 310(k)s, the Center’s classification files, or the literature.
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SCREENING CHECKLIST

FOR ALL PREMARKET NOTIFICATION (510(k)] SUBMISSIONS |

510(k) Number:

The cover leﬁer cl_eady identifies the type of 5_10(1() submission as (Check the

_appr_opriate-box):
0 Special 51009 . DoSections {and2
O ¢ Abbreviated 510() - - - Do Séctions 1, Fand 4

0o - Traditional 510(k) or no identification provided .

" Do Sections 1 and 4

Section 1: Required Elements for All Types of 510(k) submissions:

Present or | Missing or
Adequate | Inadequate

Cover letter, containing the elements listed on page 3-2 of the
Premarket Notification [510)] Manual.

Table of Contents.

| Truthful and Accurate Statement.

Device’s Trade Name, Device’s Classification Name and
Establishment Registration Number.

Device Classification Regulation Number and Regulatory Status
(Class T, Class I, Class I1I or Unclassified).

Proposed Labeling including the material listed on page 3-4 of the
Premarket Notification [510)] Manual.

Statement of Indications for Use that is on a separate page in the
premarket submission.

Substantial Equivalence Comparison, including compaiisons of
the new device with the predicate in areas that are listed on page
3.4 of the Premarket Notification [510)] Manual.

510(k) Summary or 510(k) Statement.

Description of the device {or modification of the device} including
diagrams, engineering drawings, photographs or service manuals.

Ideatification of legally marketed predicate device. *

Compliance with performance standards. * [See Section 514 of
the Act and 21 CFR 807.87 (d).]

Class 111 Certification and Summmary. **

Financial Certification or Disclosure Statement for 510(k)
notifications with a clinical study. * [See 21 CFR 807.87 10}

510(k) Kit Certification 5%

- May not be applicable for Special 510(k)s.
- Required for Class III devices, only.

wonon

noR

Convenicace Kits [nterim Regulatory Guidance.

= _See pages 3-12and 3-13 in the Premarket Notification [510}] Magqual and the

34



Scction 2: [{(.:Lll;itc(l Clements for 1 SPECIAL 510(k) submission:

Prescnt | Inadequate |

‘ S . 6r-Missing
Name and 510(k) number of the submitter’s own, unmodified R

i prcdicait device.

A description of the modified device and 2 compadson to the

spoasor’s predicate device.

A statement that the intended use(s) and indicadons of the

modified device, as descabed in its labeling are the same as the -

| intended usés and in_dicatidns fot the submitter’s uvamodified - .

pr'cdi.citc device. , o o

Reviewer's confirmation thatthe madification has not altered the

fundamental scieafific technology of the submitter’s predicate

device. T ' s

A Design Coantrol Actvities Summary that includes the following

clements (a-c): ’

2. Identfication of Risk Analysts method(s) used to assess the

impact of the modification on the device and its components, and

the results of the analysis. )
b. Based on the Risk Analysts, an identification of the required
verification and validation activities, including the methods ot
tests used and the acceptance criteria to be applied.

c. A Declaration of Conformity with design controls that includes

the following statements:
A statement that, as required by the risk analysis, all
verification and validaton activities were petformed by the
designated individual(s) and the results of the activites
demonstrated that the predetcrmined acceptance criteria were
met. This statement is signed by the individual responsible
for those particular activiges.
A statement that the manufacturing facility is in conformance
with the destgn control procedure requirements as specified

i in 21 CFR 820.30 and the records are available for review.

? : This statement is signed by the individual responsible for

g \_ those particulat activiges.

Section 3: Required Elements foran ABBREVIATED 510(k)* submission:

Ptesent Inadequa:
) or Missin

For « submission, which relies on 2 guidance document and/ot
special control(s), a summaty repott that describes how the
guidance and/or special control(s) was used to address the risks
associated with the parucular device gype. (if 2 manufacturer
clects to usc an alternate approach to address a particulac nisk,

sufficieat detail should be provided to justify that approach.)
Fort a submission, which relies on 2 recognized standard, a

declaration of confornuty [Tor a lisung of the required clements
of a declaration of confocmity, SEE Required Elements for a

{ Declacation of Conformity to a Recognized Standacd, which | |

g
v,
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R S o T
ipostcd wich the 510(k) bodlers on the 1 drive.]

For a submussion, which relies on a recognized standard without-a
declaration of conformity, a statement that the manufacturer -
intends to conform to a recognized standard and that supporung,

-data will be available before marketing the device.

For a suboission, which relies on 2 non-recognized standard that
has been historically accepted by FDA, 2 statemeat that the

manufacturer intends to conform'to a recognized standard and

that supporting data will be available before marketing the device.

For a submission, which relies.on a non-fecognized standard that - |-~
has fot béén historically accepted by FDA, 4 statement thatthe
- manufacturer inténds to conform to & recognized standard and
thit supporting data will be available before marketing the device .
and any additional inforration requested by the reviewer in order
*o détérmine substantial equivalence. .

Any additional - formation, which is not covered by the guidance
document, special control, recognized standard and/or non-
recognized standard, in order to determine substantial

| equivalence.

* - When completing the review of an abbreviated 510(k), please fill out an
Abbreviated Standards Data Form (located on the H drive) and list all the guidance

documents, special controls, recognized standards and/or non-recognized
standards, which were noted by the sponsor.

Section 4: Additional Requirements for ABBREVIATED and TRADITIONAL
510(k) submissions (If Applicable):

Present | Inadequate

a) Biocompatibility data for all patient-contacting matenals, OR
certification of identical material/formulation:

| b) Sterlization and expiration dating informatior:

ilizafion process
ethad of stenlizatinn process

ilﬂ SAL

.

en free
esdues

Jtems with checks in the “Present or Adequate” column do not require e additional
information from the spousor. Ttems with checks in the «“ Missing or Inadequate”
coliemn must be sibmitted before substantive review of the document.

Passed Screening Yes No
Revicwer:
Concurrence by Review Branch:

o &

or Missing
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Date:

——————————

. “The deficiencies identified above represent the‘issues that we bclicffc need o be resolved

before our review of your 510(k) submission can be successfully completed. In developing

_ the deficenaes, we carefully considered the statutory cniteria a$ defined in Section 513(3) of

the Federal Food, Drug; and Cosmetic Act for determining substantial equivalence of your -
device. We also considered the burden that may be incurred in your attempt torespond to

the deficienaes. We believe that we have considered the least burdensome approach to

_ resolving these issues. If, however, you believe that information.is being requested that is

not relévant to the regulatory decision or that there is a less burdensome way to resolve the. .
issues, you should follow the procedures outlined in the “A Suggested Approach to -
Resolving Least Burdensome Issues” document. It is available on our Center web page at:

hup:// www.fda.gov/cdrh/modact/ [eastburdensome.html
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REVISED:3/14/95

oHE §10(K) DOCUHENTATION PORHS ARE AVAILABLE ON THE .LAN UNDER. 510 (K)
BOILERPLATES TITLED « DOCUHMENTATION" AND HUST. BE FILLED OUT ‘WITH
EVERY FINAL DECISION (SE, NSE, NOT A DEVICE, ETC.) .

~SUBSTANTIAL EQUIVALENCE® (SE) DECISION MAKING DOCUMENTATION .

K

Reviewer:

Division/Branch:

pevice Hame:

product To Which Coumpared (510(K} Number If Known}:

YES NO
1. Is Product A Device If Nd = Stop
2. Ig Device Subject To 510(k)? If HO = Stop
3. same Indication Statement? , . If YES = Go To 5
4. po Differences Alter The Effect Or - If YES = Stop KE
Raise New Igsues Of safety Or
Effectiveness?
5. Same Technological Characteristicsa? If YES = Go To 7
6. Could The HNew Characteristics Affect If YES = Go To 8
safety Or Ef fectiveness? :
;i 1. Descriptive characteristics Precise If HNO = Go To 10
. Enough? . If YES = Stop SE
8. New Types Of Safety Or Effectivencss If YES = Stop NE~
Questions?
9. hccepted scientific Methods Exist? If NO = Stop NE
10.. Performance Data Available? _ 1f NO = Reguest
A Data
11. bata Demonstrate Equivalence? Final Decision:
o
Note: In addition to completing the form on the LAN, “yes®” responscs t
questions 4, 6, 8, and 11, and every “no” responsec requires an

explanation.
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1. - Intended Use:

2. pDevice Description: provide a statement of how the device. is either
 gimilar to and/or different from other marketed devices, plus data (if
necessary]. to support the etatement. I8 the gevlce'tlfefpdpporting or -

life sustaining? Is the device_ implanted (short-term or long-term}? Doer
the device design use software? Ie the device sterile? 1s the device fo:
single use? Is the device over-thé—counter -or -prescription use? _Does tl
device contain drug or biological product as a conpaenent? Is this devic
a kit? Provide ‘a gummary about the devices design, materiale, physical
properties and toxicology profile if important.

EXP‘LPLN.RTIONS TO “YES" AND “NO" ANSWERS TO QUESTIONS ON PAGE 1 AS }{EEDED

1. Explain why not a device:

2. Explain why not subject to 510(k):

3. How doeg the new indication differ from the predicate devicé'g
indication:

4. Explain why there ig or is not a new effect or safety or effectiveness
isgue:

5. Describe the new technological characteristics:

: ; G. Explain how new characteristics could or could not affect safety or

© effectiveness: .
7. Explain how descriptive characteristics are not precise enough:

8. Explain new types of safety or effectiveness questions raigsed or why
questions are not news:

9. Explain why existing scientific methods can not be used:
10. Explain what performance data is needed:

11.- Explain how the performance data demonstrates that the device 18 or
not substantially equivalent:

ATTACH ADDITIONAL SUPPORTING INFORMATION

FOI - Page 245 of 290 57



Internal Administrative Form

YES

NO

B -

Did the firm request expedited review?
Did we grant expedited review?

oo

Have you verified that the Document is labeled Class il for GMP
purposes?
If, not, has POS been notified?

Is the product a device?
ts the device exempt from 510(k) by regulation or policy?
Is the device subject to review by CORH?

XN O~

9.

Are you aware that this device has been the subject of a previous NSE

decision? _
If yes, does this new 510(k} address the NSE issue(s), (e.g.,

performance data)?

11.
12.

10. Are you aware of the submitter being the subject of an integrity

investigation?

If, yes, consult the ODE Integrity Officer.

Has the ODE Integrity Officer given permission to proceed with the
review? (Blue Book Memo #191-2 and Federal Register 90N0332,
September 10, 1991.
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To:  Robert Thatcher, Ph.D.

From: Yung Pak

Re:  K041263 — Neuroguide Analysis System
Date: July 13, 2004

The following additional information is needed to complete the 510(k) review. Please
provide software documentation which includes functional requirements and system
specification, hazard analysis, software design, software development, software
verification, validation and testing. Please refer to FDA guidance titled “Guidance for
the Content of Premarket Submissions for Software Contained in Medical Devices” in the
website www.fda.gov/cdrh/ode/html

Your 510(k) will be on phone hold and we will resume the review when the requested
information is received. If you have any questions, please contact me at (301)594-2036
ext. 144,
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To:  Robert Thatcher, Ph.D.
From: Yung Pak
Re:  K041263 — Neuroguide Analysis System

Date; July 13,2004

The following additional information is needed 0 complete the 510(k) review. Please
provide software documentation which includes functional requirements and system
specification, hazard analysis, software design, software development, software
verification, validation and testing. Please refer to FDA guidance titled “Guidance for
the Content of Premarket Submissions for Software Contained in Medical Devices” in the

website www.fda.gov/cdrh/ode/html

Your 510(k) will be on phone hold and we will resume the review when the requested
information is received. If you have any questions, please contact me at (301)594-2036

ext. 144.
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Pak, Yung

From: Schlosser, Michael J*

aent: Wednesday, June 30, 2004 8:58 AM
To: Pak, Yung

Subject: K041263 NeuroGuide system

Yung,

I have read through the literature references provided in the 510(k) application for the NeuroGuide Analysis System.

In brief, this system is stand-alone software that accepts data digital EEG data recorded form a patient and performs
spectral analysis using analyses such as fast fourier transforms. The software provides output to the clinician in the form of
statistical summary tables, relative power, and topographical maps.

The system is indicated to be used by a qualified medical or clinical professicnal for the post-hoc statistical evaluation of
human EEG. The instructions for use specify that the NeuroGuide does not diagnose any condition and only provides
displays of the digital EEG and statistical analyses of selected segments. The instructions go on to state that quantitive
EEG (qEEG) is not a substitute for clinical training, evaluaticn of the raw EEG by a competent and trained clinician and is
only to be used as an adjunct to a complete patient evaluation.

The system utilizes a look up table function to generate Z scores that are based on a reference population. A publication of
this reference EEG data was provided by the sponsor (Thatcher et al 2003} and included normative EEG data collected on
625 subjects with ages from 2 months to 85 years old. This reference describes the rigorous statisticat approach used to
generate the normative data, segmented by age, from which comparisons can be made. Additionally, the sponsor has
provided published articles demonstrating the ability of these analyses techniques to differentiate various grades of
traumatic brain injury patients from each other based on the gEEG measurements with high specificity and sensitivity.

These references support the use of EEG analysis as a valid clinical technique. Further, the use of gEEG to analyze large
volumes of continuous EEG data from patients is @ common clinical practice. Given the adequate IFU that warn the user
that gEEG is not a diagnostic tool, nor does it substitute for clinical judgement and visual inspection of the raw EEG
signals, there does not appear to be any new safety or effectiveness issues raised by this device. | would therefore find it is
clinically SE to the predicate device.

Michael J Schiosser, MD
Medical Officer
DGRND/GSDB

THIS MESSAGE 1S INTENDED ONLY FOR THE USE OF THE PARTY TQ WHOM IT IS ADDRESSED AND MAY CONTAIN INFORMATION THAT IS
PRIVILEGED, CONFIDENTIAL, AND PROTECTED FROM DISCLOSURE UNDER LAW. If you are not the addressee, or a person authorized to
deliver the document to the addressee, you are hereby notified that any review, disclosure, dissemination, copying, or other acticn based on the content
of this cemmunication is not authorized. If you have received this document in error, please immediately notify the sender immediately by e-mail or
phcne.
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Pak, Yung

From: Vishnuvajjala, R, Lakshmi

“Sent: Thursday, July 01, 2004 3:32 PM

To: Pak, Yung

Subject: FW: K041263, Neuroguide analysis system

From: Vishnuvajjala, R. Lakshmi

Sent: Thursday, July 01, 2004 1:27 PM

To: Krause, David

Cc: Lao, Chang S.

Subject: K041263, Neuroguide analysis system

| am the team leader for the diagnostic devices in DBS and Chang Lao just gave me this 510(k) as it appears to be a

diagnostic device. Neither he nor | can find any statistical hypotheses or statistical analyses. The literature submitted may

have statistical analysis in them, but the papers are in neuroscience journals and not statistics journals. They require
clirical review rather than statistical review. If the reviewing clinician has any specific questions, we can help.

Lakshmi Vishnuvaijjala
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510(k) “SUBSTANTIAL EQUIVALENCE”
DECISION-MAKING PROCESS

New Device is Compared to
Marketed Device *

Does New Device Have Same
Indicagon Statement?

Descriptive Information
about New or Marketed

Device Requested as Needed
YES

New Device Has Jame Intended
Use and May be “Supstantially Equivalent”

Does New Devick Have Same
Technological Cha¥acteristics,
c.g. Design, Materipls, etc.?

NO

NO Do the Differences Alter the Intended

®

Therapeutic/Diagnostic/ete. Effect YES

Not Substantially
Equivalent Determination

o

@l iy -7

(in Deciding, May Consider Impact on
Safety and Effectiveness}?**

NO
4_.__-—
New Device Has
: New Intended Use
Could the New

Characteristics Do the New Characteristics
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YE Affect Safety or — Raisc New Types of Safety YES ()
@ l Effectiveness? or Effectiveness Questions?
‘1\
NGO Ar escriptive NO
“Raracteristics Precise Enough NO
@ to Fnsure Equivalence? @
NO
Are Peflormance Data Do Accepted Scientific
Available Jo Asses Equivalence? YES Methods Exist for
Assessing Eftects of NO
the New Characteristics?
YES
@ |
A4
Performance Are Performance Data Available  NO
Data Required To Assess Effects of New
Characteristics? ***
YES
ONE GO
Y .
> perforthance Data Demonstrate Performance Data Demonstrate
Eq Ence? O Equivalence?  #———
YES NO
NO
“Substantially Equivalent” @

To Determination To

* S10(k) Subrmissions compare new devices to marketed devices. FDA requests additional information if'the relationship between
marketed and “predicate” (pre-Amendments or reclassilied post-Amendments) devices s unclear.

b This decision is normally based on deseriptive information alonc, but limited testing information is sometimes required.
e Data maybe in the ST0(k), other S10(K)s, the Center’s classification tiles, or the literature.



DEPARTMENT OF HEALTH AND HUMAN SERVICES Public Health Service

Food and Drug Administration
Center for Devices and
Radiclogical Health

Office of Device Evaluation
Document Mail Center (BHFZ—-401)
9200 Corporate Blwvd.

July 22, 2004 Rockville, Maryland 20850
APPLIED NEUROSCIENCE ING. 510(k) Number: K041263

228 176TH TERRACE DRIVE Product: NEUROGUIDE

ST, PETERSBURG, TL 33708 ANALYSIS SYSTEM

ATTN: ROBERT W. THATCHER

The additional information you have submitted has been received.

We will notify you when the processing of this submission has been
completed or if any additional information is required. Please
remember that all correspondence concerning your submission MUST
be sent to the Document Mail Center (HFZ-401) at the above
letterhead address. Correspondence sent to any address other than
the one above will not be considered as part of your official
premarket notification submission. Also, please note the new

Blue Book Memorandum regarding Fax and E-mail Policy entitled,
"Fax and BE-Mail Communication with Industry about Premarket Files
Under Review. Please refer to this guidance for information on current
fax and e-mail practices at www.fda.gov/cdrh/ode/a02-01 html.

The Safe Medical Devices Act of 1990, signed on November 28, states
that you may not place this device into commercial distribution
until you receive a letter from FDA allowing you to do so. As in
the past, we intend to complete our review as quickly as possible.
Generally we do so 90 days. However, the complexity of a submission
or a requirement for additional information may occasionally cause
the review to extend beyond 90 days. Thus, if you have not received
a written decision or been contacted within 90 days of our receipt
date you may want to check with FDA to determine the status of your
submission.

If you have procedural or policy questions, please contact the
Division of Small Manufacturers International and Consumer Assistance
(DSMICA) at (301) 443-6597 or at their toll-free number (800) 638-2041,
or contact me at (301) 594-1190.

Sincerely yours,

Marjorie Shulman
Supervisory Consumer Safety Officer
Premarket Notification Section
Office of Device Evaluation
Center for Devices and

Radiological Health
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Applied Neuroscience, Inc.

228 176" Terrace Drive
Redington Shores, Fl 33708
727-392-7851, rwthatcher@yahoo.com

July 20, 2004

Document Mail Center (HFZ-401)

Center for Devices and Radiological Health
Food and Drug Administration

9200 Corporate Boulevard

Rockville, Maryland 20850 USA

Re: 510(k) Number: K041263

Dear Sirs;

Enclosed is an original and two copies of the requested software
documentation including functional requirements and system
specification, hazard analysis, software design, verification, validation
and testing as per the FDA guidance titled “Guidance for the Content of
Premarket Submissions for Software Contained in Medical Devices”.
Applied Neuroscience, Inc. has already submitted a 510(k) application
and this is in response to an identified deficiency of insufficient software
documentation. o

Sincerely, B
S

Robert W. Thatcher, Ph.D

President . S \\, Y
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07/13/2004 14:24 FAX 301

8§27 4350

L —— CPRH_DGRND ___

To: Robert Thatcher, Ph.D.

From: Yung Pak

Re:  K041263 — Neuroguide Analysis Systém
Date: July 13,2004

The following additional information i$ necded to complete the 510(k) review. Please
provide software documentation which includes functional requirements and system
speciﬁcation, hazard analysis, software design, software development, software
verification, validation and testing.  Please refer to FDA guidance titled “Guidance for
the Content of Premarket Submissions for Software Contained in Medical Devices” in the
website www.fda.gov/cdrhfode/html '

Your 510(k) will be on phone hold and we will resume the review when the requested
‘aformation is received. 1f you have any questions, please contact me at (301)594-2036
ext. 144.

//my/f‘/’/K

d001-001
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510(k) Number: K041263 — Neuroguide Analysis System

SOFTWARE DOCUMENTATION

Section Number 2.1 and 3.1 — Level of Concern is Minor

The level of concern is minor because failures or latent design flaws would not be
expected to result in any injury to the patient and/or operator. The answer to all five
questions in section 2.2.2 — Decision Process (www.fda/gov/FDA\57 FINAL
SOFTWARE GUIDANCE COPY 2.htm) is No, Therefore, the level of concern is
minor. The Neuroguide analysis software does not diagnose and is used only as an
adjunct to other measures and in conjunction with conventional visual examination of the
EEG tracings. The trained expert who uses the neuroguide analysis software (NAS) has
the option to ignore the results or to validate the results using independent tests to
confirm or reject the Neuroguide spectral analyses and statistics. The NeuroGuide
software uses defensive programming in that design and programming efforts are made to
minimize intentional and accidental error to the extent possible (see section No. 3.3
below).

Section Number 3.2 - Software Description

The NeuroGuide Analysis System (NAS) is a software program for the post-hoc
statistical analysis of the human electroencephalogram (EEG). EEG recorded on a
separate device (i.e., the host system) is transferred to the NAS for display and user-
review. The system requires that the user select reliable samples of artifact-free, eyes-
closed or eyes open resting EEG from the recording for analysis. Analysis consists of the
Fast-Fourier Transformation (FFT) and direct Fourier Transform (Complex
Demodulation) of the data to extract the spectral power at 0.5 Hz resolution and each of
the five primary frequency bands (delta, theta, alpha, beta and gamma) and standard
ratios of frequency bands of the EEG. The results of this analysis are then subjected to
univariate, bivariate, and multivariate statistical analyses and displayed in statistical
tables and topographical color maps of absolute and relative power, power ratios, power
asymmetry, coherence and phase delays for 19 monopolar and all of the possible 171
combinations of 19 electrode bipolar derivations of the EEG. In all over 1,200 measures
are derived for comparison against a carefully constructed and statistically controlled age
grouped, normative reference database in which the variables have been transformed and
confirmed for their Gaussian distribution. Each variable extracted by the analysis is
compared to the database using parametric statistical procedures that express the
differences between the patient and an appropriate age-matched reference group in the
form of Z-scores. Univariate and Multivariate features are compared to the normative
database using Gaussian Univariate and Multivariate distance statistics. The Gaussian
multivariate distance statistic controls for the interrelationship of the measures of brain
cortical function in the feature set, and provides an accurate estimate of their difference
from normal. The univariate statistics allow for single electrode and < 1 Hz resolution
while the multivariate measures permit an evaluation of regional indices of brain
function. Extracted feature sets are further analyzed to determine if a pattern in the EEG
(statistically significant feature score values identified for the patient) are consistent with
patterns in the EEG identified in prior neuroguide evaluations of clinical patients with
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known disorders. A step-wise discriminate analysis program identifies patterns in the
EEG that are commonly present in traumatic brain injured patients and learning disabled
children. The multivariate discriminant functions provide a probability estimate of the
presence or absence of a pattern in the EEG that has been found to be prevalent in
individuals constituting the normative and clinical database. The discriminant function is
not intended as a diagnostic program, instead it serves as a pattern recognition program
and probability estimate of the presence of certain EEG patterns.  The discriminant
program is restricted by confining potential outcomes to specific patient symptoms, eyes
closed resting conditions, greater than 30 seconds of EEG and limited ages derived from
the patient history profile. Established discriminant functions were evaluated through the
use of Recetver Operating Characteristic (ROC) curves for their sensitivity and
specificity. The outcome of the statistical analysis is presented in report form that
includes (a) patient demographic and history information, (b) selected EEG epochs, (c)
statistical tables of monopolar, bipolar, and multivariate extracted feature values, and
topographical brain maps. This information is to be read and interpreted within the
context of the current clinical assessment of the patient by the attending
physician/clinician. Multivariate linear regression as well as discriminant analysis are
also used to identify the maximal correlation between EEG features and performance on
neuropsychological tests performed on normal subjects ranging in 1.Q. from
approximately 80 to 150. A prediction with 95% confidence band is computed for each
subtest of the neuropsychological tests. The decision to accept or reject the results of
the neuroguide analysis, and incorporate these results into their clinical appraisal of the
patient, is dependent upon the judgment of the attending physician or clinician. Windows
operating system (Windows 97, 98, ME, 2000, XP and NT) is used to interface the
microcomputer hardware platform, the stored or archived digital EEG data, statistical
processing programs, data storage, and output devices. NeuroGuide also provides for
statistical validation using repeated measures analysis of variance, paired t-tests and
independent t-tests for both test re-test designs and group analyses.

Section Number 3.3 & 4.3 — Device Hazard Analysis - Minor

The Neuroguide analysis system is standalone software that is not in contact with
a patient and is designed to facilitate visual and mathematical evaluation of the EEG.
Training and expertise in EEG analysis is required in order for an individual to evaluate
the EEG patterns. The risk is minor because the device itself does not provide a
diagnosis. The expert who reads, interprets and evaluates the quantitative values and
visual EEG patterns has the option to ignore the numbers and EEG patterns or to use this
information along with other information as a supplement to the conventional EEG.
When the results are used in this manner, the likelihood of introducing error into
diagnosis and treatment is substantially reduced. That is, the test is viewed as an adjunct
to the evaluation of the patient, and does not serve as a primary basis for a diagnosis.

Potential minor adverse effects (identification and causes):

1- If the NeuroGuide Analysis System is used as the only or the sole diagnostic
system (a use that 1s specifically contraindicated by Applied Neuroscience, Inc.
and the system’s developers) in the absence of other clinical data from more
traditional means of patient evaluation.
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2.

Relying only upon the use of a single index (such as relative power, or the
topographical maps alone) without reviewing the traditional EEG, the epochs
selected for analysis, or the complete set of statistical summary tables is also
contraindicated and a source of potential error.

Additional sources of error could arise from the inappropriate selection of EEG
samples, e.g., selecting artifact and not EEG, or selecting EEG representative of
other states, such as drowsiness or eyes-open EEG when comparing to an eyes
closed database, or by purposely selecting conditions for testing other than those
specified.

Additionally, it is possible that errors will occur through the purposeful
falsification of symptoms in the patient history and patient age.

Risk management and methods of control to minimize or eliminate
potential minor concern

1-
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Neuroguide labeling and software documentation specifically states that the
Neuroguide analysis system is an adjunct to the evaluation of a patient and does
not serve as a primary basis for diagnosis. The discriminant functions are used as
pattern recognition software that gives a probability value to the match of a
particular EEG pattern that is commonly present in certain defined clinical
populations. Warning statements are contained in the software documentation
emphasizing that only qualified and trained individuals should use the Neuroguide
software for clinical or research purposes.

The Neuroguide software displays the conventional EEG and the quantitative
analysis of the EEG simultaneously on the same screen display. Thus, visual
examination of the EEG tracings is a built in defensive programming requirement
because quantitative analyses can not be performed without visual examination of
the EEG tracings.

Over 1,200 quantitative numerical values are produced by the Neuroguide
analysis system on any > 2 sec. selection of EEG thus minimizing the likelihood
that an unqualified individual will only examine a single index. Training in both
conventional EEG and spectral analysis EEG always involves the analysis of
multiple factors or indices and the Neuroguide software does not limit the analysis
to a single value or a single index.

The Neuroguide software minimizes artifact using defensive programming that
allows users to visually select artifact free segments of EEG while simultaneously
computing the split-half and test re-test reliability of the selections. The
simultaneous reliability measures minimize the likelihood of selecting artifact
because the standard criteria of reliability > 90% will not be met when sample
length is too short and when artifact is present. The test re-test reliability
compares the first 1z of the EEG selection to the last 1% of the EEG selections and
thus helps guard against selecting drowsiness or other state changes that may have
occurred during the end of the recording as compared to the beginning of the
recording. For example, the recommended value of test re-test reliability > 90%
will not be met if drowsiness in the second half of the recording is present.

While it is impossible to prevent purposeful misrepresentation of a patient’s age
or other clinical information, the Neuroguide software minimizes such conduct by
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providing the users with a subject information window that must be filled in
before the quantitative analysis can be conducted. If an erroneous age is
accidentally entered, then the user can easily correct this error by clicking
Window > Subject Information and then typing in the correct age. Ifthereisa
mismatch between the date of birth and date of test or age information in the EEG
data header and the age entered by the user, then the discriminant functions and
multivariate statistics are not computed. Another safeguard build into NAS is the
eyes closed condition, greater than 30 seconds of data and exact age criteria must
be met before the EEG data selections can be submitted for discriminant analyses.
The age requirements are = 13 years of age for the traumatic brain injury
discriminant and + 6 years of age for the learning disabilities discriminant and
prediction of neuropsychological test scores.

Section Number 3.4 & 4.2 — Software Requirement
Specification (SRS)

1- Hardware and Operating System Requirements

a- IBM compatible hardware platform (PC), any processor speed, 128 mbyte RAM
is recommended, minimum of 100 mbytes of hard disk space, standard display.
Operating system is Windows 97, 98, ME, 2000, XP or NT

There are no special interface requirements other than a disk drive and a printer.

b
c

2

. Programming language and program size:

a- Programming language is C and the program size when resident in memory is 13.5
mbytes.

b- The version number is displayed upon launch and can be viewed by clicking Help
> About Neuroguide.

3- Software Performance and Functional Requirements

Software performance testing of the NAS included the evaluation of the
algorithms and statistical methods used for data analysis. Specifically, control signals,
in the form of signal generated waveforms, were analyzed for frequency and auto and
cross spectral power, coherence, phase, amplitude asymmetry and amplitude ratios. EEG
signals were analyzed for conformity between the host digital EEG system and the NAS.
The NAS includes a feature that reproduces sampling frequency in the host digital EEG
system, and permits the visualization and evaluation of the EEG waveform for accuracy
between the host system and the NAS translation. In addition, data obtained in previous
implementations of the NeuroGuide analysis method were evaluated for consistency and
accuracy -- the results of the NAS’s analysis of stored subject data had to conform to that
of the prior analysis (which was conducted using the same method and procedures,
algorithms and method of analysis as that implemented on the NAS). The user of the
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NAS can verify the accuracy of the EEG spectral analyses by using built in calibration
signals.

The ability of the NAS to accurately translate and present EEGs from clinical
patients was confirmed by the non-clinical testing. In order for the NAS to be effective
for clinical use the results of the analysis (both statistical tables and topographical brain
maps) had to be in agreement with the results of the analysis conducted on the host
system used in the processing of patient and normative information at the Applied
Neuroscience Laboratory. In addition, the outcome of the discriminant analysis had to
be consistent, not resulting in errors of misclassification (that is, the classification on the
NAS had to be consistent with that of the host system used to acquire the EEG samples).
These tests confirmed that when eyes-closed or eyes-open resting, and artifact-free EEG
was selected for analysis, the results were reproducible within an acceptable degree of
variation consistent with reliability estimates identified in normative and clinical studies
(see Figures 3, 4 & 5 and Table II below).

Subjects upon which this device has been tested included individuals who were
either volunteers or clinical patients referred for QEEG evaluation to the Applied
Neuroscience Laboratory Department of Psychiatry University of Maryland School of
Medicine, and/or Shock Trauma and the Applied Neuroscience Institute at the University
of Maryland Eastern Shore, or as part of the DVHIP program. The results of the analysis
are usually conveyed to the referring physician and/or Ph.D. clinician who was asked to
use the information as an adjunct to their clinical interpretation of the patient’s traditional
EEG. The information was provided in report form (including EEG epochs selected for
analysis, statistical tables and topographic brain maps, and the result of the discriminant
analysis) to permit the physician or Ph.D. clinician to determine its relevance to their
clinical evaluation and diagnosis or treatment of the patient.

The normative reference database was compiled under well supervised and
careful construction procedures as specified in grant applications to the NIH and USDA
and as approved by the University of Maryland Institutional Review Board (IRB) in
1979-1987. Under University of Maryland faculty copyright rules and as principal
investigator the raw digital values and selections, arrangements, coordinations and
derivatives were analyzed and published in numerous peer reviewed journals over the last
25 years.

Software Requirement for the Computation of the Fourier Power Spectrum using
the Auto and Cross Spectral Matrix of all combinations of 1 to 19 International
10/20 System EEG electrode locations.

The Neuroguide software consists of power spectral procedures described below
that are used for linked ears, average reference and Laplacian digital values for both the
eyes-closed and eyes-open conditions, thus producing for a given subject a total of six
different 81 point FFT power spectral density values. These values are then used to
compute means and standard deviations for different age groups. The FFT normative
database uses, five sequential age groupings that were selected to cover the age range
from two months to 82 years. The age groupings were: (a) two months to 5.99 years (N =
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122), (b) 6.0 years to 9.99 years (N = 147), (c) 10 to 13 years (N = 72), (d) 13 to 16 years
(N=117) and (e) 16 to 82 years (N = 167). The direct Fourier Transforms and Joint
Time Frequency transforms (e.g., complex demodulation) use means and standard
deviations of normal reference subject’s temporal variability and time series features at
different age groupings and different degrees of freedom than for the FFT.

Summary of Program EEG Spectral Requirements

1- The EEG selections and/or edits are tagged and are spliced together as a
continuous stream of digital EEG data from 1 to 19 channels at a sample rate of 128
samples/sec {down sampling or up sampling to produce 128 samples/sec.). In order to
remove possible splice artifact the time series is low pass filtered at 40 Hz (5" order
Butterworth TIR filter).

2- The FFT parameters are: epoch = 2 seconds made up of 256 time points and a
frequency range from 0.5 to 40 Hz at a resolution of 0.5 Hz using a cosine taper window
to minimize leakage. Each 2 second FFT is 81 rows (frequencies 0 to 40 Hz) X 19
columns (electrode locations) = 1,539 element cross-spectral matrix for each subject.

3- In order to minimize the effects of windowing in the FFT (Kaiser and Sterman, J.
Neurotherapy, 4(3): 85-92, 2001) a EEG sliding average of the 256 point FFT cross-
spectral matrix was computed for each normal subject’s edited EEG by advancing in 64
point steps (75% overlap) and recomputing the FFT and continuing with the 64 point
sliding window of 256 point FFT cross-spectrum for the entire edited EEG record. Each
of the 81 frequencies for each 19 channels is log; transformed to better approximate a
normal distribution. The total number of 2 second windows is the N that is entered into
the analysis of variance and t-tests and it is used to compute the degrees of freedom for a
given statistical test.

4- A mean, variance, standard deviation, sum of squares, and squared sum of the real
(cosine) and imaginary (sine) coefficients of the cross-spectral matrix is computed across
the sliding average of edited EEG for all 19 leads for the total number of 81 and 1,539
log transformed elements for each subject. This creates the following six basic spectral
measurement sets and their derivatives 1- Cross-Spectral Power (square root of the sums
of squares of the real and imaginary coefficients); 2- Auto-Spectral Power which is the
diagonal of the cross-spectral matrix where the imaginary coefficient = 0 and power =
sine square; 3- Coherence = square of the cross-spectrum divided by the product of the
two auto-spectra; 4- Phase = arctangent of the ratio of the real/imaginary components for
frequencies from 0.5 to 40 Hz,; 5- Real coefficients; 6 — Imaginary coefficients.

5- The results of the computations in steps 2 to 4 are stored in the NeuroGuide
Analysis File, designated as * NGA. These results are used in the comparative statistical
— xi

analyses. Z scores are defined as Z = where X = mean of the normative

St. Dev.
reference database value at a given age and x; = the subject’s EEG value and St. Dev. =

FOI - Page 260 of 290



K041263 — Neuroguide Analysis System

standard deviation of the normative reference database value at a given age.
Multivariate statistics are similarly defined in standard statistical text books.

The number of normative reference subjects at different ages is shown in Figure 1.

NeuroGuide EES Normative Database

5 28 33 4% BB 6% TE 34 3R WIS M5 17§ 1X5 t4& 162 181 3T 287 4635
Moan Ape (Years}

Figure 1 above is the number of subjects per year in the Lifespan EEG reference
normative database (y-axis). The database ranges in age from two months of age being
the youngest subject and 82.3 years of age being the oldest subject (x-axis). This figure
shows the number of subjects constituting mean values which range from a mean of .5
years to 62.6 years of age and constituting a total of 625 subjects. Exclusion/inclusion
criteria: (a) a neurclogical history questionnaire given to the child’s parents and/or filled
out by each subject, (b) psychometric evaluation of IQ, and/or school achievement, (c)
for children the teacher and class room performance as determined by school grades and
teacher reports and presence of environmental toxins such as lead or cadmium. A
neurological questionnaire was obtained from all of the adult subjects more than 18 years
of age and those in which information was available about a history of problems as an
adult were excluded. Selection criteria were: 1- no history of neurological disorders, 2-
normal development milestones, 3- normal intelligence, 4- performing at grade level in
all academic subjects, 5- no history of learning disabilities or attention deficit disorders or
hyperactivity, etc. It is important that the demographic mixture of males and females,
different ethnic groups and socioeconomic status be reasonably representative of
expected North American clientele. The normative EEG database is made up of 58.9%
males, 41.1% females, 71.4% whites, 24.2% blacks and 3.2% oriental. Socioeconomic
status (SES) was measured by the Hollingshead four factor scale (details of all tests and
criteria are published in Thatcher, R. W., McAlaster, R, Lester, M. L., Horst, R. L. &
Cantor, D.S. (1983). Hemispheric EEG asymmetries related to cognitive functioning in

20
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children. In A. Perecuman (Ed.), Cognitive processing in the right hemisphere (pp. 125-
145). New York: Academic Press and Thatcher, R. W, Walker, R. A. & Guidice, S.
(1987). Human cerebral hemispheres develop at different rates and ages. Science, 236,

1110-1113.

The steps involved in the cross-validation of the normative reference database and
the clinical validation of the database by correlation with neuropsychological test scores
is shown in figure 2 below:

Normative Database Validation Steps

Teansform & Re-Coampule
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Parametric & Non-Parametric Statistics

Figure 2 (above) is an illustration of the step by step procedures that were used to
Gaussian cross-validate using & leave-one-out validation procedure and then by
correlations with clinical measures in order to estimate the predictive and content validity
of any EEG normative database. The feedback connections between Gaussian cross
validation and the means and standard deviations refers to transforms to approximate
Gaussian if the non-transformed data is less Gaussian. The clinical correlation and
validation arrow to the montage stage represents repetition of clinical validation to a

different montage or reference or condition such as eyes-open and eyes-closed conditions.

(pubhished in Thatcher et al, J. Neurotherapy, 7(3/4): 87-121, 2003).

The normative reference EEG database values are well behaved and approximate
a Gaussian or normal distribution. The results of the cross-validation tests are shown in

Table I.
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Sensitivity Based on Deviation from Gaussian
Cross-Validation Accuracy N = 626 Subjects

False. Nog. = 2.3 - 1.98) = 32 7 False Pos.= 288 -.23)= 8

Expected = - 2.3% s N Expected = + 2.9%
(Obsorved = - 1.98%) f.r" \_\ (Obsnrvad - + 2.50%)
4
£ 1,
A Y
s ,

i
s ~

=
2

P .
3 / ! A 8 1 2 1
Z Scores
4.8 50 +196S.0.

True Positive = {100 - (1.96 + 2.88) = 95.14%

™ 96.14
Sensitivity = = »
TP +(FP + FN) 95.14+10
Specificity = ™ = Undefined
TN +(FP + FN)

Figure 3 above is an illustration of the leave-one-out validation procedure with
respect to a normal curve showing values of Z (+1.96 ), which includes the proportion
which is .95 of the total area. The lefi and right tails of the distribution show probability
values of .025 (one-tailed). The results of the cross-validation of 625 subjects showed a
classification accuracy that was normally distributed with 2.28% of the Z-scores > + 2
standard deviations (SD) and 0.16% of the Z-scores > = 3 SD. The clinical evaluation of
EEG measures rely upon such a normal distribution by estimating the probability of
finding an observed EEG value in a given range of a normal population and then
empirically testing the sensitivity of the database by cross-validation.

Figure 4 below are histograms of the Z-Score cross-validation for all ages.
Measures of skewness and kurtosis and tests of Gaussian demonstrated that the
Neuroguide normative reference database approximates a Gaussian distribution and thus
meets the statistical criteria for a normal distribution as shown in Figure 3.
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Cross-Validation Birth to 82 Year EEG Normative Database
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FFT Normative Database Sensitivities

2 STDEVSs CALC SENSITIVITY. FR=TRATP+FP) of FN=TPATP+FN)

AGES (+- 2 S0) {>=2 3D) (<=2 SO)

069 095440265 0.9771774 B 97730526

6999 0.954407%67 0.9772031 nor7oonse  ¥-2 Std. Dev.
10-12.98 0.9643997 0.97724345 097715624

1315 95 0.95440512 097723601 0.97716811

16-ADULT 0.9543045 DIFFI8143 0.97721307

AL 0.95442375 0.97720714 0.97721661

3 8TDEVs CALC SENSITMITY: FP=TP/TP+FF) or FN=TPATP+FRN)

AGES {+- 3 S0 {>=3 SO) f<= -3 SO)

05,90 0.9974%98 099871123 0.99672774

6999 0.99744112 0.99871511 pomsrosnr W~ 3 Std. Dev.
16:12.98 0.9974463 0.99673171 0.99671518

131599 0.99743196 0 99671951 0.99671234

1E-ADULT 096743035 0 99870216 0.9967%19

AL 0.99744002 0.99871716 0.99672206

Table I above shows the results of the cross-validation tests of the normative
reference database (published in Thatcher, R. W., Walker, R A, Biver, C., North, D.,
Curtin, R., Quantitative EEG Normative databases: Validation and Clinical Correlation, J.
Neuratherapy, 7 (No. %): 87 - 122, 2003).
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Figure 5 below is an example of 1 Hz resolution color topographic maps of Z

- scores computed using the same equations and methods as in Figure 3 and Table 1.

Montage: LINKEARS

Z Scored FFT Absolute Power

JH

s i—— |
3210123
7THz

EEG ID: Demo-TBI
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Figure 6 below are the Receiver Operating Characteristic curves (ROC) for the
traumatic brain injury discriminant function and severity index which also used the
normative reference database. The ROC provides an estimate of false positive and false
negative classification rates for the detection of patterns in the EEG that are commoniy
present in individuals who have suffered a traumatic brain injury. The discriminant
functions have been independently cross-validated and published in the peer review
literature in Thatcher, R W., Walker, R.A_, Gerson, 1. and Geisler, F. EEG discriminant
analyses of mild head trauma. EEG and Clin. Neurophysiol., 73: 93-106, 1989 and
Thatcher, R W, North, D., Curtin, R, Walker, R. A, Biver, C., J.F. Gomez M., and
Salazar, A. An EEG Severity Index of Traumatic Brain Injury, J. Neuropsychiatry and
Clinical Neuroscience, 13(1): 77-87, 2001.

Sensittvity-Specificity (ROC) of Traumatic Brain Injury Discrimtnant Functions

Mild Head-Injury Discriminant Function
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Table I shows the Pearson Product-moment correlation results, mild vs. severe
EEG discriminant scores, compared with hospital admission information.  This table
shows and example of clinical validation by correlation with TBI severity measures

Variable Correlation P Values
Loss of consciousness 0.561 0.0601
Posttraumatic amnesia 0.169 NS
Glasgow Coma Score -0.853 0.001
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From Thatcher, R W., North, D., Curtin, R., Walker, R A., Biver, C., J.F. Gomez M., and
Salazar, A. An EEG Severity Index of Traumatic Brain Injury, J. Neuropsychiatry and
Clinical Neuroscience, 13(1): 77-87, 2001.

Figure 7 below is an example of the neuroguide software display of the
discriminant functions in which all of the variables that are used in the analysis are
displayed for the user so that one can verify and validate which variables are most
deviant and most contributory to a given predicted classification. The discriminant
function is used as a pattern recognition program to provide a probability of the detection
of a pattern in the EEG that is commonly present in clinically confirmed TBI patients.
The discriminant functions are not intended to render a diagnosis, instead they are
intended to provide information to a competent professional as to whether or not there is
a pattern in the EEG that is associated with TBI. A warning is given to users of the
discriminant analysis that this analysis is not intended to diagnose a patient, but rather is
an adjunct to other measures and is to be used to confirm and disconfirm hypotheses and
to evaluate which aspects of the EEG patterns are contributing to the classification
prediction. The wording of the warning is contained in the output page for the
discriminant function and it is as follows: “The Discriminant Analysis and Severity
estimate are to be used by experienced and qualified professionals for the post-hoc
statistical evaluation of the human electroencephalogram (EEG). The Discriminant
Analysis and Severity estimate are to be viewed as an adjunct to the evaluation of the
patient and they do not serve as a primary basis for a diagnosis. Warning: Inclusion
criteria include a history of traumatic brain injury and greater than 13 years of age must
be adhered to.”
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= Montaga: LINKEARS EEG ID: Demo-TBI
Traumatic Brain Injury Discriminant Analysis®

TBI DISCRIMINANT SCORE = 0.7 TBI PROBABILITY INDEX = 99.6%

The TEI Probability Index is the subject’s probability of bership in the miid b ic brain injury
population. (see Thatcher et al, EEG and Clin. Newrophysiol., 73: 93-106, 1989.)

¥

B rvomat |

T8I SEVERITY INDEX = 4.96
This seventy score places the patient in tha MODERATE range of severity.

MILD MODERATE SEVERE

The TBI Severity Index is an estimate of the newological severily of injury. (see Thatcher et al, J
Neuropaychiatry and Clinical Newroscienca, 13(1) 7787, 2001 }

*Statemert of iIndioslions of Use:

mamwmu—ayn—-hhmh and qualifiad pr & porkhoo
sttistion) ewahyation of the human slecim h '} The Discriminant Swvarity Index am to be viewsd as
an adjunct fo the evalugtion of the patient. and they da Wok Serve &5 & pnmany basis for & dagnosis. Waming: Inclusion crifena of 8
hrstony ot biin injury and 13 yeam of age must be adhard fo.

Table I below is an example of the clinical validation of the traumatic brain injury
severity index or severity estimate.
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TABLE V

Comelation Results: MILD .vs. SEVERE of EEG Discriminant
Scores .vs.
NeurcPsych Tests

Pearson Prod uct-Moment Correlation Comelation Probability QEEG Correlatlons with Cogmtlve
:‘L‘:':b;fz“s“"" Scores — — Function in > 200 Long-Term Qutcome
Simllarkies 0640 0.001 TBI Patients (N’s vary from 225 to
re Arrangement -0.576 0.01 .
Fortormance Beoa oot 287 TBI subjects, 2 months to 1,444 days)
Digit Symbal -0.524 0.01
BOSTOM NAMMNG TEST ) .
# of Spontanecus Corect Responses -0.482 0.05 From J. Neuropsychiatry & Clin. Neurophysiol.,
WORD FLUENCY TEST-Total Comect Vol. 13:1, 77-87, 2001.
Words
cowA -0.568 Q.01
Animais -0.630 0.001
Supermarket -0.708 0.001
ATTENTION TEST-Raw Scores
Trail Making A-Response Time 0.627 0.001
Trall Making B-Response Time 0.827 0004
Stroog -Word -0.427 0.05
Stroop -Color -0.618 0.001
Stroop -Color+Word -0.385 ns
WISC TEST-Executive Functloning-Raw
Scores
Perseverative Responses 0.408 0.05
% Concept Levei Responses -0.20¢ ns
Categories Comgleted -0.187 ns
Oesign Fluency - # Origlnals -0.454 0.05
Design Fluency - #Ruk Violations 0.304 ns
WECHSLER MEMORY TEST-Raw Scores
Logical Memory Il -0.382 ng
Visual Poduct ion Il -0.509 4.01
Digit Span ( Forw ard+Backward} -0.338 ns
Digit Span ( Fow ard} -0.225 ns
%-tile Rank Fomw ard -0.300 ns

Table I11 above — The results of clinical validation analyses involving correlations
between neuropsychological test performance and the TBI EEG discriminant function
and severity index. From Thatcher, R W., North, D., Curtin, R., Walker, R A_, Biver, C.,
J.F. Gomez M., and Salazar, A. An EEG Severity Index of Traumatic Brain Injury, J.
Neuropsychiatry and Clinical Neuroscience, 13(1): 77-87, 2001. These analyses along
with the correlations with the severity of injury upon admission to a hospital (Table 1)
were used for content validation of the NAS and users of the NAS can refer to the
scientific published literature to verify that their procedures and results are in accordance
with the standards published in the literature.

The learning disabilities discriminant function software is used to identify patterns
in the EEG that are commonly present in individuals with a history of problems in school
involving achievement test scores in reading, spelling and arithmetic. The discriminant
function software is used as a pattern recognition program to provide a probability of the
detection of a pattern in the EEG that is commonly present in clinically confirmed
learning disabled children. The discriminant functions are not intended to render a
diagnosis, instead they are intended to provide information to a competent professional as
to whether or not there is a pattern in the EEG that is also present in a group of LD
subjects.  The presence or absence of a given pattern is not definitive and the
discriminant analysis is only an adjunct to other clinical information and is not to be used
as a sole diagnostic measure. The user of NAS is referred to the scientific literature and
warned that the discriminant values are only an adjunct to visual analysis of the EEG

29
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tracings to be used to confirm or reject hypotheses that may arise based on the patient’s
clinical history and other information.

A. Discriminant Function for Learning Disabled Chikirenwith ADD

Crom Validation
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Figure 8 above — Receiver Operating Characteristic curves (ROC) for the learning
disability discriminant function and severity index. The ROC provides an estimate of
false positive and false negative classification rates for the detection of patterns in the
EEG that are commonly present in individuals who are performing two grade levels or
more below normal on reading, spelling and math school achievement tests. From
Thatcher, RW., North, D., Biver, C. EEG discriminant analyses of children with

learning disabilities. International Society of Neuronal Regulation Annual Meeting,
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Houston, Texas, September, 2003 and Thatcher, R W., North, D, Biver, C. EEG
analyses of children with learning disabilities. Eleventh Annual Future Health Congress,
Palm Springs, California, February, 2004,

Figure 9 below is an example of the neuroguide display of the discriminant
functions in which all of the variables that are used in the analysis are displayed for the
user 50 that one can verify and validate which variables are most deviant and most
contributory to a given predicted classification. The discriminant function is used as a
pattern recognition program to provide a probability of the detection of a pattern in the
EEG that is commonly present in clinically confirmed learning disabled children. The
discriminant functions are not intended to render a diagnosis, instead they are intended to
provide information to a competent professional as to whether or not there is a pattern in
the EEG that is associated with LD. A warning is given to users of the discriminant
analysis that this analysis is not intended to diagnose a patient, but rather is an adjunct to
other measures and is to be used to confirm and disconfirm hypotheses and to evaluate
which aspects of the EEG patterns are contributing to the classification prediction. The
wording of the warning is contained in the output page for the discriminant function and
it is as follows: “The Discriminant Analysis and Severity estimate are to be used by
experienced and qualified professionals for the post-hoc statistical evaluation of the
human electroencephalogram (EEG). The Discriminant Analysis and Severity estimate
are to be viewed as an adjunct to the evaluation of the patient and they do not serve as a
primary basis for a diagnosis. Warning: Inclusion criteria include no history of traumatic
brain injury and greater than 6 years of age to adulthood must be adhered to.”
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- Montage: LINKEARS EEG ID: Demo-TBI
Learing Disablity Discriminant Analysis®
LD DISCRIMINANT SCORE = 0.57 LD PROBABIUTY INDEX = G65.0%
The Leaming Dieability Probability Index is the subject’s probability of membarship in the Leaming
Disability (LD) population.
z
¥ 8 038
3638
-0.12|
F
018
o2
D28
(]

LD SEVERTY INDEX = 660
This sevarity score places the palient in the MODERATE range of severity.

LD MODERATE SEVERE

The LD Severity index is an estimate of the neurological severty of Leaming Disability.

“Statement of Indloslions of Use:

The Disoriminant Anatysis and mlﬂ—mih_‘hwﬁ“nlﬂﬁﬂiumiﬂhﬁhn
statistical avalustion of the homan eledr phalageam (EEG). The Analysis and Sevestly Index are fo be viewnd as
an adjunck 10 e ewalusion of the patinnt and they do not serve a3 § pimary basis tor » dlagnoms. Waming: Insiusion ciitena of no
history of traumatio biain injury 3nd age bebwen years and adullhood must be adhemo te,

FOI - Page 273 of 290



K041263 — Neuroguide Analysis System

Section Number 3.5 - Architecture Design Chart

Neuroguide Architectural Design Chart

import EEG

L

Subject Information

Dimpiny EEG Tracings
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¥

Edit A Relisbiity Tents

Epaciral Analysis & Normaiive
Raferance Comparinons

Produce Tablew & Color Maps
& Discriminant Funclionn

PrintiExpot Rasulin

Section Number 3.9 - Validation, Verification and Testing

I- The software version number

Version 2.0 will be the version number for the first release. The version number
and release date are shown upon launching the software and also by clicking Help >
About NeuroGuide

2-Software Verification test plan with pass/fail criteria, data, and an analysis of the
results.

2.2 — Pass/fail criteria for host amplifier calibration: Figure 10 below is an

example of the calibration frequency responses of host EEG amplifier systems. A
NeuroScan pocket trace EEG calibrator as well as a Grateful Head EEG calibrator were

25
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used to inject 20 uV, 40 uV and 80 uV calibration sine wave signals into the amplifiers of
Host EEG amplifier systems from 0 to 40 Hz and thus producing frequency response
curves. Figure 10 below is an example of the frequency response curves using
calibration microvolt sine waves to exactly match the frequency response of the
normative database amplifier frequency characteristics.

CALIBRATION (EQUALIBRATION) CURVES

............................................................

FREQUENCY (Hz)

Figure 11 below is an example of the mathematical equilibration factors that are used to
match the frequency characteristics of Host EEG amplifier systems to the normative
database amplifier frequency characteristics.
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CALIBRATION (EQUALIBRATION) RATIOs

10

AMPLITUDE (microVoits)

]
QF

0P 208 60 P AP o oF PP 0P 0P 6P 6 P P P P 00 00 0 0 P s P
FREQUENCY (Hz)

Mathematical equilibration using the equilibration factors in figure 11 are an example of
the verification and validation procedures used in Neuroguide to approximate as best as
possible the Host EEG system to the NeuroGuide software. The pass criteria is met after
the frequency characteristics of the host amplifier match the frequency characteristics of
the normative database amplifiers.

2.3 — Pass/fail criteria for software calibration: Software verification is
accomplished by the use of calibration sine waves of specific amplitudes, frequency,
phase delays and with or without the mixture of Gaussian white noise. The pass/fail
criteria are that an exact frequency match between the time domain and frequency
domain must be achieved. If an exact match is not achieved then the test has failed.

Figure 12 below shows the user interface by which users select the verification
calibration program inside of the NAS.

-
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Figure 13 below shows an example of a sine wave verification test in which the fail/pass
test is where the Time Domain = Frequency Domain.

Verfication Using Cailbration Sine Waves ~ Channel Fp! = § Hz 10 WV &0 phase lag, Chanriel Fp2 = 8 UV

& 48 dog. Phase lag, channsl F3 = 16 Hz, 10 uV &0 phase lag, channe! F4 = 16 Hz, 10 uV & 48 deg phase lag
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2.4 — Pass/fail criteria for multivariate discriminant analyses: The following pass/fail
ctiteria must be met before the discriminant analyses will be computed: 1- EEG sample
length must be > 30 seconds; 2- eyes closed condition only; 3- test re-test and split-half
reliability > 90%; 4- age > 13 for the TBI discriminant and > 6 for the LD discriminant.

3- Software Validation and tests of reliability and validity

Figure 14 below is an example of the split-half and test re-test reliability statistics
in which the criteria of > 90% reliability of the selected EEG segments is recommended.
These statistics help validate the EEG selections and verify that artifact has been removed
from the EEG selections. Short sample lengths of EEG and artifact result in reliabilities
< 90%. The reliability data are dynamically available in the EEG display screen to
facilitate accurate editing and quality control in the selection of artifact free EEG.
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The steps involved in the cross-validation of the normative reference database and

the clinical validation of the database by correlation with neuropsychological test scores
is shown in figure 15 (also Figure 2) below:
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Normative Database Validation Steps

Tranaform & Re-Compute
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Clinical Carvelstions & Predictive Validity

Parametric & Non-Parametric Statistics

Figure 15 (above) is an illustration of the step by step procedures that were used
to Gaussian cross-validate using a leave-one-out validation procedure and then by
correlations with clinical measures in order to estimate the predictive and content validity
of any EEG normative database. The feedback connections between Gaussian cross
validation and the means and standard deviations refers to transforms to approximate
Gaussian if the non-transformed data is less Gaussian. The clinical correlation and
validation arrow to the montage stage represents repetition of clinical validation to a
different montage or reference or condition such as eyes-open and eyes-closed conditions.
(published in Thatcher et al, J. Neurotherapy, 7(3/4): 87-121, 2003). The normative
reference EEG database values are well behaved and approximate 2 Gaussian or normal
distribution. The results of the cross-validation tests are shown in Table 1.

)
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Sensitivity Based on Deviation from Gaussian
Cross-Validation Accuracy N = 625 Subjects

False. Neg. -~ 2.3 - 1.98) = .32 ../‘WH'\ False Pos. = 288 -2.3)= &

Expoctod = - 1.3% S .\\ Expactod = +2.3%
Observed - - 1.9% \,  (Obeervad = « 2.00%)
/ \
er. \,\
e ",
y

A

.,'"d' \\
- I\ o
3 //.z R 1 2\ 3
Z Scores
-4.98 80, +1%S0

True Positive = {100 - {1.98 + 2.88) = 95.14%

™ 95.14
Sensitivity = = =
TP +{FP + FN) 95.14+1.0
Specificity = ™ = Undefined
TN +(FP + FN)

Figure 16 above (also figure 3) is an illustration of the leave-one-out validation
procedure with respect to a normal cusve showing values of Z (£1.96), which includes
the proportion which is .95 of the total area. The left and right tails of the distribution
show probability values of .025 (one-tailed). The results of the cross-validation of 625
subjects showed a classification accuracy that was normally distributed with 2.28% of the
Z-scores > + 2 standard deviations (SD) and 0.16% of the Z-scores > + 3 SD. The clinical
evaluation of EEG measures rely upon such a normal distribution by estimating the
probability of finding an observed EEG value in a given range of a normal population
and then empirically testing the sensitivity of the database by cross-validation.

Figure 17 below (also figure 4) are histograms of the Z-Score cross-validation for
all ages. Measures of skewness and kurtosis and tests of Gaussian demonstrated that the
Neuroguide normative reference database approximates a Gaussian distribution and thus
meets the statistical criteria for a normal distribution as shown in Figure 3.

-~ -
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Cross-Validation Birth to 82 Year EEG Normative Database
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2 STDEVs
AGES
0593
6999
10-12.9%
131599
16-ADULT

3 STDEVs
AGES
0592
999
10-12.99
131599
16-ADULT
AL

FFT Normative Database Sensitivities

CALC SENSITMIFY. FP=TRPATP+FP) or FN=TPATP+FN)

(+-2 SD)
D.95445265
0.95440683
09543997
0.95440512
0.9543945

095442375

CALC SENSITIVITY: FP=TRATP+FP} or FN=TPATR+FN)

{+- 3 SO
0.9974389%
0.997441172
099744688
099743186
0.99743835
0.99744002

(>= 238D
13 roa byt |
09772001
Q97724346
0.97723001
0.97718143
09770714

(== 350}

0.998F1123
099871611
0.9887 3171
093871951
0 99870218
0.99871716

[«<=-230)

LT 1575
Q9770054
0.97715624
0.9rTiRa
D777
Q7766

{<=-330)

Q99872774
0.99872501
0.99671518
099871234
0.99873%19
0.9567 2298

/= 2 Std. Dev.

‘f‘ 3 w- D“-

Table I above shows the results of the cross-validation tests of the normative reference
database (published in Thatcher, R W., Walker, R.A., Biver, C., North, D., Curtin, R,
Quantitative EEG Noramtive databases: Validation and Clinical Correlation, J.

Neurotherapy, 7 (No. %): 87 - 122, 2003).
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Figure 18 below is an example of normative reference database validation that is
an intrinsic part of the NAS software. The validity criteria are that different montages
(linked ears, average reference and Laplacian) should yield comparable Z score
distributions for different frequencies.

Linked Ears Average Reference Current Source Density

y +——Theta Excess 6.5H:

Figure 19 below are independent validation statistics using correlations between EEG and
neuropsychological test scores. These statistics are also used to verify and validate the
Neuroguide normative database. Figure 6 below is an example of the correlation between

single EEG quantitative EEG measures and school achievement scores in normal children.

(published in Thatcher, R W., Walker, R.A., Biver, C., North, D., Curtin, R., Quantitative
EEG Noramtive databases: Validation and Clinical Correlation, J. Neurotherapy, 7 (No.
%): 87— 122, 2003).
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Example of Content Validity of EEG Norms
Scatterplots of Amp. Asymmetry with 1Q 8 School Achievement Tests Measures P < L0001
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Figure 20 below are additional validation of the norms which are the correlations
between multivariate EEG regressions and performance on neuropsychological tests in
the normative reference database subjects. These measures are used in the neuroguide
analysis system to produce predicted neuropsychological test scores as an adjunct to other
measures and not to replace neuropsychological tests. Predictive validity by correlation
to clinical measures and neuropsychological tests is useful for the user of any quantitative
EEG system. (published in Thatcher, R W., Walker, R A_, Biver, C., North, D., Curtin, R,
Quantitative EEG Noramtive databases: Validation and Clinical Correlation, .
Neurotherapy, 7 (No. %): 87 - 122, 2003).
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Carrelation Between the Predicted vs. the Raw IQ Scores @ P <.0001 nzing NORMSs Only
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Figure 21 below are the Receiver Operating Characteristic curves (ROC) for the
traumatic brain injury discriminant function and severity index which also used the
normative reference database. The ROC provides an estimate of false positive and false
negative classification rates for the detection of patterns in the EEG that are commonly
present in individuals who have suffered a traumatic brain injury. The validity of the
discriminant for the detection of a pattern commonly present in the EEG is seen in Figure
19 in which the top row is the “yes/no” detection of a pattern in the EEG independent of
the severity of injury while the bottom row are the ROC curves of the severity index
which steadily increase as a function of the severity of TBL. The discriminant functions
have been independently cross-validated and published in the peer review literature in
Thatcher, R.W., Walker, R A., Gerson, I. and Geisler, F. EEG discriminant analyses of

mild head trauma. EEG and Clin. Neurophysiol., 73: 93-106, 1989 and Thatcher, R W,
North, D, Curtin, R., Walker, R.A., Biver, C., I F. Gomez M, and Salazar, A. AnEEG

Severity Index of Traumatic Brain Injury, J. Neuropsychiatry and Clinical Neuroscience,

13(1): 77-87, 2001.
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Sensithvity-Specificity (ROC) of Traumatic Brain Injury Discriminant Fanctlons
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Figure 22 below is another example of verification and validation of the TBI
pattern recognition discriminant for the evaluation of the severity of TBI in clinically
confirmed TBI patients whose EEG was measured obtained from four different VA
hospitals (Minneapolis, Tampa, Richmond VA & Palo Alto, CA) and three different
military bases (Walter Reed Army, Balboa Naval Hospital & Wilford Hall Air Force).
These measures were used as a part of the standard of care in the evaluation of TBI in
these patients. The severity of TBI was greater in the VA hospital patients than in the
military hospital patients as determined by standard clinical workups and
neuropsychological tests. Verification and validation of the ability of the EEG
discriminant to detect a pattern in the EEG that is correlated to the severity of injury is
shown in Figure 21 for 505 TBI patients. From Thatcher, R W., North, D, Curtin, R,
Walker, R A, Biver, C, J.F. Gomez M., and Salazar, A. An EEG Severity Index of

Traumatic Brain Injury, J, Neuropsychiatry and Clinical Neuroscience, 13(1): 77-87,
2001.
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EEG SEVERITY INDEX BY SITE
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Table IV (same as Table IT) shows the Pearson Product-moment correlation results, mild
vs. severe EEG discriminant scores, compared with hospital admission information.
This table shows and example of clinical validation by correlation with TBI severity

measures
Variable Correlation P Values
Loss of consciousness 0.561 0.001
Posttraumatic amnesia 0.169 NS
Glasgow Coma Score -0.853 0.001

From Thatcher, R W, North, D,, Curtin, R., Walker, R_A., Biver, C.,JF Gomez M., and
Salazar, A. An EEG Severity Index of Traumatic Brain Injury, ], Neuropsychiatry and
Clinical Neuroscience, 13(1): 77-87, 2001.

Table TII below is an example of the clinical validation of the traumatic brain injury
severity index or severity estimate.
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TABLE V

Comelation Resuits: MID .vs. SEVERE of EEG_Discrimlinant
Scores .vs,
NeuroPsych Tests

Pearson Prod uct-Mement Correlation Corelation Probabiiity QEEG Correlations with Cogmtive
SWA'S TEST-Sozled Scores Function in > 200 Long-Term Outcome
Vocabulary -0.4186 0.05

Similarities 0640  0.001 TBI Patients (N’s vary from 225 to
Picture Arrangement -0.576 0.01 .

Forformancs 0506 oor 287 TBI subjects, 2 months to 1,444 days)
Digit Symbol -0.624 0.01

BOSTON NAMING TEST

# of Spontaneous Comect Respon ses -0.487 0.05 From J. Neuropsychiatry & Clin. Neurophysiol.,
WORD FLUENCY TEST-Total Cormrect Vol. 13:1, 77-87, 2001.

Words

COwA -0.568 0.01

Animals -0.630 0.001

Supermarket -0.7309 0.001

ATTENTION TEST-Raw Scoras

Trail Making A-Response Time 0627 0.001

Trail Making B-Respanse Time 0.627 0.001

Stroop -Waord -0.427 0.05

Stroep -Color -0.618 0001

Stroop-Coior+Word -.385 ns

WiSC TEST-Executlve Funet foning-Raw

Scores

Perseverative Responses 0.408 0.05

% Concept Level Responses -0.200 ns

Categories Completed -0.187 ns

Design Fluency - # Originals -0.454 0.05

Desigh Fluency - #Rule Viclatlans 4.304 ns

WECHSLER MEMORY TEST-Raw Scores

Logical Memory Il -0.382 ns

Visual Product ien It -0.509 0.01

Digit Span { Fow ard +Backward) -0.338 ns

Digit Span { Fow ard) -0.225 ns

%-tile Rank Fomw ard -0.300 ns

Table V above (same as Table III) — The results of clinical validation analyses involving
correlations between neuropsychological test performance and the TBI EEG discriminant
function and severity index. From Thatcher, R W, North, D., Curtin, R., Walker, R A,
Biver, C., I.F. Gomez M., and Salazar, A. An EEG Severity Index of Traumatic Brain
Injury, J. Neuropsychiatry and Clinical Neuroscience, 13(1): 77-87, 2001. These
analyses along with the correlations with the severity of injury upon admission to a
hospital (Table IT) were used for content validation of the NAS and users of the NAS can
refer to the scientific published literature to verify that their procedures and results are in
accordance with the standards published in the literature.

4- Example of Verification and validation of off-the-shelf Low Resolution
Electromagnetic Tomography (LORETA) software

Figure 23 below is an example of how the Neuroguide software can be validated
when used with off-the-shelf software. The example is the software algorithms used by
the off-the-shelf Key Institute LORETA program in which validation and verification are
accomplished by comparing ASCII time domain EEG data to the frequency domain in
the off-the-shelf software.

b
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Examples of Verification of Key Institute Cross-Spectral Equations
6 Hz Callbration — F3 16 Hz Callbratian ~ P4
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Bottom Row are Kay Instituta Cross Top Row ara NauraGuide Cross
Spectra of Exportad ASCH data Specira Of the Same ASCI! Dats

The Key Institute off-the-shelf software only an example of how users can verify
and validate by exporting time series and frequency domain data to any off-the-shelf
EEG spectral analysis software programs in order to confirm or validate. The universal
and mathematica} standard is the microvolt as defined by the laws of physics.
Neuroguide software does not diagnose and only facilitates access to off-the-shelf
software and the use of LORETA or any other off-the-shelf source localization program
is at the discretion of the user and requires training and expertise. Validation by
matching time domain values to frequency domain values in different host systems is an
efficient and good validation procedure.

Section Number 3.12 - Version number and date for all levels of concern
The version number and revision date is displayed when the NAS is launched and
by clicking Help > About NeuroGuide.
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